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read me first
Simon Jary
editor-in-chief

Wow! Apple’s actually beaten its
own timetable to get Mac OS X
pre-installed on all of its new Macs.

About time 2.0
A
“Apple used to
launch a great
new Mac, only
to make it look
outdated
immediately
by showing off
something it
invented that
morning.”
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t Macworld, we often see amazing technologies
demonstrated to us by fire-eyed developers.
They say “Wow!”; we say “Wow!”; we write
about it; you say “Wow!”. Not long after you’ve
shown the article to someone else, and they’ve said
“Wow!”, you start writing in and asking when Wow 1.0
will be available to buy. Then we realize that what we
just saw wasn’t anywhere near ready to ship. This is the
point at which Wow turns to Oww…
Although, occasionally, Apple shipped products way
before they were ready (the, ahem, Newton, for
instance), the company used to pre-announce more
stuff than it actually shipped. I remember witnessing
demos for Sherlock, most of Mac OS 8 and tons of
QuickTime features many years before they became a
part of the on-sale operating system. The funny thing
was that, after all those dormant years, these features
hadn’t changed a bit. They must have just been lying
around on floppies and Zip disks gathering dust in
Apple’s R&D laboratories.
Maybe an absent-minded Apple boffin – his bottom
still smarting from the Newton fiasco – mislaid these
disks after they were returned from the demos.
“Geoff, where’s that neat new QuickTime wavy
effect everyone loved at Macworld Boston 1995?”
“Er… well, I think it’s behind the prototype 15th
anniversary Mac Portable by the water cooler, Frank.”
Imagine them having to tell the head of software
development that they’d lost search utility Sherlock.
“I’ve got nothing to find it with, either, now…”
Steve Jobs realized that pre-announcing meant
killing off all the stuff you can actually make and sell.
Apple used to launch a great new Mac, only to make it
look outdated immediately by showing off something
it invented that morning. Steve’s pre-announcements
mean you won’t be able to buy the latest Mac for a
month or two – just time for Apple dealers to flog-off
the remaining inventory at bargain prices. (In the past,
Apple used to have to gather all its unsold stock and
bulldoze it into desert landfills – I kid you not.)
Pre-announcing then became the preserve of the
browser warriors. Every few days, Netscape or
Microsoft would release a new beta of its Web browser.
By the time, say, Netscape 2.5 was officially released,
everybody was downloading the beta for version 3.0.
Now, the worst offenders for pre-announcement
time-lags are games designers. Following his own
show-it-when-it-ships policy, Steve livened up his
keynotes by inviting young whippersnappers on stage
to blow-up bug-eyed monsters and race alien buggies
in unbelievable 3D action – extraterrestrial visions of
in-flight space-blasting so incredible that they hadn’t

even been seen by the secret services of the high-tech
warring factions of the planet Kabbula.
Bungie was the worst offender. First there was Oni…
“Wow!”. Then there was Halo… “Double Wow!”. Several
years after we all first looked forward to pretending to
be lithe Japanese urban-shooter girls, Oni finally
shipped for the Mac. It’s now at least a couple of years
since we imagined ourselves as body-armoured Halo
space troopers, and still we wait. By the time Halo hits
the streets, Steve Jobs will actually have a halo, and our
great-great-grandkids will have been conscripted to
fight the imperialistic Kabbulan forces somewhere in
the ninth galaxy. Bungie’s share price will explode (like
an over-charged sonic-flashblaster) as thousands of
23rd-century Earthlings rush to play this now quaintly
historical game on their Red Alsatian neuro-MacPads.
Pre-announcing products like these games isn’t
going to do companies such as Bungie any harm, as
long as it also actually invents and ships a few things
that people can buy in the meantime.
Pre-announcing operating systems and gleaming
new computers could cripple Apple, and very nearly did
during the pre-iMac dark days.
Now, Apple should be applauded for largely sticking
to its Mac OS X timetable – and, in late May, actually
beating it. According to the deadlines, Mac OS X was to
ship as the default operating system “sometime this
summer”. This scary proposition has been bettered by
Apple’s far-more sensible announcement (see page 21)
that, immediately, all new Macs will ship with OS 9.1
installed as default and OS X as an option.
Apple may very well be right that it’s now possible
to survive on Mac OS X alone. But it’s equally true that,
if you do go for it, you’ll be relying heavily on X’s Classic
emulation. And there’s only two things slower than
Classic – E4’s interminable daytime coverage of Big
Brother and Mac OS X’s own Finder.
Apple could have kept wowing us with Aqua demos
while waiting to release a faster, more compatible
update later this year. But that policy would inevitably
have affected its Mac-hardware sales, as people waited
for X-loaded systems rather than later having to pay
out the extra £99. And software developers have been
clamouring for Apple to jump-start OS X’s proliferation.
This early, more flexible move should help everyone.
This isn’t unqualified praise for Apple’s OS X efforts,
however. While we no longer have to wait for X on our
newly acquired Macs, customers new and old won’t be
too happy to be kept waiting and waiting and waiting
for perkier X performance. Once that’s achieved, maybe
even the still-vociferous anti-X brigade will go “Wow!”
as well.
MW

Read more Macworld opinions online (www.macworld.co.uk), and join in the debate.
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Your Star Letter wins a copy of Office: 2001, worth £480!
We reward the best reader letter with a copy of Microsoft’s Office: 2001 for Mac. This integrated package
of business applications includes enhanced versions of the market-leading Word, Excel and PowerPoint
programs, as well as the new Entourage – a personal-information manager and email client.
Write to: Letters, Macworld, 99 Gray’s Inn Road, London WC1X 8UT.
Or email letters@macworld.co.uk. Please provide full name and contact details.

Subject: Appleless Apple
I’ve just read Fortune
magazine’s (www.fortune.com)
profile of Steve Jobs. The most
fascinating thing is his refusal
to put licence plates on his
Mercedes to avoid parking
tickets. What does this bode
for Apple products of the
future? An iMac with no OS
installed, so as to avoid crashes?
A PowerBook with no battery,
so as to avoid startup problems?
Macs with no logo, so as to
avoid pesky customers? Maybe
the logical outcome of his nonumber-plates tactic is the
Apple retail store without a
name – just a logo.
Rob McMinn

Subject: Free iBook
I bought a copy of the June
2001 edition of Macworld in
WH Smith. The CD was not
on the cover, but I asked a
shop assistant and they
fixed this for me.
However, even though the
magazine boasted “New iBook
Inside” on a bright yellow
sticker, I could find no new
iBook. The shop couldn’t help
me on this matter, so I turn to
you. Please send my iBook as
soon as possible.
Will Bramhill

Subject: Window of opportunity
In your review of Mac OS X,
you noted that, like OS X,
Windows XP will result in a
similar upheaval for its users.
However, Windows doesn’t have
the committed fans that the
Mac OS has. Does Microsoft
expect its casual users to learn a
new OS? I don’t think they will.
Ross Jelley
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Subject: Apple Be missing out
Apple should buy Be, which
is teetering on the edge of
insolvency. Apple would then
acquire an infusion of top-notch
engineering talent, obtain cool
Be technology to integrate into
OS X, and secure a nice path
to grow the OS past Windows
2000. Apple could buy Be
for around $40 million – the
engineers alone are worth that.
Dave Zihlman

Subject: Imperial or metric
Your review in the June issue
of the new iBook has its details
in pounds and dimensions
in inches. Isn’t it possible
for someone on your staff to
convert these to metric? I don’t
know many Mac designers still
working in inches. I find this
sort of thing as annoying as
“color” and “trash”.
Bill Kocher

The metric measurements were in the
second paragraph of the preview on
page 21. We do try to include both
metric and imperial – we get letters
from people who prefer pounds to
kilograms, as well. – ed.

Star Letter: OS 9.1 vs X
our advice on upgrading to Mac OS X was
spot on. Of course, even though I run a small
business, I ignored it and purchased a copy of OS X.
Just as you found, it’s nice to use and great fun. But
so many of the bits and pieces that hold daily life together –
WebShuttle, scanner, big Epson printer – don’t yet work with it,
even in Classic mode. After a while, you get fed up rebooting to
Mac OS 9.1, and go back to the old system to earn a living.
I eagerly await the arrival of upgrades of mainstream software
and drivers, and intend to dip back to OS X at regular intervals to
keep up to date. This is definitely the future. The best decision Apple
made was to enable people like me to switch between systems as
the world catches up with the advances in OS X.
One of the most exciting things about experimenting with OS X
has been working with new bits of software: OmniWeb is a great
alternative to Microsoft Internet Explorer, and I’m already a big fan
of GraphicConverter. I’m sure I wouldn’t have discovered these
without Mac OS X.

Y

Martin Whitfield

iTunes would only work on 9.1.
This wonder has been made
possible via a free patch,
available from
www.WormInTheApple.gr/
downloads/index.html.
Steve Howe

Cocoa. However, Cocoa is not
a programming language, it’s
the set of new OS X APIs that
programmers can use to write
their programs. The languages
in which you write Cocoa apps
are Java or Objective C.
Martin van Hensbergen

Subject: Crazy weirdness
How depressing to read Michael
Prochack’s War In NAMM piece
in the March 2001 issue.
It was essentially an extended
complaint that it’s now “easy”
for a talentless nobody to get
hold of a Mac and start making
mediocre music.
It’s similarly true that guitars
and saxophones come with no
talent included.
He declares: “there’s no
substitute for being able to
play an instrument”. There
was a time when this was
true. Now, that time has passed.

Subject: Aquq flab
Mac OS X’s Aqua interface takes
up too much room. My 1,024-x768-pixel monitor looks like it’s
running at 640-x-480, thanks
to those drop-shadows, antialiased text, and mega-icons.
Have Macintosh users been
complaining that everything
is too small? If I resize the Dock
to the manageable width of the
old Control Strip, then the eyepopping, screen-filling icons
become illegible. Where is my
readable, elegant, single-pixel
Geneva 10-point? It’s vanished
in a fugging fog of blury pixels.

Paul Sellars

Pete Farman

Subject: Retro iTunes
As I type this, I’m listening to
radio music via iTunes, on a
Umax Apus 3000 running
system 8.6! We were told that

Subject: Mind your language
In your OS X feature in June’s
issue you state that developers
can write native OS X code in a
programming language called

Subject: Doh! Selector
In trying to use the 2000 Issues
CD, I can’t access the October
issue from the Issue Selector. If I
click on the October front cover,
I’m taken to the September
issue. What can I do?”
Bob Evans

Apologies for this. Despite our checks,
we all missed this error.
Within the Inside Macworld
folder on this month’s CD, you’ll find
a folder entitled ‘letters’. This has two
replacement PDFs. Drag-&-drop the
entire 2000 Issues CD – not just the
contents of the open window – onto
your hard disk, and replace the Issue
Selector and Read Me 2nd PDF files
with the new ones. You should now
be able to access all 12 issues from
last year. You’ll need just over 120MB
of hard disk space for this.
Vic Lennard, Cover CD editor

Join in the live IT debates on Macworld Online Forum (www.macworld.co.uk/forum).
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Cover CD

A 30-day tryout of Adobe Photoshop Elements plus trials of Spark XL 2.0 and MarkzScout 2.0 head up this month’s CD.
The latest demos, shareware and updaters are included – plus a stonking demo of Rune! Vic Lennard leads the way…

MAIN ITEMS

Photoshop Elements 30-day tryout
Adobe Photoshop Elements offers unique features for
amateur photographers, hobbyists and business users
who want an easy-to-use, yet powerful digital-imaging solution.
State-of-the-art image-editing tools and flexible image-capture
options let you work with photos taken with digital or traditional
cameras, and versatile
delivery features enable
you to prepare images
for print, email, or
posting on the Web.
Requires a Power Mac
with Mac OS 8.6 or later,
and 64MB free RAM with
virtual memory on.

Spark XL 2.0 7-day trial
Spark is a two-track editor with 12 high-quality VST
plug-ins plus DeNoiser and DeClicker for audio
restoration. Create your own
playlists and burn them to CD.
Use the crossfade editor for
detailed crossfading and fades.
Includes cut, paste, pitch shift
and time stretching. Requires a
Power Mac with Mac OS 8.6 or
later and 48MB available RAM.

Rune demo
In this section of the full
game, assume the role of
Ragnar the Viking, mightiest
warrior of a bygone age,
who doles out justice on
the blade of his massive
battle-axe. Explore beautiful
settings as Ragnar fights
his way through stunning
kingdoms to an ultimate
confrontation with the
shadowy warrior-masters
of the netherworld.
Using the same engine
as Unreal Tournament,
Rune requires a Power Mac
with 3D video hardware
and at least 190MB of
available RAM. Check the
Read Me for more info.

Acrobat Reader 5
View, navigate and print PDF files.
Version 5 saves copies of files
downloaded in Web browsers and has
improved usability, drag-&-drop toolbar icons
and dynamic thumbnail generation, and
support for Adobe Illustrator 9.0 graphics
that contain transparency. Requires a Power
Mac running Mac OS 8.6 or later. For Mac OS
X, install in Classic mode but runs as Carbon.

Go to Macworld.co.uk for the latest daily news, hot reviews, buyers’ guide and special offers.

MarkzScout 2.0 trial
Create your own automated
workflow. Markzscout is designed
to fit into any pre-press operation and
streamline the preflighting process by
detecting problems and then activating
other applications to correct them
automatically. Includes a new PDF creator
and improved FlightCheck integration.
Test it out fully for 14 days.
page 14
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Cover CD
JULY 2001
INSTALL

The CD-ROM on the cover of Macworld is supplied as is, subject to the following terms and conditions. The CD-ROM is provided as a free
item to readers of Macworld for their personal use, and may not be resold or copied for distribution. The publisher shall have no liability
without limitation for any losses or damage arising from using cover-CD software – or for taking advice from Macworld’s CD troubleshooting point-of-contact – including any loss of profit, damage to equipment or data, interruption of business, or any other damage,
direct or accidental. It is strongly recommended that you back-up any programs or data on your hard disk before installing any cover-CD
software. If problems occur, it is most likely to be a result of an incompatibility or conflict with other software on your system. Macworld
cannot be held responsible for discontinued offers. This does not affect your statutory rights.

Before you start working your way through the software on our CD,
go to the System Utilities folder and make sure you install the following:

■ Acrobat Reader 5

■ StuffIt & RealPlayer

■ System tools & ATM Lite

■ QuickTime 4.1.2

Install this version to be able to read many
of the on-screen manuals.

Version 6.0.1 of StuffIt Expander and DropStuff is
included as is the installer for RealPlayer 8.

The CD also carries the latest version of InternetConfig,
UnZip 5.32 and ATM Lite 4.6.1 (required for Suitcase 9).

Some programs require QuickTime 4.1.2. This can be
downloaded from www.apple.com/quicktime/download.

INSIDE MACWORLD
BBEdit 6.1
HTML and text editor
designed for the
editing, searching,
transformation and
manipulation of text.

Cubase VST 5.0
Professional music
recording system that
combines high-resolution
MIDI sequencing
with 16/24-bit audio
recording. Demo.

Download
Deputy Turbo
Download manager
and accelerator in one
package. Create lists
of files you want
and then downloads
them later. Shareware.

UpdateAgent X

AmorphiumPro 1.1

Easy way to update all
the system software,
control panels, extensions,
applications and utilities
on your Mac. Preview.

Intuitive 3D modeller
with real-time 2D
brushes. Demo gives 24
hours of actual use.

CD CATALOGUE
plus…

Fetch 4.0
User-friendly FTP client
that allows point-&-click,
drag-&-drop file transfers.
Works with Mac OS X.
Fifteen-day trial.

DoubleTalk 1.0.1 update
Fire.app 0.25.c
Extension Overload 5.8.3
Ultra Lingua ES-ENG
Ultra Lingua FR-ENG-MED
VCD Player 1.4.8

Courtesy of Mark Pirri’s superb DiskTracker
program, Macworld brings you a searchable
catalogue of all our CDs from 1997 to
2001 – over 221,000 files! This will
grow month by month to allow you
to find any file you want, without
wearing out your CD-ROM drive. The
latest version of DiskTracker (2.1.1)

OS X HEAVEN

OS X Heaven – your monthly one-stop
shop for the latest OS X-specific software.
Utilities, demos, shareware and games
– OS X Heaven features the best Carbonized
goodies for the Mac’s new OS.
This month there’s 20 shareware
utilities including Interarchy 4.1, a powerful
and flexible Internet interface, Contact
Keeper X for storing useful contacts, Prefling,
a dockling that allows you to access all
panels of the System Preferences directly
from the Dock, and Mac Toolkit, an easy to
use and convenient desktop utilities bar.
You’ll also find three carbonized games
including Tic Tac Toe A-GoGo which has
the interesting feature of enabling the
computer to cheat. Enjoy!

SERIOUS SOFTWARE includes

Chaos Master 1.2.1
Chaos Master delves deeply into
the world of files and their interrelations. It’s also a utility to help you clean
up your computer’s hard disk. In fact, it’s a
collection of utilities that help you manage
your files. Clean out old, duplicate or
damaged files, update applications with
help from VersionTracker.com, uninstall
unwanted applications and related files,
and much more.
This demo allows you to look around the
program, to see how much space you could
save, and to see how many unneeded files
you could delete safely.
Requires Mac OS 8.1 or later and 5MB
available RAM.

is also included – don’t forget to
register if you find our library useful.

Andromeda
Perspective demo
View and manipulate your image
through Andromeda Perspective’s “lens”.
This is a unique Photoshop compatible plugin that uses a virtual camera in 3D space to
introduce or enhance depth or perspective
distortions in your images. Features include
360° rotation of images in any direction,
consistent perspective in multiple images or
in a string of text characters, and the ability
to zoom in/out of an image with ease.
Use factory presets with a visual interface
or create your own. A quick and intuitive
perspective tool.
This demo gives you full access to all
features but is save disabled.
page 16
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Cover CD

FAULTY COVER CD-ROM?
•If your cover disc is broken and you want a replacement CD, please contact
Kelly Crowley, on 020 7831 9252, or email at kelly_crowley@macworld.co.uk.
•If your cover CD doesn’t seem to work as it should, please check you have
read all the instructions on the cover disc pages carefully first. If it still
doesn’t work, then please email Woody Phillips at woody@macworld.co.uk.

JULY 2001
GAMES WORLD

DEMOS & GAMES

As always, Macworld’s Top 10 Shareware
Games folder plays host to a range of
interesting offerings.
David’s BackGammon now reaches the
big 4.0. New features include improved skills
on the computer’s side. Then there’s a couple
of Yahtzee-style games in Poker Dice 1.0
and Turtle Dice 2.1 plus the latest version of
MacSolitaire.
On the strategy side we have Double 2.0.3,
the latest demo of Take Away! and an
excellent Chinese tiles game in Zador.
Arcaders among you will enjoy Elf Forest
and Snake 1.2 while Legendary Lair 1.0.1
gives you an opportunity to put your roleplaying adventure skills to the test.

Mystery Island II demo
You are a navy seal serving on
the USS Volarus when your
submarine gets fired upon by an unknown
enemy. The ship is blown to pieces, yet
somehow you manage to survive. Drifting
all night, you wake up in the morning on a
sandy beach… somewhere. Walking around
the island you find a strange communications
panel. There is a message – aliens are
planning to take over the planet and
enslave all human life to mine its resources.
There are three power boxes somewhere on
the island sending rays up to a translucent
sphere on the top of a mountain. You must
disable them and destroy the portal.
Requires a Power Mac with
QuickTime 4 and 16MB available RAM.

(Top row) David’s BackGammon 4.0 & Zador
(Middle) Legendary Lair 1.0.1
(Bottom) Poker Dice 1.0

ALSO ON THE CD
COMMS & INTERNET
12 applications including:
CreativePage 2.6.1
DupliMizer 2.0.1
HTML-Optimizer 5.0
Interarchy 4.1
NotifyMail 4.0.2
EDUCATION
Three utilities including:
Language Assistant 2.1.1
QuickTTest 1.5

INFO

ATPM 7.05
WineBook 1.1
plus seven utilities
for developers

DON’T MISS…
Amazing Slow Downer 1.06
MP3 Rage 3.3
Virtual Composer 2.8.2
UTILITIES
Seven categories with
over 30 useful tools for
your Mac including:

MATHS & SCIENCE
FONTS

Four items including:
FontCat 1.3.5
SmoothType 2.2.3
GRAPHICS
Four items including:
Etchelon Macdoodle 2.2
GraphicConverter 4.0.7
Screen Catcher 2.3.4
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Six items including:
Atom in a Box 1.0.6
earthbrowser 1.5
Periodic Table 2.6.2

AltiVec Fractal Carbon
AutoCat 3.0.1
clipEdit 2.1.3
ConverTable Units 1.7.3
Default Folder 3.1.1
Doublet Scan 3.3.1
DragThing 4.0.2
Mac Army Knife 2.5.1

SCREENSAVERS
iScreensaver 1.5
Setting Sun 1.6
SOUND & MUSIC
Six programs including:

OneApp Clean Text 1.2.5

Pepper 3.6.5
Quick Rename 2.0
Rosetta 1.2.0
SwitchRes 2.5.1
TaskMenuBar 2.4.1
The Dailies 1.0.6
txt2pdf 4.6
UPDATERS
This month’s dedicated
updaters folder includes
over 45MB of patches
to bring many popular
applications bang
up-to-date, including:
Adaptec Toast 4.1.3 OEM
BBEdit 6.1 -> 6.1.2
Dreamweaver 4.01
FlightCheck 3.9r9
LaCie Updater 6.4.1
Norton AntiVirus 5-7 (05/01)
Retrospect Extension Upd
SoundJam 2.5.3
Toast Deluxe 4.1.3
Toast Titanium 5.0.1
Virex (05/01)
VirusBarrier (05/01)
VirusBarrier Updater 1.6
VST FireWire Updater 2.3.1

■ Cool Extras
Shockwave Installer
Latest version of
Macromedia’s essential
Web multimedia player.
ProcessGuard 3
View and control all running
apps – background as well.

■ Mac ISPs
Internet access offers from Abel gratis, AppleOnline & LineOne.

■ Netscape/Internet Explorer
Complete packages for Netscape 6 (with 6.01 update) and IE 5.

■ Plus…
… many thanks to Simon Youngjohns for our CD icons.

SHAREWARE
Shareware is a distribution method, not a type of software.
It makes fitting your needs easier, as you can try before you
buy. Shareware has the ultimate money-back guarantee – if you
don’t use the product, you don’t pay for it. If you try a Shareware
program and continue using it, you are expected to register.
Support shareware authors so that they continue to provide
high-quality programs for the Mac.

Go to Macworld.co.uk for the latest daily news, hot reviews, buyers’ guide and special offers.

25 Mac shops to open in

Apple says ‘Shop Different’
pple CEO Steve Jobs has
outlined plans to open
a chain of plush Apple
computer boutiques across the US.
“We’ll open a new shop every ten
days,” promised Jobs, as he took the
wraps off the first two outlets. Apple
will open 25 shops across the US this
year – with more in 2002.
The first Apple-designed shopping
experiences are open now. One is
situated just outside Washington DC
at Tysons Corner, McLean, Virginia;
another is in the upmarket Glendale
Galleria in Glendale, California.
Apple’s bold attempt to capture
consumer mind-share (and credit-card
details) has been public rumour for
months. Jobs praised the move as “an
amazing new way to buy a computer”.
“Rather than hear about
megahertz and megabytes, customers
can learn and experience what they
can do with Macs.”
Stores will open for business
across the US. Four are in Los Angeles,
with more in: Birmingham, Alabama;
Chicago; and Pittsburgh, Minneapolis.
More stores will appear in New York,
Ohio, Tennessee, Texas, Connecticut,

“We want to convince people that Macintosh
is much simpler, richer, and more human”
– Steve Jobs, Apple CEO

PHOTOS BY MACCENTRAL, EXCEPT GENIUS BAR BY LAURA DUNN

A

Grand opening
Apple CEO Steve Jobs minutes
before the opening of the Tysons
Corner store; a punter receives
advice at the store’s Genius Bar;
you wouldn’t see this at Dixons.

Florida and Washington. The third
store will open by the end of June.
Jobs revealed that the prototype
for the stores was constructed in a
warehouse deep inside Apple’s
Cupertino campus. Store content and
design was developed over two years
by a stealthily recruited team of Apple
executives, led by board member and
Gap CEO, Millard Drexler (Jobs is also
on the board of directors at Gap). The
executive team is led by Apple’s VP of
merchandise, Ron Johnson – once of
giant US discount retail-outlet, Target.
“We’ve seen a lot of smart people
try their hand at retail and get their
head handed to them,” Jobs said.
“We don’t want to be one of them,
so we’ve surrounded ourselves with
experienced people.”
Apple wants to increase visibility
and capture market share. Five per
cent of computer users are Macintosh
users. “We’ve got to ‘ambush’ the other

95 per cent by being where they’re
already at, locating in high-traffic
gathering places: malls, hip streets,
and lifestyle centres,” Jobs said. “We’re
going to be in top-tier locations.”

rightly designed, well-lit and
spacious, Apple’s big-city
plush corner shops are designed to
help customers get what they want.
The shops try to capture the essence
of the Macintosh-user experience,
taking it out of the box and into
the mall. Reflecting this, the front
windows of each store mirror
the Aquafied Mac OS X desktop.
Ten clearly sectioned areas focus
attention on what using the Mac OS
is all about.
The Product area showcases
current Macs. This area is split
into “Home” and “Pro” sections.
Solutions exists to help customers
add value to their Macs, and has four
sub-sections – Movies, Music, Kids
and Photos. Among other things,
these topical zones look at making

Apple’s five per cent “is higher than
both BMW’s and Mercedes-Benz’s
share of the automotive market. It
equals 25 million customers around
the world using Macs. If only five of
those remaining 95 people switch to
Macs, we’ll double our market share,”
said Jobs.
Johnson believes the stores will
attract over 100,000 visitors a week
during the Christmas period. Apple’s
CFO Fred Anderson affirmed: “We’ll
break even by the end of Christmas
shopping, and show a slight profit
next year.”
Analyst reaction remains positive.
AG Edwards analyst Brett Miller said:
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desktop movies, creating digital
prints, and burning custom CDs.
Kids can explore the latest
educational and gaming titles.
This section also carries a host of
third-party “digital-hub extensions”,
including MP3 Players, digital
cameras and camcorders, and PDAs.

Opening day (May 19) saw 7,700
shoppers turn out between the two
locations to spend $599,000.
“We are blown away with the
numbers,” said Jobs. “Customers have
told us they love everything about the
store – from the knowledgeable sales
staff at the Genius Bar to the store’s
design and unique approach.”
First-day customer, Patrick
Donohue said: “Customers can see
products in action. Apple has taken a
real hands-on approach to selling
computers.”
Praising the Genius Bar, graphic
designer Sean Copley said: “It’s a Gap
with Apple products. There’s an
aesthetic quality to using a Mac. It
goes without saying that its store
would be the same.”
Apple retail staff receive a month’s
training in Cupertino, and must have
great interpersonal skills, said Kathie
Calcidise, Apple’s VP retail operations.
Jobs called Apple’s staff
“craftspeople”. Johnson said: “We
want to select great people, train
them well, hire great managers, and
provide a great culture.”
As a major venture, Apple faces all
the traditional problems that beset
retailers. Leasing space in upmarket
areas is costly. Staff and training cost
money. Distribution is less of a

problem, but Apple must meet sales
targets. Business Week observes:
“Since PC-retailing gross margins are
normally 10 per cent or less, Apple
has to sell $12 million a year per store
to pay for the space.” Apple’s
advantage is that its margins could be
as high as 30 per cent.
Summing up the plan, Jobs said:

“We want to convince people that
Macintosh offers a much simpler,
richer, and more human-centric
computing experience. We believe
that the best way to do this is to
open Apple stores right in people’s
neighbourhoods.
MW
Dennis Sellers, Jim Dalrymple,
Jonny Evans, Lauren Dunn

UK wants Mac stores ‘immediately’

Think Genius
Staffed by experienced Macintosh
users, the Genius Bar supplies
solutions to customers’ Mac
conundrums. Should a question
stump the resident genius, then a
single call on the hotline rigged up
to Apple HQ provides an immediate
answer, claims Apple.
The Theater is a presentation
area with a ten-foot screen to
demonstrate the company’s award-

“Branded shops are material to Apple
being able to sell more and different
products to customers”.
Needham & Company analyst
Charlie Wolf said: “Stores are
essential if Apple hopes to grow
its installed base of users”. He
condemned the buying experience
in major computer shops for
Apple customers as “terrible”.
Reputable US executive’s bible
BusinessWeek said: “Given the typical
computer retailer’s disdain for Macs,
Steve Jobs can’t open his string of
upscale stores quickly enough”.

Jobs ‘blown away’
Profit by Christmas

Apple plans friendly
retail experience
B

US this year

PHOTOS: PAUL HARRIS/BWP MEDIA
KIDS: MACCENTRAL

Macworld News

winning software solutions, such
as iMovie, iTunes and Final Cut Pro.
The Software section stocks
300 of the best-available Macintosh
solutions, taken from a range
of subjects – including those for
small business and Web design.
The Etcetera section hosts a
wide assortment of third-party

peripherals, including printers,
scanners, graphics tablets, cables,
paper, ink and other accessories.
Not just a showroom, the retailtherapy stores hold stocks on hand
so customers can buy what they
want when they want, according
to Apple.
MW
Dominique Fidéle

For the information as it happens visit Macworld Online Daily News (www.macworld.co.uk), updated throughout the day

pple won’t discuss plans for international
stores. However, the company has said that it’s
“exploring many geographic locations for stores”.
Macworld’s UK readers would welcome the
move – 66 per cent want to see an Apple store
on their street “immediately”. For full details,
see www.macworld.co.uk/polls.
Apple UK is installing what it calls “Apple
ecosystems” in carefully chosen stores. These are
designed to show Apple products in the best light
and to visually express Apple’s user experience.

A

If Apple chooses to bring wholly owned
retail outlets to the UK, what would UK resellers’
reaction be?
Mygate’s managing director Maneesh Patel
told Macworld: “Limited numbers of stores won’t
provide the same service nationally. Resellers
can provide a full range of products and services
in places Apple stores don’t reach.”
Patel sees Apple’s stores as physical
manifestations of the online AppleStore: “Following
initial concerns, we did not find that the online

For the information as it happens visit Macworld Online Daily News (www.macworld.co.uk), updated throughout the day

Apple’s retail heaven
From top, and left to right:
Opening day at the Apple store
in Glendale, California; kids get
somewhere to play, too; an iMac
in the Home zone; PowerBooks in
the Pro zone; customers get to try
out Apple’s systems with expert
help at hand.

store really affected us. Apple stores could
generate new users – which would be good
for everybody.”
David Shaw, purchasing director for
onestopapple, agreed that: “Retail stores in the
UK would create more demand for Apple products”.
Looking forward, Patel said: “We’d work with
Apple to create similar store environments in the
UK. Such partnerships may be a way for Apple
to extend its concept beyond US shores.”
Jobs offers reassurance: “Our strategy isn’t to
put our resellers out of business, but to work side
by side with them. Our stores will help resellers
by increasing exposure to the Mac platform.” MW
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OS X ships in box; Apple discontinues last CRT Macworld News

X for free with all new Macs
pple CEO Steve Jobs surprised
pundits and industry insiders
alike at the Worldwide
Developers Conference (WWDC),
announcing that Mac OS X will ship
in-the-box with all Macs from May 21.
Jobs also revealed Apple’s plans
to offer an all-LCD flat-panel monitor
line-up, confirming rumours that
its 17-inch CRT (cathode ray tube)
monitor will be discontinued.
“We don’t have to talk about the
future any more. Mac OS X is here
now,” Jobs told the crowd of
developers. “The reception has been
so positive that we’ve decided
to pre-install it alongside Mac OS 9
on all Macs. We said we were going
to be pre-installing in July. We are
going to move that up two months
and are pre-installing today.”
New Macs will ship with Mac
OS 9.1 as the default OS, although
Apple’s Dual Boot technology means
that “it’s so easy to flip, we think
many will,”

A

Jobs said.
Macs without
OS X are still
available in
Apple’s sales
channels.
To compensate,
resellers have
been shipped flatpack versions of
OS X, containing
the OS X installerCD. While supplies
last, customers
will be given
these on the spot
when they buy a
Mac. Otherwise,
if you bought your Mac after May 21,
you can download a form from
www.apple.com/uk/macosx/uptodate/uptodate.html,
complete it and send it to Apple, and
the company will post you a copy of
Mac OS X for free.
“This will give all our customers
access to the world’s most advanced
operating system and ensure a ready
and lucrative market for Mac OS X
applications,” said Jobs. “This is a
total commitment on Apple’s part
and we ask the same from you.
The train has left the station.”
However, low-end Cubes and
iBooks ship with only 64MB of RAM.
This is enough to run OS X, but not
Classic. Apple recommends 128MB.

Apple flat out
Meanwhile, Apple’s 17-inch CRT
has been dumped in favour of a
new 17-inch Studio Display – a digital
LCD featuring a 1,280-x-1,024-pixel
resolution for £699 (see page 90).
Apple also slashed the prices of its
two digital LCD displays. The 22-inch

Cost of CD-R
media to rise

Apple Cinema Display is now £500
cheaper, at £1,799, and the 15-inch
Apple Studio Display is available
for £449, a price cut of £130.
“Apple is the first company to
move to an all-LCD display line-up
– the all-digital desktop has finally
arrived,” said Steve Jobs, Apple’s CEO.
“Apple’s complete line of affordable
digital LCD displays are far brighter
and sharper than the CRTs of old.”
Apple claims its digital displays
provide crisper images than analoguedriven flat-panel displays. The alldigital interface produces “sharp,
flicker-free images that need no
adjusting via user controls, such as
those required by CRTs”. The displays’
active-matrix technology provides
“extraordinary brightness and
contrast with no image degradation”.
Apple has also introduced
Mac OS X in eight additional
languages: Swedish, Danish,
Norwegian, Finnish, BrazilianPortuguese, Korean, and Traditional
and Simplified Chinese.
MW

Jonny Evans

The cost of CD-R-media is
set to rise, following last
year’s manufacturers’ price
war. Major manufacturers –
thought to include Memorex,
TDK and Verbatim – are
expected to announce price
increases of up to 350 per
cent over the next few
weeks. The manufacturing
base for the media has
shrunk since 1998, when
between 60 to 80 companies
produced CD-R discs.
Production reached 100
million discs per company
per year. This led to
a severe
worldwide
glut of discs.
Industry
insiders
explained:
“They were
producing
discs with no firm purchase
orders from anybody.”
As the standard gained
converts, demand increased
by up to 84 per cent in 2000.
Manufacturers slashed
prices to shift their surplus
product, assessed at one
billion discs.
But now demand is set
to outstrip supply. Global
sales of CD-R media will
reach 4.5 billion this year
alone.
MW

Apple is design king gong – again
A

pple cleaned-up at the D&AD (British Design
and Art Direction) awards again this year, taking
three top awards in the Products for Work category.
D&AD presented four Gold Awards this year; two for
environmental design and architecture, one for ambient
media, and one for Product Design – which Apple
picked up for its Pro Mouse.
Silver awards were presented to Apple for its G4
Cube, Pro Speakers and Pro Mouse. Among those
collecting awards for Apple at the ceremony – held at
London’s Earls Court 2 on May 30 – was Oren Ziv,

director of creative markets for Europe (pictured right
with TV’s Ruby Wax).
D&AD is a professional association and charity
that represents the UK’s design and advertising
communities. Its awards are internationally respected
in the design and advertising industries as benchmarks
of excellence.
Last year, Apple won a D&AD Gold Award for its
Jonathan Ive-designed Cinema Display, while the Power
Macintosh G4 and iBook scooped silver awards.
MW
Jonny Evans

Go to Macworld.co.uk for the latest daily news, hot reviews, buyers’ guide and special offers.
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Raft of new software ships to OS X Macworld News

X-appeal reels
in new apps
pple continues to improve
Mac OS X, with a raft of
updates released in the past
month. Among these is Mail Import
Script 1.1, which imports messages
from most email applications into
Mail, the Mac OS X email client (for
a review of Mail, see page 98). As we
went to press, there was rumour of
another imminent full-system OS X
update. This follows the release of
OS X 10.0.3 on May 3.
QuickTime Streaming Server has
been updated to version 3.0.1. This
adds skip-protection, Web-based
administration, improved
authentication and sturdier
broadcasting support.
Key applications and peripheraldriver releases are more of a trickle
than a flood. Many vendors are
waiting for OS X’s installed user-base
to expand, in order to make their
development effort worthwhile –
something particularly true of
publishing developers.
Office 2001 for OS X from
Microsoft is due in the autumn,
and many other key players are
also waiting until then – expecting an
increase in demand following Apple’s
decision to ship OS X with all new
Macs from May 21 – two months
ahead of schedule.
Microsoft has also released its free
5.1.1 update for Internet Explorer 5.1
Preview, which ships with OS X.
It’s available through Mac OS X’s
Software Update feature, but
is unavailable on the Web. This
update runs with Mac OS X 10.0.3.
Makers of third-party peripherals
are answering the call from OS X early
adopters for drivers. Lexmark is
delivering on its promise to support
OS X – drivers for
its Z53 and Z43
series

A

printers are now available as free
downloads from the company’s Web
site (www.lexmark-europe.com).
Hewlett-Packard has also released
a set of OS X printer drivers for its
PhotoSmart 1000 and 1200 ranges
of printers. These drivers replace
those installed with OS X and are
available from www.hp.com.
Adobe announced at the National
Association of Broadcasters trade
show that an OS X-native version
of Premiere will be available “in the
summer or autumn of this year”.
Version 5 of Adobe’s Acrobat Reader
also now runs natively in OS X –
although Adobe stresses that it has
not been fully tested.

Font of knowledge
Adobe has announced that it
will not make its ATM Deluxe font
manager OS X-native. However,
Extensis and DiamondSoft do
plan on updating their fontmanagement products – Suitcase,
and Font Reserve respectively.
Macromedia’s X-compatible
£279 FreeHand 10 vector-graphics
application is available to buy.
Features include Master Pages, tighter
integration with Macromedia Flash 5,
and the ability to publish both on the
Web and in print.
FileMaker Pro 5.5, from FileMaker,
offers native support for Mac OS X.
This database solution makes full use
of Aqua, Mac OS X’s slick new userinterface. This version offers improved
Web-publishing features.
(www.filemaker.com).
Apple recommends that OS X
users frequently run the built-in
Software Updates preference to keep
up-to-date. There are also are thirdparty solutions that will track
software updates for all installed
applications. Update Agent X from
Insider Software, and TechTracker Pro
OS X. TechTracker is free for a 30-day
evaluation from www.techtracker.com.
A beta version of Norton AntiVirus
7.0.2 has been released by Symantec.
It scans OS X discs for viruses, and
is available for a free trial download.
(www.symantec.com).

Go to Macworld.co.uk for the latest daily news, hot reviews, buyers’ guide and special offers.

The delay in delivering key
applications to Apple’s Unixpowered platform has presented
an opportunity to both smaller
and established developers.
One such developer is the Omni
Group (www.omnigroup.com), which has
dedicated itself to making “software
development fun again”. It calls OS X
“the most rewarding platform
available to develop for”. Its NeXTprogramming background has led
to the release of a slew of products.
Foremost among these is OmniWeb,
which has won much praise for its
graphics rendering (see Reviews,
Macworld, June 2001). Other Omni
products include OmniGraffle, a
charting and drawing program,
OmniOutliner, a project manager,
OmniDiskSweeper, a file manager,
and OmniObjectMeter, a developers
app. The Omni Group also has
some free software for download.
Other developers are
concentrating on general-purpose
software. StimpSoft has released Son
of Weather Grok (www.stimpsoft.com/
products/sonofgrok.html). This offers hourly
updates of temperatures worldwide.
And Iconata (www.fabricata.com/iconata) is a
tool from Fabricata (see below) that
customizes icons in OS X.
MW

By Jonny Evans and Dominique Fidéle

On the CD
■ BBEdit 6.1 from Bare
Bones Software
(www.barebones.com) is the
first version of the HTML
and text editor to run
natively on Mac OS X.
FTP support is improved.
The application costs
£99 and is available from
Mygate (020 8297 9699).
■ Fetch Softworks’
(www.fetchsoftworks.com) $25
Fetch 4.0 has become
the industry-standard app for
FTP (File Transfer Protocol).
Mac OS X-compatible, it
uses the Aqua interface
and is also compatible
down to System 7.
■ Insider Software’s
(www.insidersoftware.com)
UpdateAgent X is an
updater for Mac OS X. It
can automatically download
the latest Carbonized
versions of software, and
holds information for 5,000
products. It costs $9.95
for a single user.
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WWDC: Apple makes robust play for networks

X-rated Server goes Aqua
pple announced Mac OS X
Server, WebObjects 5 and new
G4 Power Macintosh server
configurations to developers gathered
at the company’s Worldwide
Developer’s Conference (WWDC)
in May (see page 23).
Mac OS X Server is now built on
the true Mac OS X release. Reflecting
Apple’s platform-level shift to a Unixbased operating system, it integrates
a variety of powerful server
applications. These include the
industry-standard Apache Web Server,
which powers 63 per cent of Web
sites, according to Netcraft’s April
2001 Web Server Survey. Other
sophisticated OS X Server features
include Samba for Windows file
sharing, WebObjects 5 and QuickTime
Streaming Server 3. The applications’
cutting-edge features are accessed
through Apple’s user-friendly Aqua
user interface.

A
Java 5 alive
A

pple has announced
version 5 of WebObjects,
its pure Java-based
application server for Web
publishing and in-house
enterprise application
development. Its solutions
can be hosted on any Javacompatible server.
Apple’s own online
AppleStore is hosted on
two Mac OS X Servers,
and was constructed using
WebObjects. Another highprofile UK client is the BBC,
which uses the application
for its online presence.
Built-in tools include
a Project Builder, Direct
to Web and Direct to Java
for three-tier Web and
Java applications, and
WebObjects Builder, to
simplify the design of HTML
interfaces. Tools for database
modelling are also built-in.
At the heart of the new
£492 version 5 is Java 2
Standard Edition version 1.3
runtime. Java 2-accredited
servers include Mac OS X
Server, Solaris 8 and
Windows 2000 Pro. MW

Apple has announced its summer range of
G4 servers – the single-processor 533MHz
Power Mac G4, and dual-processor 533MHz
Power Mac G4. Both ship with Mac OS X and
OS X Server installed.
The Macintosh Server G4 with a single
533MHz processor, 256MB RAM, 60GB hard
drive and Mac OS X Server Unlimited Client
Edition costs £2,099 (ex. VAT). The hardware
features are otherwise identical to those of
the 533MHz Power Macintosh.
The £2,799 dual 533MHz processor Server
G4 also offers 256MB RAM, 60GB hard drive
and Mac OS X Server Unlimited Client.
A souped-up version of this model with
a 72GB Ultra160 SCSI hard drive, and dualchannel SCSI card costs £3,849.
Apple’s iServices team is offering Mac OS X
Server training courses and certification
programs for system administrators.
All Apple’s server systems ship with fourport ethernet cards so the servers can serve up
different sites on different ports over different
connections – or multitask as both a mail and
a Web server.

Power, simplicity, elegance
The new iteration integrates all
the server functions of the previous
version of Mac OS X Server, and
adds all the features of AppleShare IP
and WebObjects 5.
Apple’s vice president of
worldwide product marketing Phil
Schiller claimed: “Mac OS X Server has
the power of Unix, yet is simple and
easy to install, administer and
maintain. It’s Apple’s most powerful
server ever and can integrate with
Mac, Windows and Unix networks.”
Because this version of Apple’s
Server solution fully implements all

Apple seals default ISP deal with Demon
pple and Demon have forged a multi-year
alliance that makes Demon the exclusive
Internet Service provider (ISP) in Apple’s Internet
setup software included with all Macs sold in the
UK. Previously, Apple offered a choice of ISPs at
startup, including BT, Direct Connection and Demon.
When new users access Apple’s Internet Setup
Software feature they will be directed through
setting-up and installing a Demon Internet account.
Demon’s basic dial-up account costs £11.75 per
month. Apple will make a “substantial amount” from
Demon for each customer signing up to the service.
Demon promises a “full range of well-priced
services” for Macintosh users. New users will get a
30-day free access trial if they select Demon as their

A
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ISP. Of course, users do not have to choose Demon,
and can pick any Mac-friendly ISP – including
several free services.
The deal is Apple’s first outside of the US.
Apple partnered with EarthLink at San Francisco’s
Macworld Expo 2000 – see Macworld, March 2000.
Demon won the ‘Best Overall ISP’ award in Net
Magazine’s June 2001 ISP survey, and is the most
popular ISP for medium-sized businesses, according
to a recent Oftel survey.
The partners are expected to announce a number
of services exclusively for Macintosh users. They
revealed that they have been working together for
four years to create the best “Internet experience”
for UK Macophiles online.
MW

Visit Macworld’s Web site for the latest daily news, hot reviews, buyers’ guide and special offers.

the features of its Mac OS X release,
users also get protected memory,
pre-emptive multi-tasking,
symmetric multiprocessing, advanced
memory management and full
implementation of all the latest
networking and security standards.
Apple is also proud of its built-in
fault tolerance systems. These have
been developed to automatically
detect and recover from failures in
system services. This means network
admins can set the server up to
reboot itself if the whole system fails,
and to apply its own fault-tolerance
diagnostic and repair in the event of
individual application failures.
The server is also controllable
remotely. Administrators can change
settings or apply security adjustments
from wherever they happen to be.
Apple says the implementation of
such fault-tolerance systems also
reflects the company’s unique ability
to offer full integration between its
software and hardware.
Mac OS X Server will control
intranets and internal networks, too.
It can share files and printers with
Mac, Windows, Unix and Linux clients
and offers a host of useful network
features. One major advantage of
its implementation is the fact that
a Windows user can log on and see
all devices (printers, for example)
attached to a network.
The NetBoot feature permits
users to create a single image of the
operating system accessible by client
computers on the network. In this
way all the Macs on a network can

“Mac OS X Server reboots itself if the
whole system fails, and applies its own
fault-tolerance diagnostic and repair in
the event of individual application failure”
sing from the same hymn sheet. OS X
Server can support up to 50 clients
from one server, with the client Macs
booting up from the server rather
than their internal drives.
The Macintosh Manager feature
lets administrators create small,
individual disk images on the server.
Privileges (such as application access)
can be defined for each disk image.
Built for use in corporate and
educational environments,
this feature makes it a complete
no-brainer to ensure that users saving
work do so to the server, rather than
to their own hard drives. Whenever
users on the network log in – no
matter from which machine – this
feature means they will see their
own desktop and files.

User-friendly Unix
“We’ve done a great deal of work
to make the system admin more
user-friendly. We’ve also added the
ability to define access privileges
for each user,” said Apple UK’s Stuart
Harris. “It’s possible for a user to get
all their documents and applications
from the server”.
The Server also offers full support
for email protocols, including SMTP
(Simple Mail Transfer Protocol),
(Internet Message Access Protocol)
IMAP and POP (Point of Presence).
These three protocols are used every
day to enable email over the Internet.
The Server also supports WebDAV.
This is a set of extensions that enable
collaborative Web publishing and
remote-content management.
The World Wide Web Consortium
hopes that WebDAV will one day

let users collaborate over the Web
in the same way some already do
over corporate intranets.
It also has a built-in IP filtering
Firewall, and is capable of deploying
a series of IP addresses for a network
– called Dynamic Host Configuration
Protocol or DHCP. This DHCP support
offers users greater security.
Confirming this stress on security,
Apple announced that it has taken
a seat on CERT (the Computer
Emergency Response Team
Co-ordination Center), the Internet
hacking watchdog organization
funded by the US government.
Mac OS X Server is available in
both ten and unlimited client
varieties. The ten-Client edition costs
£339 (ex. VAT), while the unlimited
client version costs £680. It costs
£339 to upgrade from the ten-client
to the unlimited-client version of
the solution.
MW
Jonny Evans

ATI readies next-gen 3D graphics
ATI, which supplies graphics cards for Apple’s iMacs, iBooks and
PowerBooks has unveiled a new rendering technology called Truform,
which is supported in OpenGL and designed for future generations of
graphics processors. It adds detail to 3D objects, making them look more
natural by giving them smoother surfaces with more accurate lighting.
In games and computer graphics, 3D images are composed of
triangles. The more triangles, the higher the level of detail and realism.
However, adding triangles takes time, effort, memory, and bus bandwidth.
Truform uses a new type of higher-order surface composed of curved
triangles – PN Triangles, dubbed “N-Patches” by ATI – that permit
surfaces to be generated entirely within the graphics processor.
And it doesn’t require any more bandwidth or memory.

Easy implementation
What’s more, for existing 3D artwork composed of flat triangles, Truform
doesn’t require significant changes but rather enhances those models by
adding triangles within the current form. This makes Truform compatible
with older graphics processors, and therefore easier for software
developers to implement in their games.
“N-Patches also allows for a higher level of scalability, meaning the
number of triangles or polygons in a 3D image can be varied according
to the capabilities of the installed graphics hardware,” said Toshi
Okumura, ATI senior product manager of desktop marketing.
“N-Patches can take 3D models with low polygon counts and generate
smooth, highly detailed images, affording most users a greatly enhanced
visual experience with no compromise in performance,” added Okumura.
ATI expects to ship Truform-enabled chips for both PCs and Macs
before the end of 2001. And because the company has been working
with game developers on Truform since November, ATI expects several
games that utilize the new technology to ship around the same time.
Mathew Honan

Macworld JULY 2001

25

Macworld News

Hitch Hiker’s AppleMaster bought UK’s first Mac

In The Hitchhiker’s Guide to
the Galaxy, Deep Thought, a
“stupendous supercomputer
the size of a city block,”
requires 7.5 million years
to answer “the ultimate
question of life, the universe,
and everything.”
The answer (42) is pretty
close to the number of Macs
Douglas Adams has owned.
Adams used his Macs to
experiment with interactive
fiction and online games –
such as his own, Starship
Titanic (see right).
We spoke to Adams
during last year’s July
New York Macworld Expo.
Here’s an interview extract:
MW: Just how many Macs
do you currently use?
Adams: My main ones are
a PowerBook and a G4 with
a Cinema Display. I have an
embarrassingly large number
of old Macs: some iMacs,
a blue-and-white G3. My
oldest Mac these days is
a 20th Anniversary Mac,
which I want to set up
for Internet radio.
MW: Which piece of
Mac-related paraphernalia
can’t you do without?
A: The Cinema Display. It is a
stupendous piece of kit. I use
Final Draft and Inspiration
a lot. And Microsoft Word,
I suppose. Also, iMovie has
been a bit of a revelation for
me, and I’m working my way
up the nursery slopes of
Final Cut Pro.
MW: Pick an iMac flavour.
A: Mint. A completely clear
iMac. An obvious gap in
the range.
MW: What was it like
making your first iMovie?
A: I loved it. I’ve done a
bunch of iMovies since then
as well. In fact, I’m going to
have to scrub that software
off my machine soon, or I’ll
have too much fun and not
do enough work.
Interview by Adelia Cellini
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ritish AppleMaster Douglas
Adams, author of The Hitch
Hiker’s Guide to the Galaxy
(HHGG) radio/novel/TV series, died
suddenly aged 49 on May 11 in
California following a heart attack.
At the recent Macworld Awards
ceremony in London, another literary
Mac fanatic, noted comic and close
friend of Adams, Stephen Fry told
the audience that he believed himself
the owner of the third Mac ever
purchased in the UK – Douglas Adams
had bought the first two.
Adams described his relationship
with the Mac as “love at first sight”.
“It was the first time I came
across a computer that seemed to be
designed by someone with a creative
imagination,” he said in an interview
on www.apple.com/applemasters/dadams.
“I’ve been a Macintosh user for as
long as there have been Macintoshes,
right from the very first one. It was
elegantly thought out, intuitive, and
it was such a pleasure to use that
you wanted to hug it. It was also
ludicrously slow and underpowered,
of course, but that was a small price,
as Butch Cassidy said in the movie,
to pay for beauty.
“Most of the people I know
use Macs, and it feels like we’re
a privileged minority, though the
odd thing is that, unlike Mercedes’
or BMWs, they are not significantly
more expensive than the competition.
Why does anybody use anything
else?” ruminated Adams.

Intergalactic satire
The author became a household
name when the quirky cult sci-fi
novel was turned into a television
series. HHGG, published in 1979
after a successful BBC radio series,
was a satirical adventure about
a group of intergalactic travellers.
It opens with the Earth being
destroyed to make way for an
intergalactic superhighway. It sold
more than 14 million copies worldwide.
It was followed by the sequels The
Restaurant at the End of the Universe,
Life, the Universe and Everything, So
Long, and Thanks For All the Fish, and
Mostly Harmless
At the time of his death Adams
was working on “the 137th rewrite

MARK JOHANN

So long, Douglas
Macs, the
Adams…
universe and
everything
B

Starship Titanic
Macworld Games Room editor Peter Cohen on
Adams’ Starship Titanic: “The game exhibits all
the trademark wit and bizarre, surreal situations
you’d expect from any Adams opus, with
fantastically detailed surroundings created by
Oscar-winning designers. There’s also a great
cast of characters, including a deranged parrot
voiced by Monty Python’s Terry Jones. The game
is beautiful to look at, fun to play, entertaining,
and promises dozens of hours of challenge as
you unfold all of the game’s mysteries.”

of The Hitchhiker’s Guide to the
Galaxy movie screenplay, an all new
novel, and a new secret project”.

Mostly harmless
“He brought wit to science fiction.
His ability to connect cosmic ideas
with the banal commonplaces of
everyday life was unique,” Fry said
after his friend’s early death.
“Over the past 10 years he
concentrated less on writing and
more on bridging the cultures of
science and the arts in lectures
and broadcasts all over the planet.
He spread the word of the Internet

Go to

years before anyone outside
universities and the American defence
dept had ever heard of it,” Fry added.
“He never had the aggression or
single-minded ambition to profit from
the dotcom boom, which he regarded
with tolerant scepticism,” said Fry.
“His Internet was much more than
a flash travel agency or dating service,
it was a chance to change the way
people thought and advanced.”
In HHGG, the planet is described
as “mostly harmless”. Fry said that
Adams had once suggested these
words as his epitaph. Now Fry
suggests instead the words of Steve
Jobs, Apple CEO: “Insanely great”.
Biological guru and author of
The Selfish Gene Richard Dawkins said:
“I have seldom met a more congenial
spirit. And in modern electronic
technology, he was a real expert.
Science has lost a friend, literature
has lost a luminary, Apple Computer
has lost its most eloquent apologist.
And I have lost an irreplaceable
intellectual companion and one
of the funniest men I ever met,”
Dawkins concluded.
Read thousands of tributes
(and leave your own) at
www.douglasadams.com.
MW
Douglas Noel Adams, 1952-2001
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733MHz PowerPC G4 vs 1.5GHz Pentium 4

MHz: myth or reality?

LAB TEST

o to a Macworld Expo keynote
speech, and you’re bound to
see a demo that shows a Mac
blowing away its Wintel rivals. Apple
execs run an Adobe Photoshop file on
machines with the fastest available
PowerPC and Pentium processors:
the Mac sprints to the finish line first,
and the Wintel PC staggers down
the home stretch like a weekend
jogger running a first marathon.
Apple’s point is simple: megahertz
numbers aren’t everything. Chip
architecture is just as important—
that’s what helps a PowerPC CPU
outperform a faster Pentium chip.
At January’s Macworld Expo, a 733MHz
Power Mac G4 finished a Photoshop
test 33 per cent faster than a PC with
a 1.5GHz Pentium 4 processor did.
Does Apple’s example hold up
in a real-world road race? We ran six
Photoshop 6.0.1 operations on the
fastest PowerPC and Pentium chips
we could find: a 733MHz Power Mac
G4 and a Gateway Performance
1500XL with a 1.5GHz Pentium 4 chip.
Going up against a P4 chip twice
its speed, the G4 more than held its
own. The Mac and the PC performed
most of the tasks in about the same
time, with the Mac the decisive
winner in two tests.
How did a Mac with a 733MHz chip
outperform a 1.5GHz machine? Credit
AltiVec, the subprocessor built into
a G4. It allows the chip to render
graphics and perform calculations
faster than an ordinary PowerPC CPU.
Adobe designed Photoshop to take
advantage of AltiVec; hence the Mac’s
speedy performance in Photoshop
tests. (In April, Adobe announced
an optimizing plug-in for the P4.)
But try other applications, and the

G

1GHz PowerPC
in ‘late 2001’
IBM’s PowerPC development
team aims to develop chips
capable of hitting 1GHz late
this year, aiming to reach
2GHz in 2002. Though
this development still
hangs on the coattails of
Intel and AMD, it could offer
significant speed advantages
to Apple’s computers.
Intel plans to reach 2GHz
with its Pentium 4 in 2001’s
third quarter. However, many
tests prove that despite the
on-paper chip-speed-gap,
the performance difference
remains slight (see right).
IBM’s newest PowerPC
chip (code-named Sahara)
will be announced later
this year, sources say. It will
be theoretically capable of
1GHz performance. Reports
claim Motorola is set to ship
a follow-up version of the
current 7450 chip (codenamed Apollo) later this year.
This will also reach 1GHz,
with 2GHz chips from
Motorola promised in 2002.
Both IBM and Motorola
will be implementing their
own versions of advanced
technologies (for example,
IBM’s Silicon-on-Insulator
technology) to build these
high-speed PowerPC chips.

account for the PowerPC’s lower
Quake III frame rate. Most PCs have
a sound card to take the load off the
host CPU during game play; the extra
processing demands on Apple Sound
Manager sent the Mac’s score even
lower. With Sound Extension turned
off, the PowerPC’s scores improved.
It’s not just marketing spin when
Apple says processor speed isn’t the
only way to determine whether a
computer will zip through a task.
But if the other factors involved don’t
favour the Mac, performance will lag
behind that of a Pentium machine,
megahertz gap or no.
MW
Jeffy Milstead & Philip Michaels

speed advantage that the Mac enjoys
over a Pentium PC quickly evaporates.
Operations in Microsoft Office took
longer on the G4 – more than three
times as much time in one case. Only
line-by-line scrolling tests in Word
and Excel were faster on the Mac.
The MP3-encoding test is a perfect
example of the G4’s worst-case
scenario. Since the Mac version of the
MVP player and encoder hasn’t been
optimized for AltiVec, the G4 lags
behind the PC version. (When running
AltiVec-friendly SoundJam, the
PowerPC edges out the Pentium.)
Architectural differences between
the Mac and Windows platforms

More than just megahertz? Macworld Lab’s real-world performance tests
Best results in test.
Photoshop 6.0.1 (results in seconds)

Shorter bars are better (except in Quake III tests, when longer is better

RGB to CMYK

Total time

Lighting Effects

Rotate 0.3 degrees

5

6

2

14

9

6

42

1.5GHz Pentium 4 PC

7

4

3

23

12

6

55

Document scroll

28

Resize 50%

Unsharp Mask 2.3

Gaussian Blur 10
Power Mac G4/733

Microsoft Excel 9 (results in seconds)

Microsoft Word 9 (results in seconds)
Search & Replace
Auto-summarize

Recalc

Quake III (fps)
Time demo

MVP 1.2 (seconds)
MP3 encode

Document scroll

Power Mac G4/733

17

49

29

36

11

276

82

1.5GHz Pentium 4 PC

51

40

8

22

38

188

126
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Upgrades to use OS X as multiprocessor lever Macworld News

Card makers in power play
he Macintosh platform’s largest
upgrade-card manufacturers
have stepped up their efforts
to double the Mac’s processing power.
Sonnet Technologies and XLR8 are
now shipping dual-processor upgrade
cards, while PowerLogix continues
to develop its own. The upgrades
are designed to take advantage of the
multiprocessing support in Mac OS X.
Sonnet was the first to market,
with its Encore/ST G4 Duet card. This
£680 card features two 500MHz G4
processors, each with its own 1MB
of backside cache. Duet works with
Power Mac G4s with AGP graphics.
It replaces the original processor
daughtercard in the Mac, and
requires no software. It’s also
compatible with Mac OS X.
Sonnet is also looking to
develop multiprocessor upgrades
for older Macs.

T

Sonnet sales joy
Sonnet is planning OS X-supporting
multiprocessor products for earlier
Zero Insertion Force (ZIF)-based Macs
(such as blue-&-white G3 machines)
and PCI Macs such as the Power Mac
8500 and 9500 series. While Sonnet
plans to expand its multiprocessor
efforts, XLR8 is already shipping the
first of its ambitious multiprocessor
upgrade product line. XLR8 has based
its latest upgrade cards on both ZIFprocessor packaging and the
company’s Carrier ZIF product, to
allow for upgrades in a wide variety
of PCI Macs. XLR8 has
adopted a modular

approach for using ZIFs to upgrade
Macs. The company began labelling
its ZIF upgrades last summer as
multiprocessor-enabled (MPe).
Extra connections increase
production costs, so no ZIF packages
other than XLR8’s have adopted this.
Once XLR8 had its G4 ZIF cards
enabled to serve as multiprocessors,
the company had to find a way to put
two CPUs in a single processor-slot
or ZIF socket. XLR8 came up with two
methods – each for a different family
of Macs.
For PCI Macs, such as the 8500
and 9500, XLR8 created the Carrier ZIF
MPe (£115). This approach attaches to
the company’s MACh Carrier G4 MPe
upgrade card, which has one ZIF
socket and one Light Insertion Force
(LIF) socket. LIF is similar to a ZIF, but
with no lever. You choose what speed
the G4 in the LIF socket is. You can
choose to buy another G4 for the
ZIF socket, or buy the card with
the ZIF socket empty.
For ZIF-based Macs like
beige G3s, blue-&-white G3s,
and early non-AGP G4s, XLR8
offers the MACh Velocity G4 MPe
upgrade card. This card works
much like the MACh Carrier G4
MPe – it has LIF and ZIF

sockets, and you choose how to
populate them. What’s the difference?
You don’t need a Carrier ZIF MPe, but
do need the proper-speed MACh
Velocity G4 MPe. For instance, owners
of beige G3s need the MACh Velocity
G4 MPe 66, for this Mac’s 66MHz bus.
Blue-&-white G3s and non-AGP G4s
with 100MHz busses need the MACh
Velocity G4 MPe 100. ZIF processors
can be added to any empty slot in
XLR8’s MPe carriers – a key selling
point. It means old processors can be
kept, or replaced by an XLR8 G4 MPe
ZIF upgrade, and then put into a
multiprocessor upgrade.
The company is selling double-G4
processor upgrades, utilizing the
new technology for both 100MHz
and 66MHz bus speeds. A pair of
400MHz G4s costs £845, a dual450MHz upgrade costs £925, and
the twin-set G4 500MHz MACh
Velocity G4 Mpe costs £1,169.
There are drawbacks when using
a G3 processor on a non-MP-enabled
G4 in XLR8’s multiprocessor upgrades.
XLR8’s director of engineering Chris
Cooksey said: “Use a G3 processor in
the empty ZIF socket and you’ll lose
the G4’s AltiVec capabilities that came
with the multiprocessor upgrade.

Performance boost
“If you use a non-MP-enabled G4,
you’ll get AltiVec – the subprocessor
technology that speeds up certain
applications. But you may also
experience slower performance,
since non-MP-enabled G4s lack the
extra connections needed for superior
performance. That also happens if
you use a G3 and G4 as your two
processors, because the G3 doesn’t
have these connectors.”
PowerLogix demonstrated its
first multiprocessor design back
at the Macworld Expo 2000 in San
Francisco but hasn’t shipped any
multiprocessor upgrades since.
The company is still working on
multiprocessor upgrade cards,
says marketing director Robin
Sharp-Howdershelt: “We will
announce an MP ZIF processor
upgrade and a dualprocessor upgrade for
AGP Macs. However,
there will be no MP PCI
upgrade, because this
will be too pricey.” MW

iMac doublememory deal
Apple has launched a
special double-your-memory
promotion for buyers of new
iMacs. The memory giveaway is available from
participating dealers only.
These include most
AppleCentres, the Online
Apple Store and most major
resellers, who will double
the iMacs’ standard installed
RAM. Apple is footing the
bill.
iMac 400MHz and
500MHz models – which
ship with 64MB of RAM
installed – as well as older
iMacs still in the retail
channels – iMac 350MHz,
DV and DV Plus – will all be
upgraded at point of sale
with an extra 64MB of free
RAM. iMac 600MHz SEs, as
well as older end-of-line
iMac DV SEs, get 128MB of
extra RAM.
Apple recommends a
minimum 128MB of RAM
to run OS X in Classic mode.
Confirm that your dealer is
supporting this promotion
before purchasing your iMac.

David Read
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Games news for the Macintosh world

E3: Civ III for Mac confirmed
uring E3, the video-game
industry’s largest trade show
(held at the Los Angeles
Convention Center, May 17-19),
Infogrames’ MacSoft division
announced that it will ship the
long-awaited Civilization III for Mac.
Calling Civilization “a standard
against which all other strategy
games are judged,” MacSoft
marketing manager Cindy Swanson
said her company is enthusiastic to be
publishing the game, and is expecting
an equally avid response from Mac
players.
The game is the latest title to be
designed by the legendary Sid Meier.
Civilization titles have sold a total of
more than four million units to date,
a terrifically impressive number by
any measure. MacSoft has previously
scored success with the Macintosh
conversion of Civilization II,
released in 1996.
A rival successor to Civilization II
was released by Activision last year.
Civilization: Call to Power (reviewed,
Macworld, March 2000) was not
developed by Sid Meier’s Firaxis
company, and was generally received
with indifferent reviews. Civ III, on the
other hand, is reported to stick a lot
closer to Civ II’s gameplay, while
expanding its reach and enhancing
the arena of combat.
New Wonders of the world
include: The Great Canal, which
links oceans; and The Internet,
which promises to boost national
science output.

D

C’mon, feel
the GeForce3
Nvidia’s GeForce3 graphics
chip is now available
through the online Apple
Store for £359 (ex. VAT). The
GeForce3 graphics processor
(see Macworld, March 2001)
holds over 57 million
transistors, and can perform
more than 800 billion
operations per second.
Apple notes that the
card “is designed only for
Power Mac G4 systems with
the new 4X AGP card slot
(introduced in January
2001).”
The card will render 3D
scenes in real time, carries
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64MB of dedicated graphics
processing RAM and has a
230MHz 128-bit memory
controller. In tests, GeForce3
shows its prowess – Quake
III runs at 71fps on it,
against 35fps on the
GeForce2 MX. When he
announced the card at
Macworld Expo Tokyo,
Apple CEO Steve Jobs called
GeForce3 “the most exciting
thing in years”.
MW

A new Culture rating (alongside
military strength and technological
discoveries) helps players get positive
outcomes in diplomatic negotiations,
expands borders, and faster
assimilates conquered cities.
Also in Civ III, barbarians have
their own cities, which “respawn”
in an uncharted area of the map
when you destroy them.
Civilization III is an empirebuilding strategy game. Players get
the opportunity to take on some
of history’s greatest leaders as they
try to build a civilization themselves.
Some elements from previous
Civilization games have remained the
same, but the new title sports a new
graphics engine that will provide

City at bottom of table
The City screen is now on the map. Firaxis’s
Jeff Briggs says that Civ III keeps more
info on the map, and so reduces pop-ups:
“We’re working to make it a seamless,
continuous experience”.

better looking maps, animation
and graphics. An improved interface
and new reporting screens will help
acclimatize novice players, and
provide useful info for experienced
Civilization fans.
The title sports customization
tools and enhanced combat, trade
and diplomacy features, as well.
MacSoft hasn’t yet offered a firm
release date for the game.
MW

Apple pits
Mac OS X
against
Microsoft’s
Xbox at E3
Despite Microsoft’s determination to steal the show to
promote its X-box games console, Apple took a booth
at the Electronic Entertainment Expo (E3) last month
to showcase games running on Mac OS X (v10.0.3).
Apple set up a dozen Power Mac G4s equipped
with dual-533 MHz processors. The Macs had 512MB
of RAM and a fresh batch of Apple-made GeForce3
cards driving 15-inch Studio Displays. In an interesting

Go to

concession to gamers, each Mac was equipped with
multi-button USB mice manufactured by Logitech,
rather than the Apple Pro Mouse.
Running at 1,024-x-768 resolution and 32-bit
colour depth, the Macs returned stable frame rates
of 60 fps or above in enclosed areas of a never-seenMW
before beta build of Quake 3 Team Arena.
Peter Cohen
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Business news for the Macintosh world

Slump dampens stores launch
month of notable announcements for Apple received
a mixed reaction – with consumers and analysts
welcoming the company’s new products and
strategies, but the financial community reserving
judgement. Despite the successful launch of its retail
stores (see pages 18-19) and continued enthusiasm for its
titanium PowerBook G4 and revised iBook range, Apple’s
share value fell by $4.80 during May. However, Apple
remained a favourite with institutional investors, with
69 per cent of trades in May coming from that group.
Initial market optimism for the iBook saw Apple
stock climb 50 cents per share, but this was tempered by
continued uncertainty over the short-term future of the
PC industry. As Macworld went to press, IT giant Sun
Microsystems had issued its own warning, which had
impact across the industry. The company warned of sales
of $3.8 billion in its first quarter. Analysts had expected
$4.42 billion in sales.
The market message boards are praising Apple for
accelerating its product release schedule – with its
hardware announcements staggered throughout the year,
rather than being concentrated at the US Macworld Expo
events. Others cite the increasing strength of Linux in the
corporate markets, the perceived weakness of Windows,
and the underlying Unix-based networking strengths of
Mac OS X. These factors could offer significant opportunity
for Apple in the future, they claim.
Analysts AG Edwards upgraded Apple stock to a “Buy”,
following news that the company was opening a chain of
retail outlets on May 7. A spokesman for the brokerage
said: “The stores will be about brand equity. If you’re going
to go after consumers, you need to raise awareness and
generate excitement.”
Lehman Brothers analyst Dan Niles agreed, saying the
company will attract new customers with the move. Niles
is positive in his outlook for the company, predicting a

A

Business
briefs
■ Ricoh UK increased its UK
market share by 7.6 per cent
during 1999-2000. Xerox climbed
3.1 per cent, while Canon fell by
11.1 per cent. Figures come from
market analysts, Inforsource.
■ Former CEO of Belgian
software vendor Lernout &
Hauspie, Gaston Bastiaens, has
been arrested in the US and is
awaiting extradition to Belgium
on charges of stock-price
manipulation and false
accounting.
■ Palm’s market capitalization
fell last month, following a profit
warning announcement. Palm
has cancelled its merger with
Extended Systems, and is
expecting fourth-quarter
operating losses between
$170-190 million.
■ HP posted revenues of $11.6
billion for the quarter ended April
30. This total compares to $12
billion in revenue for the same
period last year. HP saw its
revenue slide 7 per cent yearover-year in the US markets. Its
marketshare in Europe dropped
5 per cent.
■ Roxio has completed its
separation from parent company
Adaptec, to focus on software
development. Its shares stood
at $11 as press time.
■ Tomb Raider creator Eidos
is to offer existing shareholders
new shares at below present
market value in a bid to raise
$70 million.
■ Adobe Systems will shut
down operations in the US and
Canada for the week of July 4
to help control expenses.
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Viao SuperDrive
ioneer is shipping its DVR-103 to Sony for use in its
Vaio notebook, sources claim. Sony is the fourth
manufacturer to take the product, after Apple, Compaq and
NEC/Packard Bell. Apple calls the DVR-103 the SuperDrive.
It offers both DVD-R and CD-RW capabilities and is
bundled with the 733MHz Power Macs.
The device is also available as the DVR-A03 for use
by third-party systems integrators and peripheral makers
such as LaCie. This external unit retails for $995.
To meet rising demand, Pioneer is expanding
significantly its production capacity in China, opening
two new plants there this autumn. The company plans
to produce over one million DVD-R/CD-RW drives there
before the end of the fiscal year.
For the fiscal year ending March 2002, Pioneer expects
its group net-profit to climb 15 per cent to 21 billion yen,
and group revenues to rise 11 per cent to 720 billion yen.
The company expects sales of core electronics products,
such as DVD players and recorders, plasma-display panels
and car electronics, to continue growing steadily.
MW

P

near-term dollar-value target of $29 – well in excess of
consensus near-term estimates of $23. Apple stock
climbed almost a dollar in response to these predictions.
However, Salomon Smith Barney analyst Richard
Gardner warned that Apple may face inventory problems,
as new users try to purchase OS X-installed Macs in
preference to OS 9.1 machines. Apple has moved to
head-off such as situation, with its OS X on-demand
strategy (see page 3). Gardner rates Apple stock as
“Neutral”. “We would not be aggressive buyers of Apple
shares in the mid-$20 range, due to the company’s channel
inventory-management challenges and continued
consumer demand weakness worldwide,” said Gardner.
Good news for Apple came from Merril Lynch’s midMay report. The analysts predicted a significant cut in the
rate of growth for the industry, but forecast a strong 2002.
Research firm IDC predicts a 4.1 per cent year-on-year rise
in unit sales of PCs in the current quarter. Analyst Steve
Fortuna said: “We feel next year could be surprisingly
strong.”
Wall Street remains as pragmatic as ever. “I’d love to
have a recovery in hand, but I don’t think it is yet,” said
Tom Sparico, managing director of equities at broker
Bengal Partners. “It’s just too soon. We have to digest
this slowdown process first. Ultimately, it will lay
the groundwork for a very robust recovery.”
MW

Jonny Evans
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Product News
Controlled explosion
Cinema 4D XL version 7’s
ExplosionFX tool can explode
objects into 3D elements, rather
than flat polygons – both blast
direction and blast strength are
controllable. Material settings of
the application have also been
improved to support blurry
reflections and transparencies.
Artists can adjust parameters,
including lighting effects, within
an image-processing application
without needing to re-render.

3D authoring
ready for OS X
axon Computer is shipping
Cinema 4D XL version 7 and
BodyPaint 3D for Mac OS X.
The company has made upgrades for
both apps available from www.maxon.net.
Features of version 7 include new
rendering effects – such as radiosity and
caustics – which calculate light reflections
of reflective or transparent surfaces.
Multipass rendering support has also
been enhanced. Information calculated
by the application will be written into
the image layers. Cinema 4D XL 7 also
features improved Polygon Reduction tools
– built to help create games and scenery.
100 pre set Shaders called Smells
Like Almonds 2.5 are also built in, and
can create special effects, such as X-Rays.
Maxon’s Cinema 4D Net, the networkrendering application, comes as standard.
A three-client licence of this is bundled
with each version of 4D XL 7, so that
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animations can be rendered over networks
using PCs or Macs, and the rendering can
be administrated within a Web browser.
BodyPaint 3D is an image-creation
and -manipulation tool built to integrate
with Cinema 4D. Maxon calls it “the
ultimate texturing tool for every 3D
artist, no matter what modeller is used”.
Maxon has no plans to surcharge
customers migrating to Apple’s next
generation OS. Owners of a Mac OS 9
version of either application will be
entitled to a free upgrade to the Mac OS Xnative versions. Maxon Cinema 4D XL 7
costs £1,188. BodyPaint 3D costs £408.
Demos of both products will be available
from Maxon. Anyone who purchased
Cinema 4D XL version 6 between
March 22 and June 2001 should
automatically receive a free upgrade
to version 7.
HiSoft, 01825 718 181

Crystal clear projection
Canon has introduced the LV-7105
LCD multimedia projector.
It weighs 2.8kg, and has a
resolution of 1,024-x-768 pixels.
It features digital keystonecorrection and will
accept S-Video signals,
as well as those from
DVD players and games
consoles. The £2,999 projector will
work only with Macs that have a
VGA or video-mirroring port – such
as PowerBooks, iBooks, iMacs and
G4s. It needs a £35 Mac adaptor.
Canon, 01737 220 406

Absent downloads

Visor’s price cut
Handspring has reduced the price of
its Visor Deluxe handheld computer
from £179 to £199. The Visor Deluxe
comes with 8MB of RAM, allowing
you to store up to 12,000 addresses.
It comes in five colours: ice, graphite,
blue, orange, and green. Every Visor
Deluxe also comes with a blackleather case.
Handspring, 020 7309 0134

JVC’s mini DVP cam
JVC has announced the Miniature GR-DVP3/DVP1, which it claims is the world’s
smallest digital-video camcorder. The pocket-sized camera uses MiniDV-standard
tape and an SD Multimedia card to capture still-images and MP3s.
It integrates a digital still-camera function, the ability to email video clips in
MPEG4 format, and has MP3 sound effects built-in. It also offers 10x optical and
100x digital zoom, as well as playback controls. The camera powers up and down
when the viewfinder or the two-inch high-resolution LCD monitor are opened or
closed.
The colour bandwidth is almost three times that of analogue video, according
to JVC, and the video camera boasts a CD-quality sound-recording system in either
two-channel, 16-bit sound at 48KHz; or four-channel, 12-bit sound at 32KHz. The
camera is equipped with both USB and DV (FireWire) terminals.
Bundled Mac software includes Presto! Mr Photo and Presto! Photo Album.
The camera is available in dark grey and silver, or silver finished models. The DV-out
model costs £1,100, while DV-in and -out version is £1,300. The product should ship
by early August.
JVC, 020 8208 7654

Ilesa’s Download Deputy version
4.5.3 allows downloads to be
queued and scheduled to
occur during
downtime, by dragging
the link from a
browser to the utility. If
the site is busy, the utility
tries again later. It can
automatically expand downloads,
disconnect the PPP connection, or
shut the Mac down. Version 4.5.3
features Proxy/Firewall support, an
improved scheduler and is more
stable than before. It costs $30.
Ilesa, www.ilesa.com

Seiko pads out Palms
Seiko has launched its Smartpad
2e. This £169 A4-sized portfolio
case opens up to reveal a
Palm on the left side
and an A5 pad of
paper on the right.
The device includes a
Smartpad pen, which
communicates with the Palm via
infrared using a tablet under the
notepad. Under the pad is a virtual
keypad for inputting data direct to
a Palm.
Seiko UK, 01628 770 001

Medicines sans Frontiers
UltraLingua has released a pair of
language dictionaries – FrenchEnglish medical terms
and French-Spanish.
The $29 FrenchSpanish translating
dictionary includes over
250,000 indexed terms
and a reverse translation system.
The $49 French-English Medical
Dictionary includes over 60,000
indexed medical and life-science
entries.
UltraLingua, www.ultralingua.com
continues page 40
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Husky voiced

Apple updates
Apple has released a number of
International-English updates in
recent weeks. These include
the AppleWorks 6.1.2
update for customers
with AppleWorks
6.1. Apple has also
released the iTunes
Visual Plug-ins
Software Development
Kit (SDK), which contains
documentation and sample coding
files that will enable developers
to create visuals for iTunes 1.1
or later. iMovie 2.0.3 has also
been posted. The company has
also released Multiple Users 1.4
for OS 9. This fixes some bugs
and offers enhanced security
and file handling. Apple does
not permit third parties, such
as Macworld, to carry System
updates. All the above updates
can be found at
www.macworld..co.uk/updates.

Momentum is a new collection
from PhotoDisc, part of Getty
Images. This collection has been
assembled to reflect the energy
and movement involved in four
areas of life: expressing, working,
designing and playing. It consists
of 500 images, which can
be previewed online at
www.photodisc.com. A printed
book containing the images is
also available. Pricing depends
on use and print run.
Getty Images, 0845 302 1212

Inkjet roll-out
L

Third-party updates
UltraDev and Dreamweaver 4.01
These updates significantly speed
the performance of Macromedia’s
Web-authoring
applications.
DoubleTalk 1.0
This prevents out
of memory errors,
improves the
built-in Help and
International
language support and fixes
minor bugs in Connectix’s crossplatform communication
application.
Toast Titanium 5.0.1
This update adds compatibility
with iTunes and Disk Burner,
support for built-in CD-RWdrive copying, and fixes some
minor issues with the Apple
Super Drive for Roxio’s awardwinning CD-authoring application.
BBEdit 6.1.2 updater
BBEdit 6.1.2 improves
compatibility with a variety of FTP
servers, improves its performance
under Mac OS X, and adds
support for previewing HTML
documents in OmniWeb browsers.
Rebound! 2.0.3
This file contains an installer for
Rebound! version 2.0.3 software,
including the logging system,
online help, documentation
and optional utilities in PDF form.
Iomegaware 3.0
This offers the latest support for
Zip, Jaz, and PocketZip products.

exmark has released four inkjet printers – the Z13, Z33, Z43 and Z53 ColorJets.
All feature Lexmark’s colour printhead technology and have a resolution of up to
2,400-x-1,200dpi – except the Z13, which offers a resolution of 1,200-x-1,200dpi.
Printheads are integrated into the ink cartridge to keep print quality robust, according to
Lexmark. Each printhead has 192 nozzles, which produce 2.88 million ink drops per page.
All four printers feature a Lexmark-developed paper-feeding system called Accu-Feed.
This is a stripped down version of the system developed by the company for use in its
business-class printers, which virtually eliminates paper jams and misfeeds, claims
Lexmark. The system supports a range of print media, including envelopes,
transparencies, labels and iron-on transfers.
All the printers are covered by an on-site exchange warranty. They also offer
regionally defined colour tables, reflecting Lexmark’s own research that shows
colour preferences vary by geographical location. Peer-to-peer networking is
also supported in some models.
The Z43 offers USB connectivity at up to 12ppm in black, or 6ppm in
colour. It ships with Lexmark’s Print Gallery CD, which contains over 100
high-definition images from some of the most famous artists and museums
in the world. This printer costs £84.
The £67 Z33 reaches print speeds of 9ppm in black and 5ppm in colour and uses
exclusively licensed pigmented black ink to deliver laser-quality sharpness. The ink is also
waterproof and won’t smear.
Finally, Lexmark’s USB Z13 ColorJet printer is an entry-level printer with a resolution
of 1,200-x-1,200dpi at print speeds of 7ppm in black and 4ppm in colour. It costs £50.
Lexmark, 01628 481 500

Sweet 16
The £129 USB Z53 offers print
speeds of 16 pages per minute
(ppm) in black and 8ppm in
colour. It also offers doublesided and multi-page printing
(up to 16 reproductions
per A4 page).

NEC’s eco MTs
NEC has released its MT 850 and 1050 series projectors.The MT 850 has
an SVGA (super video graphics array) resolution of 800-x-600 pixels and a
brightness of 1,700 ANSI lumens, the MT 1050 offers a brightness of 2,100
ANSI lumens and an XGA (extended graphics array) resolution of 1,024-x-768
pixels.
The projectors will cast images from a CompactFlash card.
An energy-saving Eco-mode is built-in, as is the company’s proprietary
AccuBlend solution, developed to enhance image quality.
Tools include an integrated laser-pointer, an on-screen cursor, point-&-drag
electronic zooming, a USB-mouse controlled
chalk board, and full remote
controls. Keystone correction
is built-in.
Available now, the MT 850 costs
£3,050; the MT 1050, £4,650.
NEC, 0208 993 8111

C-1 transport
The C-1 supports USB
for transferring images
to the Mac, and ships
with Camedia Master
software.

C-1 mounts on Macs
Olympus is introducing the Camedia C-1, a 1.3-megapixel digital
camera. The £249 camera’s dimensions are 110-x-62-x-34cm. It
has a 35mm lens and through-the-lens autofocus, which ensures
sharp images, according to Olympus. An ESP-metering system
takes readings from various points, to determine optimum
exposure settings. It also has a 2x digital-zoom.
The digital camera – which can be used with Camedia
printers – stores pictures on a 64MB SmartMedia card.
Olympus, 0800 072 0070

continues page 43
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LCD price
war hots up
he long-expected LCD price war
has begun, with NEC-Mitsubishi
following Apple in announcing
a series of hefty price cuts across its
LCD range.
Tom Martin, director of IBM’s flat panel
monitor programme, predicted significant
price drops in the LCD-monitor market this
year, during the Stanford Resources Flat
Information Displays conference last year.
NEC-Mitsubishi has cut prices across
the range. Its 15-inch entry level LCD1530V
drops to £368 from £549. Its multimedia
15-inch – the 1525M – falls to £449 from
£589, while its 1525X drops by £120 to
£559.
NEC-Mitsubishi has also released its
LCD1700M+ 17-inch multimedia monitor.
This £799 compact monitor measures
422-x-451-x-208mm. The company
recommends the monitor runs at a
resolution of 1,280-x-1,024 pixels at a
frequency ratio of 60Hz.
Also new from the company comes
the LCD1850DX, which offers six-colour
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controls (red, green,
blue, yellow, magenta
and cyan). It’s an 18.1inch monitor with a
horizontal and vertical
viewing-angle of 17degrees. The monitor
can be rotated up to 90degrees to offer portrait
format viewing. It can
also be separated from
the stand for different
applications. The 1850DX
offers two DVI-I interfaces.
Maximum resolution is 1,280-x-1,024
pixels at a refresh rate of 60Hz. It ships
with a three-year warranty and, costs
£1,649.
NEC-Mitsubishi has sliced £400 from
the price of its sRGB-equipped 18-inch
monitor, the LCD1830. This now costs
£899. These monitors will require a
Macintosh adaptor for Macs with no
SVGA port.
NEC-Mitsubishi, 0870 1201 160

Extension tracker
Extension Overload version 5.8
is a 4,580-item database detailing
extensions, Control Panels, Control
Strip modules and Contextual
Menu items in Mac operating
systems 7 to 9.1. It will enable
and disable extensions.
The utility contains a
searchable database of
system-error codes,
and generates reports to
help users track extensions
and Control Panels. Registration
costs $20. The demo is free to use
for a two-week evaluation period.
Extension Overload,
www.ExtensionOverload.com

Belkin fires off hub

Multimedia mogul
The LCD1700M+ 17-inch
multimedia monitor (above) offers
a wide 160-degree viewing angle
with an active display of 33.8-x27.3cm. The monitor ships with
a three-year warranty.

See page 83 for
Macworld’s test results.

Natural colour
The LVP-X390U features
Mitsubishi’s Natural Colour Matrix,
which controls six colour-signals.

Video captured in QuickTime
yVideo is a USB-based video-capture and -output solution from Eskape Labs. It will
capture motion JPEG movies from any analogue-video source to digitally edit on a Mac,
and for later output to any analogue VCR or monitor. It will capture QuickTime movies from S-Video
or Composite video sources, and will capture and playback at full speed (PAL 25fps; NTSC 30fps).
MyVideo is compatible with iMac, iBook, PowerBook, blue-&-white G3 Power Macs and all G4
Power Macs. It handles audio too, and ships with a selection of desktop-video software and Eskape
TVs own video-capture software. It costs £170.
Hauppauge, 020 7378 1997
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Motion video
MyVideo captures and outputs
video to analogue monitors. It
comes with composite-video
audio cables.

Video-CD player updated
VCD Player version 1.4.8 plays
video-CDs on Macs with fullscreen MPEG playback. It
features configurable
options to control
sound and playback,
and tracks are
selectable, like a
conventional audio CD player.
It supports multiple monitors. The
unregistered version plays
for five minutes at a time.
Registration is $10.
Jonny Lee, www.jonnylee.com

Mobile projector ships
Mitsubishi Electric has released its £4,500 LVP-X390U portable display projector.
The projector weighs 6.7kg and measures 299-x-133-x-367mm. It hosts
a 2W stereo output, and supports up to 16 million colours at an XGA (Extended
Graphics Array) image resolution of 1,024-x-768 pixels. The LVP-X390U offers
a 400:1 contrast ratio, and has a brightness of 2,200 ANSI lumens.
It also includes digital keystone-correction of up to 15 degrees. The projector
offers a point-&-zoom function that magnifies any part of the picture for sharper
viewing. It also offers a picture-in-picture (PiP) feature, so two images from
different sources can be shown together on the same projection. The digital
zoom will expand any part of the image to fill the screen, retaining the original
image as a PiP.
The projector supports PAL, SECAM, NTSC, component DVD and HDTV.
Mitsubishi Electric, 01707 278 684

Belkin has launched the six-port
FireWire hub. The cross-platform
peripheral adds six
FireWire ports to any
FireWire-equipped
computer. It can be
used alone, or
docked with other
hubs and costs £68.
The hub is covered by a lifetime
warranty.
Belkin, 01604 678 300

DiskLock security fillip
DiskLock 4.6.5 supports Mac
operating systems up to and
including OS 9.1. It offers highlevel security for data on a Mac,
using encryption technology rather
than a password key. DiskLock can
instantly lock data to protect it
from prying eyes. It supports
multiple-user profiles, offering
different levels of access – an
administration package is also
available. Folders can be protected
with a single click by DiskLock,
which loads before the system
software. It costs £69.
Computers Unlimited, 020 8358 5858
continues page 44
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Epson printers
large it up

CDs & books
Illustrator book Wows
Peachpit Press has updated its
Illustrator 9 Wow! Book. It’s
designed to help beginners and
advanced users in
the use of Adobe’s
vector-design tool.
It includes step-bystep instructions,
examples of work,
and a CD-ROM
containing brushes,
demos and other Illustrator
add-ons. The book costs
£37.99.
Pearson Education, 020 7447 2000

Quick times
Epson’s 10000CF (right) uses a
Photo Accelerator module, which
the company claims will make
printing up to 2.5 times quicker.

Maths education boon
Sherston has released Display
It Yourself Numeracy and Hide
and Reveal Random numbers.
The educational CD-ROMs
explain mathematical concepts,
and develop logical thinking.
They cost £31 each, and have
a full screen mode.
Sherston Software, 01666 843 200

Biological imperative
Rickitt Educational Media has
introduced three interactivelearning titles for secondary
schools biology. The £49 titles
are: Biomes; Flowering Plants;
and Non-Flowering Plants. The
company has also released
nine new chemistry titles –
including Atomic Structure and
Properties of Acids, Bases and
Salts. The chemistry titles start
at £79. The tutorials are
designed to complement
commonly used science text
books.
REM, 01458 254 700
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Scanners aid Expression

Dummed-down video
IDG has released Digital Video
for Dummies, its guide for
novice filmmakers. It details
camcorder choice, software,
planning, shooting
and mixing. The
title ships with a
free CD-ROM, and
costs £19.99. IDG
titles are available
at up to 30 per cent
off direct from
Macworlds’ reader offers
department. www.macworld.co.uk/
readeroffers.
Macworld, 020 7831 9252

pson has launched its Stylus Pro 10000 and the
Stylus Pro 10000CF wide-format printers. Each
uses a different ink – QuickDry Dye-based ink,
which dries “in 10 milliseconds, and ColorFast Pigmentbased ink, which “last 100 years”, respectively. Both sixcolour printers support A3 to BO+ (40-x-94 inch) sized
media. They have a resolution of 1,440dpi, and a speed
of 20 square metres per hour.
A new Micro Piezo print head features 180 nozzles
for each colour, to improve print speed and control
over dot size, shape and placement. Data transmission has
also been speeded up. The Auto Print Head Optimization System will
identify blocked nozzles four seconds before a print instruction is executed.
The Stylus Pro 10000 hosts a number of enhancements for the computer assisted
design (CAD) markets. Additionally, an Epson Stylus RIP Designer XL is available to improve
images. The USB Stylus Pro 10000 costs £7,495, while the 10000CF costs £7,995.
Epson, 0800 220 546

Clearly read
The Expression 1680 Pro
ships with a transparency unit.

Epson’s new 48-bit Expression 1680 and
1680 Pro scanners both offer an output of
1,600-x-3,200dpi, and can recognize 280
trillion colours. The 1680 can scan an 8.5x-11-inch photo in less than 23 seconds at
300dpi, Epson claims. It will scan a 35mm
slide at 1,600dpi in “less than 65 seconds”.

The scanners offer USB, FireWire and SCSI
connectivity. The bundled software includes
Adobe Photoshop LE, Epson Twain Pro 2, Xerox
Textbridge Classic, Presto! and Scan Server
software. The 1680 costs £649 and the 1680
Pro is £859.
Epson, 0800 220 546

Grand Central Pro updated
Hermstedt will release Grand Central Pro 3.0 file-transfer
software in August. Version 3.0 will be Carbonized for
Mac OS X, and offer peer-to-peer data transfer using
Internet Protocol (IP) through a choice of analogue,
ISDN and xDSL line connections. Its Multi-Homing
function offers more security settings for IP and ISDN
file-transfer servers.
The Grand Central Pro file
server keeps the connection
for external file transfers
separate from the internal
ethernet. This minimizes the
risk of unauthorized external
access to the company’s
network.
Other features include
encrypted transfer for highdata security, a Suspend and
Resume function and group
sending. Grand Central Pro 3.0
will cost £399. An upgrade
from version 2.x to 3.0 will
cost £99.
Hermstedt, 020 7242 4060

CarryOne on case
enticular Products has released the
OneTouch and CarryOne CD storage devices.
Inspired by Apple’s range of colourful hardware,
such as the iMac, the OneTouch CD-storage
box is made of translucent plastic. It costs £22
(inc VAT) and will hold 60 CDs in three separate
sections. CarryOne is a zip around polypropylene
shell. Priced at £5, it stores either 24 CDs or
holds a CD player and a few CDs.
Both products are available in Graphite,
Tangerine, Lime, Grape, Pink and Blue. The CD
sleeves are made from breathable, non-scratch,
non-woven material.
Lenticular Products 01666 840 888
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David Fanning
If Apple is to sell more-powerful machines, it
needs more processor-intensive applications

Nutty processors
have said this before, but it looks like computers
are fast enough already – at least for the average
person doing word processing and maybe
some graphics. So what is next for Apple? Even
an iBook can edit DV movies without skipping a beat.
Well, Apple needs to find more processor-intensive
tasks for people to do. But if you can already do
digital video, what else is there? We need to look
to what people are doing at the high end to get
a clue.
Just about the most taxing thing you can ask
a computer to do is render 3D images, especially
when making animations. I’m not talking about
games rendering such as Quake or Tomb Raider.
That stuff is rendered on the fly by video cards,
which are getting faster and faster. I’m talking about
animations that take a while to render, such as Toy
Story or the new computer animated movie Final
Fantasy (out this summer). This stuff isn’t rendered
live. It takes render farms weeks to get the amazing
footage that makes a computer generated movie. So,
perhaps the next time you upgrade your Mac, it’ll be
so you can render 3D graphics on your PowerBook.
You may be thinking that this stuff is totally pie
in the sky, but a couple of things I’ve stumbled across
have convinced me otherwise.
A few weeks ago, I saw a demo of Maya – the
animation software from Alias|Wavefront that’s
coming to Mac OS X this summer. What I saw
took my breath away.
Part of the demo involved a blue rectangle that
could be viewed from any angle as the camera was
spun around. It got more interesting when an electric
fan was introduced to the scene. As the direction of
the fan changed, it started to blow on the blue square.
Rather than being inanimate, the rectangle
represented a hanging sheet of blue silk. As the fan
was pointed at the sheet, it billowed just like clothes
on a washing line. The camera spun around to capture
the movement from every angle. I had no idea such
incredible things were possible – especially as this
wasn’t a rendered scene, every aspect was being
calculated live. You could control the fan by moving
the mouse, and you could spin around the scene
while waving the fan around.
This is amazing, but it doesn’t stop there. Was I
watching the demo on a tricked-out SGI workstation
with a dozen liquid-cooled processors? No. So it must
have been a secret multiprocessor gigahertz Mac with
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a video card stolen from Area 51? Wrong again,
it was on a PowerBook G4 – other than a stack
of memory (I’m guessing), it was bog standard.
I saw similarly amazing stuff at a demo of
LightWave 6.5, where creating rushing-water
scenes or realistic smoke was just as amazing.
Before you all rush out and buy Maya or
LightWave, you need to know that this demo was
done by a professional. Mere mortals like us will
need to learn some pretty complex things before
we get to do that cool stuff. However, Maya is
getting easier and easier to use. It has gone from
an application that required some pretty hard-core
programming and modelling skills, to one where
sliders are now being introduced to save endless
co-ordinate typing.
The fact of the matter is that you still won’t learn
Maya or LightWave in an afternoon. In fact they are so
complex, it might take years. However, the technology
is there, and it’s getting easier to use. In five or ten
years your kids might be using a descendant of Maya
to make scenes for Barbie in their own soap opera, or
decapitating Jar-Jar Binks in their own remake of Star
Wars. The power is here already, so only the interface
needs simplifying.
Artificial intelligence (AI) is still creeping along, but
given ten years and practically unlimited computing
power, who knows what might be possible. Given
the ultra-realistic characters of the forthcoming
Final Fantasy movie, you may not need to re-write
Star Wars. Simply combine the realistic characters
with convincing AI, and they will make their own
movie. That should keep your iBook G6 warm.
This is one possible scenario for what might
lurk on a future iBook. It might seem fantastic,
but it really isn’t far beyond our reach – we’ll
have problems distinguishing real and animated
characters quite soon.
Of course, the driving force will be whatever
people want to do with the new-found power
of computers. If the past is anything to go by,
the porn industry is likely to come up with the
next killer application. But, it isn’t impossible for
the games industry to come up with something
cool. I’m sure they can do better than Furbies.
I’d be interested to know what other applications
you think might be used to soak up the glut
of processing power. If you have any good ideas,
MW
let me know at davidf@macworld.co.uk.

Read more Macworld opinions online (www.macworld.co.uk), and join in the debate.

“Simply
combine
realistic
characters with
convincing AI,
and they’ll
make their
own movie.
That should
keep your
iBook G6
warm.”
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Michael Prochak
Spending money on vague adverts
when money is tight is stupid

I don’t understand
s the Counting Crows song says, we all
want to be big, big stars, yeah... but we
got different reasons for that. Out in our
“everybody I know who is right always agrees
with me” world, it’s comforting to know that for the
most part, no one bothers to question just what those
reasons are. Well, at least not in public. And now that
the media-fuelled angst and urgency of the election
circus has reverted to more mundane and traditional
grounds – such as fear, greed and vengeance – the
blizzard of news, lies and thick advertising are
gradually receding to their normal subliminal level of
incomprehensible soporific background noise. But it’s
OK... bullshit makes the flowers grow, so it must be
beautiful.
Speaking of advertising, somebody once said
that they knew that half their advertising budget
was wasted... the problem was, they didn’t know
which half. When it comes to advertising, or real life
for that matter, essentially all statements are true in
some sense. However, they’re also false in some sense,
meaningless in some sense, true and false in some
sense, true and meaningless in some sense, false
and meaningless in some sense, and true and false
and meaningless in some sense. In the world of
advertising, common sense is what tells you that
the world is flat.
As you’ve probably noticed, Apple has just
launched two new iBook TV commercials to
accompany their existing back catalogue of iMac
and titanium PowerBook adverts. As usual, Apple
is sharply targeting the consumer/business/
‘is there anyone out there’ market, and probably
doing a splendid job of wasting both halves of its
advertising budget. But strangely enough, on UK
terrestrial television, there’s been a rash of similarly
vague advertisements for highly unlikely companies
like EMC, Hewlett-Packard, Computer Associates
(CA), and IBM. And apart from speculating which
half of the advertising budget they’re wasting, one
does wonder why these companies – usually targeted
fairly and squarely at the upper echelons of the IT
industry, and specifically at the decision-makers – are
advertising to the great unwashed public in general?
Traditionally, advertising on television involves
specific consumer products. So, to the unilluminated,
the move of the aforementioned companies into this
mucky medium is breaking relatively new ground –
particularly in the UK. So why, you may ask, are they
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doing it? Well, HP, rather like Apple, considers
it has a very strong consumer channel – and is
reportedly using this as the reason behind its current
advertising. However, CA and EMC in particular don’t
really focus on the consumer market, and IBM’s
e-business advertisements are clearly aimed at large
companies. So, the same reasoning can’t possibly
apply. What appears to be happening in all of these
scenarios is that these huge corporations are trying
to build their own Coca-Cola-style brand recognition
in the market-place. All of these organizations have
extensive marketing budgets, and it’s often the case
that in an economic downturn – which we’re in, in
case you haven’t noticed – many big companies get
desperate and spend even more. Although it’s
probably not a realistic expectation of any of the
current crop of advertisers – CA, EMC, HP, or IBM
– that this television marketing will result in a
telephone call the following morning from the CEO
or CTO of a large company requesting a visit from a
salesperson or account manager, there is some vague
hope that these messages – plus the perception that
IT is a major contributing factor to profitability – will
eventually up their turnover.
Unfortunately, according to a recent Butler Group
survey, there is absolutely no correlation between IT
spending and profits. And, despite the media-driven
hype, technology has been hideously over-valued by
companies involved in an IT “arms race” that has no
direct relation to company profits.
According to the report, spending money on IT
guarantees absolutely nothing, and the absence of
a demonstrable relationship between profitability
and IT spending should be seen as evidence that
other influences – such as strategic advantages,
competitive positioning and leadership’s effects
– are likely to be more decisive than information
technologies.
One might construe from this information that
if spending money on IT guarantees nothing, vague,
undifferentiated advertising of IT companies on
TV probably guarantees even less.
Like politicians, celebrities or pig farmers, even
computer companies want to be big stars, and
adverts do give them some semblance of an onscreen persona. Personally, I think some of these,
particularly the IBM and Apple adverts, are quite
clever and entertaining. But, they’re still not getting
MW
the products noticed.

Read more Macworld opinions online (www.macworld.co.uk), and join in the debate.

“Like
politicians or
celebrities,
computer
companies
want to be big
stars, and
adverts give
them some
semblance of
an on-screen
persona”
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Macworld Rating
★★★★★/9.0-10.0 = OUTSTANDING

OS X-ready Illustration and layout application

FreeHand 10
Publisher: Macromedia www.macromedia.com/uk
Distributor: Computers Unlimited (020 8358 5857)
Pros: Stable Mac OS X performance; master pages; live previewing of basic Flash
triggers.
Cons: Brush Strokes no match for Adobe Illustrator; not a feature-packed upgrade.
Minimum specs: Mac OS 8.6 or Mac OS X; 32MB available RAM; 70MB harddisk space; Web browser (Netscape Navigator or Internet Explorer 4.0); 800-x-600
colour display; CD-ROM drive.
Price: £279; upgrade from previous versions, £99 (both prices exclude VAT).
Star Rating: ★★★★/8.7

his time last year, Macromedia
wanted you to forget its printdesign past, and instead think of it
as wholly Web-focused. Today, a similar
claim would be commercial suicide.
Shrewdly, however, Macromedia never
burnt its bridges and continues to publish
an annual upgrade to its FreeHand
vector-illustration package. The latest
release improves on Web-export features,
but also targets the jobbing designer in
print and multimedia. Crucially, it’s the
first big-name application to be released
commercially for Mac OS X.
FreeHand is intended for professional
designers, or anyone who wants to
produce high-quality, resizable vector
art for print and online presentation. It’s
not an all-round drawing package for the
home or office – there are no flowchart
or calendar functions, for example – nor
is it priced as such. FreeHand lets you
draw by hand, build shapes from other
shapes, apply strokes (outlines) and
fills (inside areas) to objects, work
with textures and gradient colours, and a
good deal more. You can print the results
to colour separations, render them to
bitmaps at any size, or use them as
Web graphics. You can export the
graphics for use on desktop-publishing
pages, or combine photo images within
your FreeHand designs themselves,

T

Selective prints
FreeHand 10 now includes a Print
Area mode, which allows you to
click-&-drag out an area on your
canvas that you want to print –
without having to print the entire
document.
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Master time
Make the most of multipage designs, for Web and multimedia, by setting up Master Pages, saving
you considerable time on repeated elements.

making FreeHand a popular alternative
to desktop-publishing (DTP) software in
the multipage or poster-advertising field.
As such, FreeHand’s closest
competitor is Adobe’s Illustrator, but
it also shares many of its vector-design
features with those in CorelDraw and
Deneba Canvas. Macromedia says that
this latest upgrade is the fruit of user
wishlists, so current FreeHand users
should be smacking their lips already.

Interface-lift
The most noticeable improvement
is the interface. The ever-expanding
main Tools panel has been re-arranged
helpfully. Items, such as the Pen tool
and new Color Selection swatches at
the bottom of the Tools panel, work in
exactly the same way as their equivalents
in Macromedia Flash, Dreamweaver and
Fireworks. Despite legal quibbles with
Adobe, you can continue to drag floating
panel tabs apart and snap them back
together, but now also save your
preferred panel layouts, and even
share them with other users.
Generally, under Mac OS 8 or 9,
you should find the palettes and toolbars
neater and clearer. Under Mac OS X, they
are just gorgeous, having finally broken
away from the trademark dingy grey of
Macromedia interfaces to date. If you
tried FreeHand once and didn’t like it,
I urge you to try again under Mac OS X
– I think you’ll find it a very different
experience. Sure, there are a number
of cock-ups that affect the interface
appearance, such as the way the colour
square in a gradient bar within the Fill
panel jumps to the left of your mouse

pointer as you drag it, but I didn’t
discover any functional problems to
stop me working. If you’re looking for
an excuse to move to Mac OS X,
FreeHand 10 could well be it.
Otherwise, as with FreeHand 9 before
it, FreeHand 10 is an upgrade that brings
a mere handful of big feature additions,
but countless tiny enhancements. One
of the major items is the Master Pages
feature in the Document panel. FreeHand
has been a multipage-design package
for years – a function that Adobe has
inexplicably resisted to this very day in
Illustrator – and now the ability to set
repeating Master objects across pages
DTP-style is a significant finishing touch.
You can create up to an unfeasible
32,000 different Master Pages in a
single document, and apply updated
edits across “child” pages instantly.
Turning a layout into a Master Page,
– effectively working backwards –
is a snap too.
The process is a little confusing
at first, but once you understand when
you’re in Master Page edit mode and
when you’re in plain page edit mode,
it can be an excellent time-saver. It also
means you can use FreeHand directly for
simple multipage jobs, such as brochures,
menus and other design-led booklets.
One of FreeHand’s best features in
recent versions has been the way it can
deal with your designs as identifiable
objects and styles. You can, for example,
search and replace graphics in FreeHand
as you would with text in a word
processor. The last upgrade to the
program added a Symbols panel, which
let you store, re-use and globally update
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multiple copies of a graphic. In FreeHand
10, this has been renamed the Library
panel to reflect its wider use beyond just
graphic objects. The Library is now the
place where you manage symbols, styles,
brushes, Master Pages and so on. It’s
especially handy since it retains the
thumbnail preview pane above the list
of names, so you can always pick out
the right Master Page by sight, even
if you forget which name you gave it.
For graphics use alone, the Library
panel is still a great time-saver. If a
particular graphic is supposed to appear
several times throughout a multipage
layout, you can simply drag-&-drop it
from the Library panel onto your pages.
They all maintain a link back to the
original stored symbol, even after
moderate editing – so if you subsequently
change the symbol, all linked instances
are automatically updated to suit. In this
sense, it’s like Find & Replace without
the need for any searching.
Another important upgrade feature
is the enhanced support for Flash actions
within a FreeHand document. Don’t get
over-excited, though: it doesn’t mean
you can create self-contained movies
in new ways other than the page/frame
animations already introduced with
FreeHand 9. Rather, the program now lets
you apply a wider variety of basic Flash
triggers (Go To, Play, Stop, Print, and so
on) in addition to standard hyperlinks
from within a new Navigation panel.
Having associated some of these
triggers with graphic objects, you
can now preview their effect without
exporting everything to Flash and
HTML. Instead, you just select Test Movie
from the Control menu and preview it in
FreeHand 10’s integrated Flash Player.
This way you can fine-tune your
animated and interactive processes first,
and then export to Flash format at the
end when you’re happy. Now there’s
no excuse for not producing your next
electronic portfolio or presentation in
Flash format, and without having to learn
any Flash technique at all; you don’t even
have to own a copy of Flash itself.
One area in which FreeHand has
always been forced to play catch-up
with Adobe Illustrator is in custom
gradient fills. To fight back a little,
FreeHand 10 introduces a new type of
gradient it calls Contour. This is prepared
on a slider in standard gradient fashion,
but the shape of the gradient is
determined by the outer shape of the
object you apply it to. It’s a bit like
Ordnance Survey maps of hilly regions,
where the coloured bands follow the
shape of the mountain, changing from
the edge to the centre point.

★★★★/7.0-8.9 = VERY GOOD

★★★/5.0-6.9 = GOOD

★★/3.0-4.9 = FLAWED

★/0-2.9 = UNACCEPTABLE

Limited use
Contour gradients aren’t always
successful. In practice, they are
easy to create, but very difficult to
make useful. They can produce
some interesting neon effects,
gradient drop shadows and the
like, and also do some nice things
with text once you’ve converted it
to outlines. However, it can make
your artwork look rubbish, so use
it with care. It’s still a long way
behind Illustrator’s freeform
Gradient Mesh.

FreeHand 10’s final big new feature
is known as Brush Strokes. These let
you extend a graphic along a drawn path,
such as a railway track, a picket fence or
a neon tube. Using a graphic that looks a
bit like a splodge of oil paint, you can use
Brush Strokes to create almost (but not
quite) real-media effects. Because the
stroke is edited as a single path rather
than as the graphic that has been loaded
on it as “paint”, you can move, reshape
and otherwise adjust the results simply.
This feature can be extremely handy
for filling a busy canvas with multiple
objects that need to appear similar, but
not identical. For example, you could
draw an entire shoal of non-identical
goldfish in under a minute by dashing
away with a Brush Stroke containing
just the one original fish.
It’s even quite easy to copy
an existing graphic or symbol to a
Brush Stroke via the Library panel.
But unfortunately, applying it can be
a confusing affair. You’d expect to load
the Brush Stroke from the Library panel
to the Stroke panel and get going, but
every time you draw a path, the stroke
switches back to its default. This is
absolutely infuriating until you get the
hang of the system; the sequence of
selecting, loading and fixing each brush
really ought to be simpler.
FreeHand 10’s Brush and Spray
Strokes are not as slick or powerful as
the equivalent feature in Adobe
Illustrator. Nor does Macromedia offer
as many preset brushes; nor are they
as interesting and diverse as Adobe’s.
Perhaps the feature deserved a decent
paintbrush tool as found in Illustrator,
rather than relying upon FreeHand’s
more limited range of pens. Overall, it’s
a welcome and attractive new feature,
but not a compelling one.
Beyond these big items, FreeHand 10
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offers mostly a bunch of tweaks and
shortcuts – albeit quite a lot of them.
A few will certainly be useful to
everyone. Some enhancements will be
useful to people who use those particular
features a lot, but may not even be
noticed by anyone else. For example,
clicking with the Pen tool on a path
you’ve already drawn will add additional
nodes to it, and you can click the Pen on
the end of a deselected path to continue
it without having to select it first.

Macworld’s buying advice
Despite all this, FreeHand 10 might not
seem such a great leap forward for some
potential buyers. In that sense, it’s a bit
like FreeHand 9, which introduced frameanimation Flash export and a real-time
perspective grid, but nothing else terribly
important. Unless you’re having specific
problems with your current version, or
perhaps if your business is on the Web,
you may still be perfectly happy with
FreeHand 7 or 8. There’s not much
here to win over Illustrator, CorelDraw
or Canvas users either. But committed
FreeHand-professionals, especially those
upgrading to Mac OS X, will love it.
Richard Boardman

Graphic converter
Don’t forget, FreeHand inherits
all the powerful features from
previous releases, including the
unparalleled Find & Replace
Graphics dialog box.
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3D multimedia application

Director 8.5
Shockwave Studio
Publisher: Macromedia www.macromedia.com
Distributor: Computers Unlimited
(020 8358 585)
Pros: Brings interactive 3D to the Web;
Flash 5 integration.
Cons: Upgrade of limited value unless
you need 3D content; not Carbonized.
Min specs: Mac OS 8.1; 64MB of RAM;
100MB of hard-disk space.
Price: £949; upgrade from 8.0, £149;
upgrade from 5-7, £299 (all prices
exclude VAT).
Star Rating: ★★★★/8.5

irector rolls on. While Flash has
eclipsed Director as the most
versatile and ubiquitous tool for
creating interactive Web-content, this
release (version 8.5) shows there’s still
life left in the old dog. This latest version
adds one major new feature, as well as a
number of enhancements that will bring
Shockwave to a whole new audience.
Director is now seen primarily as
a Web-development tool, for creating
content that will be exported as
Shockwave and delivered online.
Sure, it can still be used for multimedia
presentations, CD-ROM development,
DVDs, interactive TV and the rest, but it’s
the Shockwave side of things that’s really
pushing it on. Not for nothing do they call
this Shockwave Studio.

D

Shockwave boon
Let’s start with the big addition to
Director – Shockwave 3D. This is the
biggest thing to happen to Director since
the Flash Asset Xtra back in version 6.5.
The new 3D features in Director 8.5 allow
you to import 3D objects, animate them,
make them interactive, and then export
them as part of a Shockwave movie.
Director is able to bring 3D to the
Web by incorporating Intel’s Internet 3D
Graphics software, an adaptive geometryand rendering-engine developed by Intel
for the deployment of 3D graphics at low
file-size.
The architecture developed by Intel
features a multi-resolution mesh. This
allows it to scale to the performance
and bandwidth of the user’s machine, by
scaling the number of polygons that are
rendered – as well as surface subdivision
– to keep file sizes low, but add detail
at the rendering stage. The architecture
also incorporates systems such as particle
effects – used in most high-end modelling
tools, allowing the simulation of complex
natural phenomena, such as smoke or
explosions.

All this is delivered online through
the latest version of the Shockwave
Player, which includes the 3D engine
needed to render and display the 3D
objects embedded into the Director
movie. An object’s geometry, textures
and environments can all be streamed,
keeping download times to a minimum.
While other Web3D plug-in technologies
– such as Cycore’s Cult3D and
Viewpoint’s 3D technology – have gained
only small numbers of users, Macromedia
can leverage the huge installed base of
Shockwave users.
While Director might now sound
like a 3D tool, it’s not. Just as there are
no video-editing tools in Director, even
though Director supports digital video,
there are no 3D modelling tools in the
Director itself – other than a simple text
extrusion capability. Director 8.5 simply
supports a special new type of 3D file
format, called Shockwave 3D, with the
W3D file extension. You will still need to
use an existing 3D-modelling application
to create your 3D models in the first place
– or license them from a third party.
Currently, the only application that
has an export option for Shockwave 3D
is Discreet’s 3D Studio Max, which will
be a disappointment for Mac users.
However, the situation is rapidly
changing, as exporters are released
for more 3D applications, including
Mac-friendly ones such as Cinema 4D,
Amapi, Maya, Lightwave and others.
The text extrusion capability is very
easy to apply to any existing text cast
member, which instantly turns it into
a 3D object. You can then define the
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parameters of the 3D object using the
extrusion tab of the Property Inspector.
There are few things I hate more than
animated spinning 3D text, but this
program seems set to give us them in
spades.

Familiar face
The user interface of Director 8.5
remains essentially unchanged.

3D interactive
Applying interactivity to 3D objects within
Director can be done either using Lingo,
or by using the number of 3D behaviours
that come with 8.5. Firstly, you apply 3D
actions to your 3D sprite, for instance to
zoom the camera in an out, and then a
trigger that will instigate that action, such
as a key press or mouse movement. You
can apply a number of actions to an
object, and then set up a number of
corresponding triggers, so that you
could make your 3D scene completely
zoomable, pannable or rotatable – all
through different key and mouse
combinations.
A Shockwave 3D model within
Director may consist of a number of
objects or groups of objects, and these
can also be manipulated individually by
Director. It gives you the ability to set
certain objects as clickable – for instance
in a 3D model of a group of buildings, you
may want each building to be a clickable
link to information about that building.
The supplied Behaviors are fine for
simple interactivity, but more advanced
control than this – for instance, to create
a button onscreen to rotate your object
360 degrees – will require some
knowledge of the new Lingo commands
in Director 8.5. The learning curve for this
continues page 55

Real compatible
Director 8.5 supports a number
of new file types, including
Shockwave 3D, RealMedia,
Flash 5, and Havok Physics
scenes.
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is steep. I counted over 320 new Lingo
commands – or existing commands that
had additional function when applied
to 3D sprites – which is why the
8.5 manual of new Lingo commands is
over 500 pages thick. Thus, it’s not for the
fainthearted, but it does give you a much
greater degree of control, whether it’s to
build interfaces to control the interaction
with your 3D scenes, or for more complex
actions such as detecting collisions
between objects. You can even use
XML to use dynamic data to send to your
3D objects – for instance, 3D bar-charts.
If you want your 3D objects to obey
the real laws of physics – such as friction,
collisions, gravity and elasticity – then
your mechanics knowledge from A-level
maths is really going to come in handy.
Fortunately, there’s also an Xtra (Havok
Physics Engine) available, which provides
a real-time interactive physics-engine for
realistic motion and interactions without
all the pencil chewing.

Gaming action
With Director 8.5 new to the market, it’s
too early to predict in what ways its 3D
capabilities will be used. One thing that
is certain, is that games designers will
be able to utilize the 3D engine in
Director to create fast and furious
Web-enabled games.
There’s already a playable Quake
level that’s been coded in Shockwave 3D,
so things like Virtual Pool or Tomb Raider
clones can’t be far away. And all can
be delivered over the Web in a browser.
Published Shockwave files that

contain 3D objects are viewable only with
the new Shockwave 8.5 player. The file
size is very compact, and the 3D objects
stream as well. This is a remarkable
achievement.
While the 3D features make up the
bulk of the new features in Director 8.5,
they are not the only ones. Perhaps the
most significant of these is the support
for Flash 5 files. Director 8 supports
Flash 4 import only via it’s Flash Asset
Xtra, which means that you have to
ensure your Flash movie is written using
only Flash 4-compatible code. With Flash
5 support, all the ActionScript commands
and dot syntax from Flash are now
recognized within Director.
The Flash 5 support also features
a few new commands to increase the
amount of communication between the
Director movie and an embedded Flash
SWF. One of the most important of these
is the Telltarget function, which gives
you the ability to control the timeline
of a movie clip with the Flash movie
– previously you would have had to
import each movie clip as a separate
sprite within Director. Another Lingo
addition is the XML command, which
provides allows structured data exchange
between the Director movie and Flash.
While undoubtedly welcome,
the Flash integration could be greater,
especially with respect to targeting movie
clips. Only a small number of commands
are supported – you can set properties
for instance, but not variables. You will
almost certainly need to think creatively,
and adapt your Flash movies prior to
import into Director.
Director 8.5 now supports RealMedia
import, covering both audio and video,
and will enable designers to develop
front-end RealMedia players.
To wrap up the rest of the Shockwave
Studio, you’ll find the Shockwave Player
8.5, Shockwave Multiuser Server 3, the
graphics application Fireworks 4, and
the sound application Peak LE.

Mac and Java

Media management
The RealMedia support will be most useful
for online Shockwave applications.

With Multiuser Server 3 you can
create Shockwave applications that
allow up to 2,000 users to access a movie
simultaneously. One of the most obvious
applications for this is the creation of
interactive chat-engines. Using the
Multiuser server allows the creation
of rich environments – with real-time
interaction. In a nutshell, this works
far better than any other Java based
real-time chat you’re likely to come
across; and the best news for Macintosh
users is that the server is totally Mac
compatible.
All you need to be able to serve
Multiuser applications is an externally
accessible IP address. The new version
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also supports the UDP transport protocol
as well as TCP, which apparently makes
for faster traffic and improved server-side
scripting – allowing more of the dataprocessing to happen at the server
processor rather than the client-side.
There’s little to add about Fireworks 4,
except to say that it compliments Director
perfectly. Image assets in Director can be
edited directly in Fireworks, and you can
launch just the image-export component
of Fireworks to speed things up further.

Learning the Lingo
The support for Flash 5 is a
welcome addition. Lingo scripts
can now target movie clips within
the Flash movie, as in this
interactive pie chart.

Macworld’s buying advice
If you’ve still not discovered Director as
a multimedia-authoring tool, then buying
the Director 8.5 Shockwave Studio will
be like Christmas. It remains head and
shoulders above any other multimedia
application. Flash may be creating the
biggest buzz at the moment, but you
can do more with Director, and, of course,
you can always embed your Flash movies.
For existing users, the upgrade’s Flash 5
support is a bonus, while Shockwave 3D
will either be the best thing you’ve ever
used, or something you’ll never look at.
Martin Gittins

Object of desire
The properties of a Shockwave 3D
object can be set using the
Property Inspector, including
lighting and texture effects.
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Real-time video editing

RTMac
Manufacturer: Matrox (01753 665 624)
www.matrox.com

Pros: Real-time editing and effects;
additional monitor support.
Cons: You have to buy Apple’s
Final Cut Pro 2 to use it.
Min specs: 400MHz G4 with AGP
graphics slot; 256MB of RAM; free
PCI slot; Mac OS 9.1; QuickTime 5.0.
Price: £699 (excluding VAT)
Star Rating: ★★★★/8.5

f you are really serious about editing
video, then RTMac is a must-have
device. It consists of a hardware
card that attaches to a breakout box –
a device with various audio and video
connections. The hardware card takes
care of analogue-video capture, and
more importantly the effects acceleration.
The most compelling reason for
buying RTMac is for its real-time effects
capabilities. While the breakout box has
analogue-video connections, most people
will be using DV which is captured though
the Mac’s built-in FireWire ports. If you
need only analogue to DV capture, then
the Formac Studio (See Macworld, June)
would suffice. The card supports a
monitor output, which allows you to have
a dual monitor set-up if you have a spare
screen lying around. This is very helpful
when using an application like Final Cut

I

ATA drive connector

Ahard PCI RAID
Ultra ATA66
Manufacturer: Acard www.acard.com
Distributor: TMC Technology
(01438 842 305)
Pros: Simple and effective;
Mac OS X compatible.
Cons: Short on instructions.
Min specs: PCI slot; two ATA drives.
Price: £189 (including VAT)
Star Rating: ★★★★/8.4

f you want to add to your harddisk storage with minimum cost
for maximum speed, the Ahard
from Acard is a terrific solution. It lets
you combine two fast-but-cheap ATA
drives as a single RAID volume. This
will outperform most single drives
– SCSI or ATA – without a problem.
When I tested FireWire hard drives
a few months ago, I was disappointed
to find that the drives weren’t that wellsuited to audio-visual (AV) work. Because

I

Pro – with extra room for windows, you
can always see what is going on. To use
the RTMac at all, you will need Final Cut
Pro 2, and that isn’t included in the £699
price – it’s an extra £680. This is irritating,
as the PC equivalent comes with Adobe
Premiere and a fistful of other software
– the Mac version comes with nothing
but drivers.
If you do have the latest version
of FCP, RTMac will enable dozens
of transitions and motion effects.
It might shave only off thirty seconds
here and there, but waiting for rendering
effects cuts on creativity. You’re less likely
to try new things, or change things that
don’t quite work if you have to wait
around for the results. Instant effects let
you keep the rhythm of editing, and help
you produce better results faster.
The RTMac also lets you work with
up to three layers in real time, meaning
you can have two video channels and a

FireWire drives use a bridge between
the FireWire connection and the ATA
drive, the results were slow. The Ahard
card will allow you fantastic speeds at
relatively low prices.
If you are not that familiar with
the inside of a Mac, you may be forgiven
for a little reluctance to delve. However,
installation and set-up is pretty
straightforward, at least in G3 or G4
towers. All you need is the Ahard card,
a couple of ATA drives and a screwdriver.
You can pick up a 40GB ATA drive for
£125, so for £250 you can get an extra
80GB of internal storage. This is great
for video projects – big enough for a
full-length feature film, and fast enough
to keep up with the throughput.
You set the drives up as a single
volume by flipping a couple of dip
switches and formatting. Because the
RAID is a hardware setting, it doesn’t
depend on software to mount the volume.
This means the card works perfectly with
Mac OS X.
The performance will differ depending
on what make and model of hard drive
you use. However, it should easily outstrip
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graphics channel in real time. If it can’t
render your work in real time, it will show
an approximation of the final rendered
effect.
There are some things that can’t
be done in real time; motion blur, for
example, needs to be rendered. But,
you should be able to use any
motion effect together with
any transition at the same
time. That isn’t to say
you can’t do more
complex effects, just not in
real time. When an effect is too
complex to render in real time, a red line
appears in the render status bar. You can
simply choose the highlighted sequence
and render as you need to.

Macworld’s buying advice
The cost of editing video professionally
has plummeted. Now you can use your
Mac to do broadcast-quality television
or movie work. While Final Cut Pro is an
exceptionally powerful piece of software,
you can’t afford to be drumming your
fingers waiting for effects to render
when clients are watching. RTMac
is the solution to that problem.
It would be nice if Matrox had
included FCP, but even when buying it
separately, the solution should pay for
itself in a professional environment. If
you want to use a Mac in an edit suite,
the RTMac offers the right features,
and will reduce those pauses that
slow rendering inflicts on the editor.
David Fanning

InternetBuddy Web Journal
Publisher: Web
Support Services
www.websupportservices.com

Pros: Handy size; specially
designed pages for Web
information.
Cons: If you lose it… that’s all
your info gone; needs more
pages than are included.
Star Rating: ★★★★/7.5

Passwords for myriad Web
sites can be impossible to
keep track of. You can
organize them efficiently by
using the InternetBuddy Web
Journal. The InternetBuddy,
a 5-x-8-inch ring-bound
organizer, consists of index
pages and detachable security
cards for passwords. You enter
your real passwords against
a proxy Password 1, and
then enter Password 1 in the
relevant Web site section of
your Buddy. Lose it, and at
least your passwords are safe
– even if you don’t know what
they are for.

Gillian Thompson

Swift RAID
The Ahard card is great alternative to FireWire when working with video.
It’s quicker and relatively cheap

your normal
internal drive. It’s likely that an
Ahard RAID system will be fairly close
in performance to a SCSI RAID system,
but at a fraction of the cost.

Macworld’s buying advice
If you want to use your Mac for video
work, the Ahard RAID is an ideal way
of solving the storage problem. It gives
you all the speed you need, and bumps
up your space for minimal expense.
David Fanning
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Projector round-up

C60
Manufacturer: Ask
(0800 028 6470)
www.infocus.com

Pros: XGA output; 2.6kg.
Cons: None.
Min specs: VGA or video
source.
Price: £2,590 (excluding VAT)
Star Rating: ★★★★/8.2

EMP-50
Manufacturer: Epson
(0800 220 546)
www.epson.co.uk

Pros: Cheap; sturdy.
Cons: 600-x-800 pixels
maximum output.
Min specs: VGA or video
source.
Price: £1,799 (excluding VAT)
Star Rating: ★★★★/8.1

EMP-703
Manufacturer: Epson
(0800 220 546)
www.epson.co.uk

Pros: High specs.
Cons: High price; bulky
compared to the LP130.
Min specs: VGA or video
source.
Price: £3,999 (excluding VAT)
Star Rating: ★★★★/7.4

LP130
Manufacturer: Infocus
(0800 028 6470)
www.infocus.com

Pros: Small; powerful; light.
Cons: Still out of many people’s
budgets.
Min specs: VGA or video
source.
Price: £3,290 (excluding VAT)
Star Rating: ★★★★/8.7

Size up the options
While DLP projectors, like the
LP130 (top), are shrinking fast, the
EMP-703 (below) is possibly as
small as LCD technology will
allow.

58

Macworld JULY 2001

Macworld reviews

ive years ago, a portable digitalprojector cost around £5,000,
would have made a mockery of
the word of portable, and had a
brightness of around 400 ANSI lumens.
Modern projectors’ specs have improved
greatly, but the price hasn’t shrunk much.
We took a look at some of the most
recent models – the smallest, lightest
and most expensive end of the market,
and also some lower-specification lowerprice models.
The latest ultra-portable projector
from InFocus is now smaller than a
laptop, and pumps out 1,100 ANSI
lumens. Epson has a comparable
projector. Though not quite as tiny as
the InFocus LP130, the EMP703 offers
similar specs at a similar price.

F

Size matters
Even the entry-level models are
considerably smaller than their
predecessors. We took a look at Epson’s
EMP-50 and the Ask C60. Again, both
models have similar specs, and the prices
are in the same neighbourhood.
The entry-level models are bulky
compared to the ultra-light class, but,
compared to older models, reasonably
compact. Neither model is backbreakingly heavy, with the Epson
weighing in at 3.1kg and the Ask at
2.6kg. The dimensions are pretty much
the same.
Both models are based around three
0.7-inch LCD panels, which explains the
similar dimensions – though it doesn’t
explain where Ask lost 0.5kg. The
brightness is 1000 ANSI lumens on the
Epson and 1,100 on the Ask. When both
projectors displayed an image side by
side, the picture wasn’t obviously brighter
on the Ask; however the colour seemed
slightly washed out on the Epson. Both
machines claim a contrast ratio of 400:1,
which should mean a greater range of
colour. However, claims about brightness
and contrast are notoriously difficult
to verify. In our tests the Ask came
out slightly in front for image quality.
Picture resolution is an important
measure of a projector, and again, the

Ask C60 has
the higher resolution of
1,024-x-768 pixels, compared to
the Epson’s 600-x-800 pixels. This
is understandable, because the
Epson is almost £800 cheaper.
Resolution is an important measure
of quality for an LCD projector – the more
pixels you have to play with, the crisper
the image will be. If you’re projecting a
PowerPoint presentation, for example,
small text can be distorted beyond
recognition if the resolution is too low.
Both projectors have a video input, and
video – which is comparatively low
resolution anyway – looks terrific on
either model.

Noise reduction
Both models have a speaker system,
but neither is high quality. The Ask
comes with stereo 1W speakers, while
the Epson has only a single 1W speaker.
If you were to watch a movie on one of
these projectors, I would recommend
connecting your video to some more
powerful speakers. In the boardroom, the
small speaker works well enough, and if
anything will save you from naff
swooshing page-turn sound effects
that litter so many sales presentations.
The other aspect of sound is of course
the noise from the very necessary fan.
Because these projectors use such bright
bulbs, the heat generated is tremendous.
Fans are noisy because they churn-up air.
The EMP-50 was noticeably noisier than
the Ask model, but both were quiet
compared to older models.
Choosing between the two models is
not easy. The Ask model beats the Epson
on almost every count, but it doesn’t beat
it by much. As far as pricing goes, the
Epson is the most affordable at £1,799
(excluding VAT), while the Ask is £2,590.
So even though the Ask is a slightly
better projector, is isn’t immediately
obvious that it’s worth the extra
money.
Money is probably
going to be the deciding
factor for these two
projectors – by paying for
the extra resolution, you’re
increasing the useful life
of the projector. The lowerresolution model will be
outdated much quicker. So, it
makes sense to pay the extra
for the extra features. However, if your

budget is tight, it’s better to have a
projector than nothing at all. If you
budget doesn’t stretch to £2,590, the
EMP-50 is excellent value.

Top end
The other two projectors we looked
at are definitely not for the budget
conscious – the more expensive model
is almost four grand. What you’re paying
for is the ultra-portability of a high-end
projector with no expense spared. The
InFocus LP130 is a real show stopper,
eliciting interest from anybody that saw
it. It’s the smallest projector out there, yet
it has the punch of models twice its size.
The reason that InFocus can make
such a small projector is because it uses
a DLP chip. A DLP chip, or Digital Light
Processor, is basically a RAM chip
covered with microscopic mirrors, on even
smaller hinges. As the chip is addressed,
each of the mirrors is switched to an On
or an Off state. It all seems very fragile,
but it’s remarkably sturdy – because the
weight of the mirrors is so small, they are
largely unaffected by knocks of vibration.
As the DLP is a single chip, the size can
be brought right down.
Epson doesn’t use DLPs in its
projectors, most likely because it has
so much invested in LCD technology.
There seems to be a reluctance to use
technology that is developed outside
Epson, which is a shame. Consequently,
the Epson projector uses three LCD
panels, which inevitably make the
EMP-703 much bigger.
The LP130 weighs-in at a
featherweight 1.6kg, compared to
the 703’s 2.7kg. The LP130 is smaller
too, measuring just 170-x-219-x-51mm.
The Epson measures 267-x-213-x-72mm,
more than twice the size.
It almost seems unfair to compare
the two models, but both have similar
specifications. The Epson isn’t a
particularly large projector by normal
standards; it’s just that the LP130 is
incredibly small.
Both models sport an XGA (1,024-x768 pixels) output, and both are very
bright – with the LP130 claiming 1,100
ANSI lumens and the EMP-703 claiming
1,000 ANSI lumens. As with the other

Search Macworld’s Reviews database online (www.macworld.co.uk), updated throughout the month

models tested, the difference in
brightness is negligible and extremely
difficult to measure accurately. Either
model would be bright enough to project
on to a screen without dimming the lights
– though, if there is direct sunlight, it
would be necessary to draw the curtains.
Portability is a main issue for these
models; both are sold as ultra-portable
projectors. The Epson is definitely small
enough to carry around without breaking
backs or slipping discs. This is a major
step forward considering the “luggable”
12kg models around only a few years
ago. The Epson is still bulky compared to
a PowerBook though, and would probably

Mac-music starter guide

Macworld Music
Handbook
Publisher: Sanctuary www.sanctuary-publishing.com
Distributor: Macworld (020 831 9252)
www.macworld.co.uk

Pros: Well-written starter guide;
not too technical; extensive glossary.
Cons: No index.
Price: £20
Star Rating: ★★★★/8.5

s Macworld columnist Michael
Prochak spells out in the
introduction to his Macworld
Music Handbook, the Mac has long been
the choice of professional musicians for
the recording, manipulation and playback
of digital audio. USB and FireWire
technologies mean that all new-Mac
users can easily and instantly connect
digitizers, MIDI devices and DAT storage
drives in order to capture high-quality
44.1kHz audio tracks at ultra-fast speeds.
But, there hasn’t been a book devoted
to Mac-based music making since Fatboy
Slim was nerdy Norman Cook in The
Housemartins.
Rather than write about every single
piece of Mac-compatible music software,

A

need an extra bag. The LP130, however,
is so diminutive that it almost puts the
PowerBook to shame. It seems much
more suited to the new iBook.

Macworld’s buying advice
It would seem that the LCD price-war
(see page 43) may be starting to affect
the projector market. Although not all of
the models tested use LCD technology,
the prices are shifting. Just before we
went to press, InFocus wiped £1,000
of the price of the LP130 – reducing
it to £3,290. This hasn’t left Epson
time to react with a new price, so for the
moment the EMP-703 remains at £3,999;

Prochak sensibly concentrates on
Steinberg’s Cubase VST (version 5.0).
Cubase is one of the Mac’s most popular
virtual studios, “in” which you can
record, edit and process MIDI and audio
data in a creative and affordable manner.
Helpfully, the bundled CD includes a
demo of the latest version of Cubase VST.
(You may also have noticed that there’s
a couple of extract chapters in a free
booklet attached to this copy of
Macworld; so we’ve included the Cubase
demo on this month’s Macworld CD.)
Prochak points out that Mac users
traditionally hate manuals, and so
approaches his subject as a musician
helping others to familiarize themselves
with Cubase, the Mac and digital musicmaking.
“The Macintosh is changing the way
in which music is made. What used to be
done by a team of people in an expensive
editing studio can now be done by one
person at home. All it takes is the right
equipment and a bit of knowledge about
the basics of digital recording and MIDI,”
writes Prochak.
And, that’s exactly what he helps
budding Mobys and Beastie Boys with
in this book. There’s chapters on the
differences between pro and budget
setups, buying the right equipment,
getting started with Cubase, mixing MIDI,
editing and manipulating tracks, adding
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but it’s likely to change before this issue
hits the streets.
The new pricing brings the LP130
down from an unobtainable executive
plaything to a price that companies can
more readily afford.
At the moment, the high-end ultraportable market is dominated by the
LP130, at least until Epson re-jigs its
prices. At the entry-level, the EMP-50
does a perfectly good job for the price
(£1,799 excluding VAT). With a little extra
budget you will get a little more
performance and functionality
from the Ask model.
David Fanning

Price projection
Though similar sizes, the Ask C60
(above, left) packs more of a
punch than the EMP-50 (above),
but costs an additional £800.

effects (such as
Grungelizer and Wild
Flanger), quantizing, and
customizing.
At the back of the
book, there’s a 100-page
glossary – so that
experienced studioengineers can’t make too
much fun of you when
you’re just starting out.
On just one page, this
tells you the difference
between a ribbon
microphone and a ring
modulator, a riff and a
roll-off, and a rhythm
track and “riding the
faders”.

Macworld’s buying advice
Regular Macworld readers will be familiar
with Prochak’s bozo-Gonzo writing style,
and will be glad to know that he has
written this book in a similarly nontechnical manner. The Macworld Music
Handbook is an excellent guide for Mac
users starting to make music, and for
musicians starting to use the Mac.
Whether you want to be a Kraftwerk-like
synthetic robot or a bit of a hippy (like
Prochak), this long-awaited book is sure
to help lay down your tracks.
Terry Church
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Cheap-and-cheerful CD burner

Click’N Burn
Publisher: Stomp www.clicknburn.com
Distributor: Intellica UK (020 8887 0328)
Pros: Cheap; simple to use; includes
CD Stomper labelling kit; good range of
burning options; can be dedicated for
FireWire, USB or SCSI.
Cons: Lacking some more advanced
features of competition.
Min specs: Mac OS 8.0; 32MB RAM;
supported CD recorder.
Price: £42 (including VAT)
Star Rating: ★★★★/7.5

n a market dominated by Toast,
launching another CD-burning
application may seem to be foolhardy
– especially as Apple’s free iTunes has a
burning capability. But Stomp has brought
out a cheap-and-cheerful toaster.
Click’N Burn gives you the option
of choosing the interface of your burner
– SCSI/ATAPI, FireWire or USB – and
installs the appropriate drivers and
software for each. Once installed,
the user has two options – quick start
and advanced mode. For the review,
I concentrated on the latter, kicking
off in Audio CD burning mode.
Losing a point to Toast, Click’N Burn
can’t connect to the CDDB database, so

I

Cheap 3D with high-end specs

LightWave 6.5
Publisher: NewTek www.newtek.com
Distributor: Gomark (020 7610 8686)
Pros: Integrated 3D tools; great rendering
engine; integrated particle-system.
Cons: Poor documentation.
Min specs: PowerPC; Mac OS 7.5;
32MB of RAM; QuickTime4.0;
QuickDraw 3D 1.5.4.
Price: £995 until July 31, then £1,599
(both prices exclude VAT).
Star Rating: ★★★★/8.9

iven the Mac’s graphics
superiority, it’s surprising that
3D production on our platform
of choice has, until recently, been a
piecemeal process. One of the first
fully integrated 3D packages
to migrate to the Mac from the Unix
world was NewTek’s LightWave, a
powerful application for creating
television and film effects.
LightWave is a collection of
applications: Modeler, for creating
objects; Layout, for animating and
rendering; and Hub, for updating projects.

G

you’ll have to enter name songs manually.
It took 14 minutes to burn a normal
audio CD on a 4x Speed Yamaha CDBurner. There were no problems, and the
disc played perfectly. (You have the option
of using literally hundreds of other, faster
burners, but check for compatibility first.)
This involved simply dragging the
MP3 files onto the main audio window.
They then automatically expanded into
AIFF files to make them compatible to
burn. Again, the results were adequate.
Click’N Burn also provides Audio
Scribe software, which acts as an
analogue-to-digital recorder, allowing
you to transfer music from vinyl. This
is comparable to Toast’s CD Spin-Doctor.

Modeler is polygon and spline based.
It offers an efficient surface-subdivision
mode that can create smooth organic
forms similar to what you’d get with
NURBS modelling. The program includes
a collection of tools for patch modelling,
along with “viewports” that you can
use as UV-mapping editors for precise
placement of textures.
Some notable additions in version 6.5
are an integrated particle system, a softbody dynamics engine, automated Atlas
mapping tools, and a new Schematic
view. Other welcome enhancements
include a reorganized interface, a béziercurve tool, and resizable viewports.
Several powerful procedural
animation tools make complex motions
easier to set up. An integrated particle
generator – when used in conjunction
with HyperVoxels, LightWave’s
volumetric-object generator – lets you
simulate smoke, explosions, and fluids.
Motion Designer can force objects to
behave like cloth that can be influenced
by any other element in the scene.
But, no matter how many impressive
features a 3D package offers, it all comes
down to rendering – and LightWave
excels at this. The ray-tracing engine can
calculate realistic reflections, refraction,
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Burning data CDs is just as simple.
Click n’ Burn can deal with Mac HFS
volumes and Mac/ISO 9660 hybrids, copy
CD to CD-RW, and burn multi-session
discs in the same fashion as the Audio
routine. This being a product from Stomp,
you can finish the process by labelling
your CDs with the bundled CD Stomper.

Burn out
Click’N Burn gives you the option
of leaving the disc open for
another session, so you can add
tracks to squeeze the last bit of
space onto that CD. Being that
miserly, I decided to burn some
MP3s on the end.

Macworld’s buying advice
Click’N Burn doesn’t have the most
advanced feature list in the world, and
you may be put off by the dull interface.
But, it’s a good for the price. If you’re
looking for a simple-to-use and costeffective solution, check it out.
Michael ‘Click n’ Burns

and caustics; the radiosity engine
allows you to illuminate a scene using
photographs saved in the HDRI format.

Hats off to mapping
LightWave’s Atlas function
automatically “unwraps” models.

Macworld’s buying advice
For anyone looking to buy a complete
3D-production package, LightWave is
tremendous value – especially when
you consider that many standard
features, such as particles and
dynamics, are available only as
plug-ins in other packages.
Matt Lowrie
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Accessible 3D tools

Amorphium
Pro 1.1
Publisher: Electric Image
www.amorphium.com

Distributor: Gomark
(020 7731 7930)
Pros: Unique modelling tools;
easy to use.
Cons: Skimpy manual; not
Carbonized.
Min specs: Mac OS 8.6;
PowerPC; 64MB of RAM.
Price: £209 (excluding VAT)
Star Rating: ★★★★/8.2

3D-modelling app

Amapi 3D 6.0
Publisher: Eovia www.eovia.com
Distributor: Computers
Unlimited
(020 8358 5857)
Pros: Fluid and intuitive;
excellent results.
Cons: Flaky; proprietary
Web3D technology; not
Carbonized.
Min specs: Mac OS 8.1;
24-bit True Colour display,
64MB of RAM.
Price: £299 (excluding VAT)
Star Rating: ★★★★/7.5
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lectric Image’s Amorphium made
3D modelling more accessible, by
putting intuitive sculpting tools
into a simple interface inspired by
image-software wizard Kai Krause.
Like Amorphium, Amorphium Pro
lets you modify objects as though they
were made of clay, apply sculpting and
painting tools, and employ real-time
distortion effects. But, the new version
removes the original’s most frustrating
limitations. A full keyframe-animation
timeline lets you animate multiple
objects, the camera, lights, and
environmental effects. The vastly
improved Materials function lets you
define surface colours and properties, and
you can add surface effects with shaders.
In addition to importing models
in popular 3D formats, the program
can import EPS files and convert them
into 3D objects. And, Amorphium Pro’s
extensive Flash-export options let you
choose between realistic, high-bandwidth
animations and more-cartoonish ones that
consume less space.
A new Wax mode, complete with a
Heat setting, lets you expand or contract
a model’s geometry as if it were a lump
of wax. As before, you can use linked
spheres to create fingers and other
objects. With a new parenting function,

E

lthough Amapi 3D has some basic
animation capabilities, it’s largely
a modelling and rendering tool for
creating static 3D artwork – which makes
it a rarity on the Mac. It has an unusual
interface that some people think is the
best thing since sliced polygons, and
some run screaming from. And now it’s
taken individuality to new lengths with
its Web3D format, 3Space.
On its own, 3Space is a pretty decent
format. It includes all of the standard
features, such as simple animation
capabilities for allowing the user to click
and open the door of a toy car. However,
it also includes a full dynamics-system
that allows you to give objects force,
mass and other properties – such as
stiffness and damping. This allows
the creation of realistic interactive
environments without fixed results –
such as snooker table with potable balls.
3Space files are small, even when
compared to other Web3D formats, and
are rendered in OpenGL by the end-user’s
computer. The main problem with 3Space
is that it’s not Shockwave 3D. There’s no
point working with a format that has no
user base. MetaStream Viewpoint has the
user base at the moment, and Shockwave
has a huge number of potential users
who need only a minor update to get
onboard. And, that’s not counting Adobe’s
venture into this market with Atmosphere

Special FX
Amorphium’s basic sculpting functions are now split between two modes. Tools mode has a new
Brush Editor for creating your own sculpting tools; FX mode now has a Cogs effect that lets you
produce gear-like objects.

you can link one object’s motion to
another’s, and Boolean functions let
you create new objects by intersecting
existing ones. With the improved masking
tools, you can reduce or expand polygon
density in different parts of a model.
The manual is skimpy, and at £209,
Amorphium Pro costs £50 more than
the original.

Macworld’s buying advice
Amorphium Pro vastly expands on
Amorphium’s feature set, and remains
remarkably easy to use. It’s a great tool
for Flash developers, 2D artists with an
interest in 3D, and 3D artists looking for
a new organic-modelling program – it’s
just a shame about the price hike.
Stephen Beale

A

Spaced out
3Space results look good on both Mac and Windows PCs – if these were the only criteria for
judging a format, then 3Space would be one of the best available. But, they’re not.

later this year. That 3Space doesn’t work
with Internet Explorer on the Mac is
another reason to avoid it.
If you don’t care about Web3D, then
Amapi 6.0 is a better prospect. Its tools
have had a major overhaul, with a refined
smoothing tool and a clearer interface.
The polygon tools have been boosted,
and a better tessellation tool added.
The app includes more primitives and
deformers than previous versions. It also
adds totally new tools, such as the height
field object for creating a relief from a

greyscale image. You also get an extrude
tool that can work multiple sections of
an object (or the entire object) and a
bump/unbump control for contouring
surfaces. On the downside though, Amapi
can be flaky. It has a tendency to crash
and sometimes won’t open saved files
– though you can always import them.

Macworld’s buying advice
It produces stunning results, but is
let down by 3Space – and flakiness.
Moe Vernon
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Hi-res digital camera

PhotoPC
3100z
Manufacturer: Epson
(0800 200 546)
www.epson.co.uk

Pros: Monster file-size;
good software support;
flash mounting.
Cons: A little bulky.
Min specs: USB or a Compact
Flash card reader.
Price: £649 (including VAT)
Star Rating: ★★★★/8.6

Web-based training

Macromedia
University
Publisher: Macromedia
macromedia.elementk.com

Pros: Learn when and where
you want; easy-to-use
campus-style training; online
advice if you need specific
direction.
Cons: Needs a wider range of
subjects; Windows interface.
Price: Basic Training, US$99;
Complete Training, US$249;
Professional Training, US$399.
Min specs: PowerPC; Mac OS
8.0; Netscape 4.0 or Microsoft
Internet Explorer 5.0
Star Rating: ★★★★/7.2
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t first glance, you may wonder
what the difference between the
new 3100z and the old 3000z is.
The major specifications are the same;
it still has a 3.3-megapixel chip, which
when combined with Hypict technology
outputs files that are nearly five
megapixels (2,544-x-1,904 pixels). This
makes it ideal for printing A3 images.
There is, however, a raft of small but
significant enhancements. For instance,
there’s now a built in photo-stitching
assistant. This isn’t just an extra piece of
software – although there is one thrown
in the box – it’s actually a mode on the
camera. In stitching mode, each picture
you take moves to the left quarter of the
view and becomes translucent. This
allows you to line up the next shot of
your panorama without the guesswork.
It still has a 6x zoom – 3x optical and
2x digital – but the digital zoom has been
improved and is now smoother than
before. The big lens gives you an
excellent, sharp picture – even in
the Hypict high-resolution mode.
Getting your images from the cameras
to the printer is now much easier than
before. Rather than depending on a
card reader or a software-driven USB

A

s one of the leaders in design
applications, Macromedia now
offers online courses for its
software – from learning how to use
Macromedia UltraDev, to more general
skills such as DHTML or XML. You can
choose to sign up for either instructor
or study led courses, or a combination
of both.
To register as a student for the
Macromedia University, you first need to
go to www.macromedia.com and click on the
link to Resources. The registration process
is simple: Fill out your details, enter your
eight-digit code, and log in as a student
with access to several choices.
You can choose from several different
lesson styles – instructor led, self-study
and seminar, or a combination of any of
the above. Take time to have a quick tour
of what’s available to make sure you sign
up for the right class. Unfortunately, I was
first interested in running through the
self-study Quick Skill course in DHTML,
but it isn’t available for the Mac.
The classes are listed clearly, and
you can take a tour of the virtual campus
before signing up. There’s also the option
of taking a test, from which the courses
to choose will be recommended.
A study-led course has the advantage
of allowing you to choose when and
where you work. However, for those
of us who need more motivation – the
equivalent of that slave-driving teacher
– an instructor-led course is available.

connection, the 3100z actually works like
a card reader. Simply plugging it in to a
Mac with USB will
automatically mount
the card in the
camera on the
desktop. This
makes life simple,
and is another
minor refinement
that improves the
camera.
The interface
for the controls on
the back screen is
simple to navigate.
You can turn off the
camera’s helpful
beeps if you find them
irritating. You can also access
the special modes such as video,
panorama and continuous mode. Adding
a voice notation is easy too – the 3100z
has plenty of tricks up its sleeve.

Macworld’s buying advice
The 3100z is bulky compared to some
cameras, but the extra weight adds to its
feel as a traditional camera. If you don’t
mind the bulk, it’s excellent for high-

resolution
pictures – if you want to print A3
size photographs, the 3100z is ideal.
The 2,544-x-1,904 pixel output is as
high as you really need, and it’s good that
Epson has concentrated on other ways
to make the camera better. Now that
the resolution race is done with, and the
digital-camera market matures, we will
see more functional cameras like this one.
It’s packed with both pixels and features.
David Fanning

A

On course
Macromedia University remembers your preferences, selected or semi-completed courses, and level
of skill achieved. The My Courses page summarizes which classes you have completed and how
many levels are still to go. However, it has a Windows-interface option only.

The classes are presented as
interactive Flash movies. Not only are
you shown how to perform a certain
action, you’re also encouraged to follow
the steps and remember sequences.
If you get stuck or lose your place,
simply listen to the instructions again.

Macworld’s buying advice
If you aren’t lucky enough to have access
to a high-bandwidth leased line in your
office, then the cost of spending time

online could be prohibitive. You don’t
need any Macromedia software to do
the course (other than Flash Player).
The learning is done through a browser,
so you save money there.
A subscription to a course library
grants you a year of access to all current
courses, plus any new courses added
during the year. If you want to see
if the training courses are worthwhile,
Macromedia is offering a 30-day trial.
Gillian Thompson
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Pirate adventure with comic twists

Escape from Monkey Island
Publisher: Aspyr Media www.aspyr.com
Distributor: Softline (01883 745 111)
Pros: Engaging story; terrific graphics; many challenging puzzles.
Cons: Occasionally too self-referential; not for players with short
attention spans.
Minimum specs: 233MHz Power Mac G3; 64MB of RAM;
8x CD-ROM; 100MB hard-disk space; 4MB of VRAM; OpenGL 1.2.1.
Price: £40 (including VAT)
Star Rating: ★★★★/8.8

o ho, yo ho, a pirate’s life for me!
Ever since I was a wee lad, I’ve
been obsessed with pirate stories.
This hasn’t abated in my adult life – much
to my therapist’s fascination, I’m sure.
So when I heard that Aspyr Media was
publishing a Mac version of LucasArts’
latest Guybrush Threepwood adventure,
Escape from Monkey Island, the
Blackbeard in me wildly gyrated
his hook and peg leg with joy.
Escape from Monkey Island is
a rollicking good time, and thanks to
recent advances in graphics technology,
it’s a feast for the eyes as well.
Escape from Monkey Island is
the fourth adventure game to star
Guybrush Threepwood, a wannabe pirate,
and an unlikely hero if ever there was
one. Although he’s a bit daft, he means
well. And as the story unfolds, you’ll find
that even though Threepwood may have
a bit of Walter Mitty in him, he’s not just
a daydreamer – he’s a doer, but in his
own bumbling, incompetent sort of
way. In fact, he’s already won the hand
of the beautiful and plucky Elaine MarleyThreepwood, resident governor of Mêlée
Island – a veritable pirate haven.
Elaine and Guybrush return to
Mêlée Island after a three-month
honeymoon to discover that Elaine
has been declared legally dead. Elaine’s
gubernatorial seat is up for grabs, and
challenger Charles L Charles is making
his play for the position. Charles is a new
– yet disturbingly familiar – presence in
town. Guybrush and Elaine soon discover
that proving Elaine’s identity and health
status is more difficult than they thought,
and that their old nemesis, pirate
LeChuck, is behind recent events.
What makes this adventure tale
so engaging is that it’s firmly rooted
in situations that folks can identify
with today. Threepwood’s archnemesis
LeChuck may be a supernatural force
straight from the flaming bowels of
hell, but Guybrush needs to solve all
sorts of mundane – and riotously funny –
problems in his attempt to vanquish him.
Threepwood and his band of brigands
square off against the most fearsome

Y

Tricks and tips
Avast ye! If you can’t find your
sea legs in Escape from
Monkey Island, try these tricks:
■ Typically, anything
Guybrush can pick up is useful,
so don’t be afraid to grab
whatever you find. He has
amazingly voluminous pants,
apparently, because that’s
where he keeps everything.
■ Don’t be afraid to talk with
others. Often, conversations
will get you somewhere, even
if at first you feel as though
you’re wasting your time.
■ Can’t figure out what the
old drunken sailor’s birthday
balloon is good for? Challenge
the dart-throwing champ to try
to hit it.
■ Getting out of the bank
vault involves wedging open
the door frame. Hint: sponges
swell when soaked.
■ Once you get the directions
to Pegnose Pete’s lair in the
Mystes O’ Tyme Marshe, write
them down. This will make
navigation a lot easier.
Otherwise you’ll be travelling
by raft, looking at the map to
see where you are, adjusting
your course, and trying again
until you get there.
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Monkey business
Don’t let the brightly coloured, cartoonish animation fool you – kids may enjoy this title, but it’s
definitely made for adults (the game is recommended for teens and adults).

menace on the high seas: lawyers.
Threepwood also goes head-to-head with
a real-estate tycoon, a thief with no nose,
a prosthetics salesman, and perhaps the
most frightening of all, a bucktoothed
barista at the local Starbuccaneers coffee
shop. That’s only the tip of the iceberg,
mateys – to tell you any more of the
story would ruin the surprise.
Throughout, the game is rife with
well-written dialogue, superbly delivered
by top-notch voice actors. And, there’s
an engaging soundtrack accompanies
the action – I didn’t scramble to turn
off the music after the first few minutes.
Escape from Monkey Island’s user
interface is intuitive and straightforward.
The game consists of 2D illustrated
backgrounds, populated by 3D characters
and objects.
You direct Guybrush using the arrow
keys on your keyboard, and you can make
him look at, use, or store various objects,
as well as talk with characters. When
Guybrush needs to address someone,
you’re presented with a branching menu
containing various comments, queries,
and replies, depending on the context.
The game is cleverly designed, so if
you haven’t yet explored a crucial area
or got a key piece of information, your
interaction with other characters in the
game may subtly change so as not to
give the story away. This level of detail
is refreshingly complex and challenging.
Escape from Monkey Island is also
nicely configurable – you can set keys
to execute a variety of commands, tweak
audio and video settings to your liking,
and save the game at any point.
The 3D characters and objects in
Escape from Monkey Island are rendered
using OpenGL, which can tax a Mac’s
graphics hardware. Aspyr recommends
running the game on a Mac with an ATI
Rage Pro or comparable graphics-card

and at least 64MB of RAM. Westlake
Interactive, the company that ported
the game from the PC, did a nice job
on the conversion. Installation was a
breeze, and the game performed reliably,
although it did crash once or twice on
my 450MHz Power Mac G3. Interestingly,
it ran perfectly on my 333MHz PowerBook
G3, which is slower and equipped with
less-formidable video hardware. The
game’s only apparent technical deficiency
is a prodigious appetite for space on your
hard disk. It needs 500MB in “normal”
installation mode, 1GB for the full
installation, or 100GB for light mode.
If Escape from Monkey Island has
any shortcomings, it’s that the game
often depends on self-referential jokes,
and on characters who were introduced
in the series’ first three games – which
you probably haven’t played, unless you
have a PC lying around. If you aren’t
already a Monkey Island fan, you’ll
occasionally have that somewhat
uncomfortable feeling of not being
in on the joke.
As a single-player adventure game,
Escape from Monkey Island can be played
only once. But it’s vast, spanning two CDs
in all, and you can count on getting days
– if not weeks or months – of challenging
fun out of it, depending on how much
time you invest. Like a long, engrossing
novel, Escape from Monkey Island would
be a good game to be stranded with on
the proverbial desert island.

Macworld’s buying advice
Escape from Monkey Island is an
exemplary modern adventure game,
superbly executed by Westlake and Aspyr.
If you find the adventure genre appealing
and have a bit o’ the pirate in ye, then
set sail for Monkey Island, by hook or
by crook.
Peter Cohen
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G4 upgrade cards tested and rated

erhaps you’ve recently upgraded
to Mac OS X, and you notice your
once acceptably fast blue-&-white
Power Mac G3 beginning to show its age.
Luckily, this Mac’s 100MHz system bus
makes it a prime candidate for a
processor upgrade, which can give you
nearly top-of-the-line performance.
Macworld Lab examined PowerLogix’s
450MHz PowerForce G4 ZIF card; Sonnet
Technologies’ 400MHz and 500MHz
Encore ZIF G4 cards; and XLR8’s 400MHz,
450MHz, and 500MHz Mach Speed G4
ZIF MPe cards. We found that although
these cards performed similarly (relative
to their speeds), those from Sonnet and
XLR8 offered the most extras.
A G4 processor has a subprocessor
called AltiVec (Apple calls it the Velocity
Engine), which can dramatically boost
performance – but only in applications
designed to take advantage of it (such as
Adobe Photoshop and some other imageediting programs, MP3 encoders, and
video-editing packages). Not many
applications are optimized for AltiVec, but
if you happen to work with one of them
every day, you’ll want a G4. And OS X
uses the Velocity Engine much more than
Mac OS 9 does, so if you’re planning to
switch to OS X, a G4 upgrade may be in
order.

P

Patchy support
A G4 processor can’t work in a blue-&white Mac without a firmware patch,
which modifies the ROM, preparing the
motherboard for the upgrade. But, only
Sonnet provides a method for removing
the patch; you would have to contact the
other companies for a removal procedure
(at press time, each was developing this
procedure and was hesitant to release it).
XLR8 had the best installation

package, providing all of the necessary
tools and excellent instructions. Sonnet’s
instructions were also very well written –
especially for users with little experience
inside a Mac – with clear, descriptive
illustrations and a minimum of jargon.

Overclocking
Each card has a 1MB L2 cache that,
by default, runs at half the processor’s
speed. (The L2 cache stores frequently
used instructions, allowing the processor
to operate with greater efficiency.) All the
cards come with software that monitors
the cache, but the amount of control
provided differs from company to
company. PowerLogix and XLR8 provide
control panels, but XLR8’s gives you more
control over the cache’s speed and other
performance parameters. Additionally,
XLR8’s control panel checks the cache
and sets it to the fastest possible settings
– even if they exceed the default settings
– automatically and reliably. Sonnet’s
software is invisible to the user and sets
the cache settings to the proper speed
during start-up. If you don’t intend to

experiment with overclocking – driving
the cache to a higher speed than is
recommended, to squeeze out more
performance – Sonnet’s arrangement
will be preferable.
XLR8’s 450MHz Mach Speed G4 ZIF
MPe had a slightly better Speedmark
score than PowerLogix’s 450MHz
PowerForce G4 ZIF; however, the
difference was negligible – the Mach
Speed beat the PowerForce by only a
second when performing a Gaussian
blur in Photoshop, and it even fell a few
seconds behind when encoding an MP3
in SoundJam. The performance of both
450MHz upgrade cards was close to
that of the 450MHz Power Mac G3 in our
Speedmark and Quake III tests, but the
upgrades’ speeds far exceeded the G3’s
when it came to Photoshop, which is
optimized for the G4.

LAB TEST

G4 performance
The Speedmark subtest that looked
specifically at disk speed confirmed
that the Power Mac G4, with an ATA/66
controller and a newer hard drive, has

G4 upgrade cards compared
MANUFACTURER MODEL

STAR RATING

Sonnet
Technologies

Encore ZIF
G4 400MHz

★★★★/8.4 £279

XLR8

Mach Speed G4 ★★★★/8.4 £325
ZIF MPe 400MHz

PowerLogix

PowerForce G4
★★★★/7.2 £349
ZIF 450MHz
Mach Speed G4 ★★★★/7.3 £369
ZIF MPe 450MHz
Encore ZIF
★★★★/8.1 £379
G4 500MHz

XLR8
Sonnet
Technologies
XLR8

PRICE

Mach Speed G4 ★★★★/7.4 £489
ZIF MPe 500MHz

PROS

CONS

CONTACT

TELEPHONE

Good documentation;
flexible firmware package;
excellent value.
Excellent installation package;
MP enabled; good software;
excellent value.
Easy to install; offers good
performance boost.
Excellent installation package;
MP enabled; good software.
Relatively inexpensive;
good documentation;
robust firmware-package.
Excellent installation package,
MP enabled; good software.

No tools provided.

Computers Unlimited 020 8358 5857

www.sonnettech.com

Firmware-patch uninstaller
not included.

Channel Dynamics

www.xlr8.com

0870 607 0540

WEB

Firmware-patch uninstaller
AM Micro
01392 426 473
not included; no tools provided.
Firmware-patch uninstaller
Channel Dynamics 0870 607 0540
not included.
No tools provided.
Computers Unlimited 020 8358 5857

www.powerlogix.com

Pricey; firmware-patch
uninstaller not included.

www.xlr8.com

Channel Dynamics

0870 607 0540

www.xlr8.com
www.sonnettech.com

All prices include VAT.
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much better disk performance than the
blue-&-white Power Mac G3, with its
slower SCSI hard drive. (The faster disk is
part of the reason that the 466MHz Power
Mac G4’s scores were better than those
of the 500MHz upgrade cards.) Even if
you upgrade your G3 and your hard drive,
you’ll be limited by the slower ATA bus.
The upgrades from XLR8 are
multiprocessor enabled. If you purchase a
400MHz MPe ZIF, you can use it as one of
XLR8’s multiprocessor upgrade.

Macworld’s buying advice
XLR8’s upgrades come with all of the
tools you need, and its products can
be incorporated into a multiprocessor
upgrade later. Sonnet’s helpfull
documentation and low prices make its
upgrades exceptionally attractive. And
software that works without intervention,
along with easily removable firmware
patches, makes Sonnet’s upgrade cards
excellent choices for those who don’t
enjoy tinkering with their machines.

The 400MHz cards from these two
manufacturers are sensible investments.
However, the prices of the faster cards
begin to approach those of used or
refurbished Apple G4s, which have
faster hard drives and CD-ROM drives.
The G4 upgrade card from PowerLogix
is technically sound, but has no
distinguishing features, and its rough
documentation makes it less appealing
than the others we tested.
David Read

Clocking the Velocity Engine
Best results in test.

Speedmark 2.1

SoundJam 2.5.2

Overall score

Model

Adobe Photoshop 6.0.1

MP3 encode

Quake III

Unsharp mask

Gaussian blur

Normal

Sonnet Technologies Encore ZIF G4 400 MHz

120

2:24

10

14

30

XLR8 Mach Speed G4 ZIFF MPe 400MHz

127

2:21

9

13

32

PowerLogix PowerForce G4 ZIF 450 MHz

128

2:06

9

12

34

XLR8 Mach Speed G4 ZIFF MPe 450MHz

134

2:15

8

12

34

Sonnet Technologies Encore ZIF G4 500 MHz

137

2:02

9

12

33

XLR8 Mach Speed G4 ZIFF MPe 500MHz

140

2:01

8

11

35

Apple Power Mac G3/450

127

3:00

15

18

31

Apple Power Mac G4/466

157

2:02

6

8

46

Longer is best

Shorter is best

Shorter is best

Shorter is best

Longer is best

Speedmark 2.1 scores are relative to those of an iMac 350MHz (1999), which is asigned a score of 100 for each test. SoundJam scores are in minutes:seconds. Photoshop scores
are in seconds. Quake scores are in frames per second. We tested each card in a Power Mac G3/450 (blue-&-white) with Mac OS 9.1, 128MB of RAM, a default system disk cache,
and virtual memory enabled. We set displays to 1,024-x-768 pixels and 24-bit colour. We tested MP3 encoding with an audio-CD track that was 9 minutes and 25 seconds long,
and converted it using a default setting of 128Kbps in SoundJam. Ł
Macworld Lab testing by Jason Cox.

Quality speakers

SoundWorks
Slim500
Manufacturer: Creative Labs
www.europe.creative.com

Distributor: Computer
Warehouse
(020 8400 1235)
Pros: Magnetically protected;
£80 cheaper than harman
kardon SoundSticks.
Cons: Satellite speakers can
sound reedy; not as pretty
as SoundSticks.
Price: £60 (including VAT)
Min specs: Any Mac with
sound card offering line-out.
Star Rating: ★★★★★/9.1
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f you’re looking to buy audio bolt-ons
for your Mac, first ask yourself what
kind of Mac owner you are. Be
honest, now. Are you pathologically
compelled to style-coordinate your
peripherals and system, and damn the
cost? If yes, then don’t even bother
reading this. Get online and spend £140
(inc VAT) on the ultra-cool SoundSticks
(reviewed, September 2000) – because
you know you will in the end anyway. If,
however, aesthetics take a back seat to
value for money, then read on – because
it’s unlikely you’ll find a better deal than
the Cambridge SoundWorks Slim500
three-piece speaker system.
Not that the Slim500 is ugly: it’s a
slightly out-of-prime Diana Dors to the
SoundSticks’ sex-kitten Bridget Bardo, if
you will. This is no bad thing, considering
some of the pug-ugly PC sound-systems
out there.
The Slim500 consists of two ultra-slim
(hence the name) 6W satellite speakers
and a 17W subwoofer. The 40mm-high
satellites are magnetically protected,
so you don’t have to worry about
performance being affected by where
they are placed. Plonk them on top of the
monitor if you want. You can hang them
on the wall, too, as they come with a
detachable stand as well as a wallmounting socket.

I

Alone, these matt-silver satellites
are way too weedy to meet your
desktop-audio needs – which is
why they come draped
on the tattooed arm of
a subwoofer brutish
enough to quiver your
liver. The sub, says
Creative Labs, is
“electronically
contoured” to give a
“deep and
resounding bass”.
I’ve no idea what the
techie jargon means, but the company’s
sound-quality claims are certainly
justified. The sub has a frequency range
that starts at 38Hz, which is 6Hz lower
than harmon kardon’s high-performance
iSub (reviewed, May 2000).
To test the system, a colleague ran-up
a CD compilation that spanned the
musical divide – from acid jazz to the
Sound of Music. The subwoofer will
handle anything thrown at it, always
adding as much depth as it does volume.
My only quibble is that, with certain
sounds, the satellites can sound reedy
and flat by comparison.
Volume is controlled via a “knob
on a wire” – and we’re not talking Billy
Smart’s Circus. This little sound-control
unit even has a sticky strip, allowing for

it to be adhered to a convenient
spot. This handiness, though, is undone
by the fact that the bass volume-control
knob remains on the back of the
subwoofer, meaning one still has
to clamber under the desk to make
adjustments. Why not have dual-controls
on the wire? The SoundWorks Slim500
also comes with a two-year warranty.

Macworld’s buying advice
My benchmark for the Slim500 is the
speaker set-up I have at home: an iSub
and two built-in in harman kardon
speakers on my iMac DV. There’s no
comparison – the Slim500 wins hands
down – and for just £10 more than the
iSub costs on its own. A victory for
content over style.
Sean Ashcroft
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Forget the hype about the Sony Vaio and lightweight Windows laptops.
Apple’s new iBook brushes aside the competition, and – alongside the
PowerBook G4 – gives us all the chance to go portable. By Simon Jary

All white now
pple’s British whiz-kid head designer Jonathan Ive
started out blueprinting baths, basins and WCs for
Ideal Standard. (In fact, I believe that my toilet at
home is an early Ive.) With Apple’s new consumer Mac
portable iBook computer, the talented Mr Ive has made a
symbolic return to the world of white goods. The iBook is
white and very very good.

A

New iBook vs old iBook

PHOTOGRAPHY: MIKE LAYE

Like most of Ive’s creations, Apple’s original iBook (which
itself looked a bit like a colourful designer toilet
seat) won awards aplenty, and
sold well. It was the
Number 1 consumer
portable for many
months after its launch
back in September 1999. We
loved its pixel-sharp 12.1-inch
active-matrix TFT screen with millions of
colours at 800-x-600-pixel resolution. We
adored its innovative handle, its full-size keyboard, AirPort
readiness, 300-466MHz G3 processor, and ultra-long
battery life.
But we did moan about its meagre RAM (expandable to
just 160MB) and the lack of any video-out port. But most of
all, we groaned under its 3.1kg (6.7 lbs) weight.
Now, with the all-new model, Apple has maintained or
improved the original iBook’s plus points and eliminated
the negatives.
The new iBook’s 12.1-inch active-matrix TFT screen
displays millions of colours at a greater 1,024-x-768-pixel
resolution. The handle has gone, but the size and weight
are down to allow easier under-arm carriage. The G3 is
more powerful at 500MHz, and RAM is expandable to a
maximum 640MB. Apple claims that battery life can reach
up to five hours – an hour down on the first iBook, but more
realistic. Apple’s even added an RGB Video Out port so that
you can mirror your work to an external display or projector.
It also retains the TV/VCR-ready AV port.
The addition of a second USB port is welcome. While
you could always add an inexpensive USB hub to the
original iBook (and still can with this one, of course), two
ports offer greater flexibility and portability.
The 10GB hard disk certainly isn’t huge, but should
suffice for most of its target market. If you need more
space, adding a hot-pluggable FireWire hard drive is easy
and not too expensive (an extra 10GB drive costs around
£230). Best of all, the new iBook weighs just 2.2kg (4.9 lbs)
– nearly a bag of sugar less heavy than the old iBook, and
0.2kg (0.5 lb) lighter than even the titanium PowerBook G4.
Weight to go That’s not to say that the iBook is as light
as a feather – indeed, at that weight you could feed two
with the whole chicken. It’s at the heavy end of the
subnotebook spectrum, with weeny Windows portables
getting as low as 1.7kg. Even Apple’s old PowerBook Duo
(1992-97) and PowerBook 2400 (1997-98; available only in
North America and Japan) weighed a little less. But none of
these little laptops offer/offered all the iBook does.

iBook vs Windows subnotebooks
Take Sony’s range of Vaio slim notebooks. Comparing like
with like, we’ll compare Apple’s iBook with the Vaio Z600 to
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start with. The
Z600 (same size
active-matrix
screen, 700MHz
Pentium 3; 64MB
RAM; 15GB hard
drive; and Windows
2000) weighs just
1.7kg (or 3.75 lbs),
which is half a kilo
lighter than the iBook.
However, to keep
its weight down to this
level, Sony has left out
the optical-media drive.
If you want a CD-ROM
drive, you’ll need to buy a
special docking station that not
only adds the difference in weight, but makes
it more cumbersome by including external extras. And,
right now, a CD-ROM is your only option. If you want CDRW, DVD-ROM or a combination of both, you must buy an
external, third-party drive – adding further pounds to both
weight and cost.
Where the everything-built-in iBook costs from £1,099
(inc. VAT), the Vaio costs a whopping £1,699 with 16x CDROM only. And its estimated battery life is just two-and-ahalf hours – half that of the iBook. To reach the iBook’s
battery charge life, you need to buy a spare battery to swap
in – you’ve guessed it, that means more cost (about £270)
and extra weight.
Sony does have a couple of laptops that beat the iBook
on price. The £880 Vaio FX101 (600MHz Celeron processor;
64MB RAM; 10GB hard drive; but no built-in ethernet;
Windows ME) even has a slightly larger screen (13.3 inches),
although its maximum resolution (1,024-x-768 pixels) is
the same as the iBook’s. This time, the 24x CD-ROM is builtin, but you’ll have to buy an external, third-party drive if you
want CD-RW or DVD. And the FX101’s battery life still lags
two hours behind the iBook’s, without any option of
swapping batteries between recharging. Oh, yes, it weighs
a fifth more than the iBook…
Sony’s other option is its quirky new £979 QR10 laptop
(650MHz Celeron; 64MB RAM; 10GB hard drive; Windows
Me), which has taken a note from Apple’s original iBook on
‘think different’ looks and its carry-handle. Like the other
comparable PC laptops, this is available with CD-ROM only.
Other failings include its 3kg weight (as heavy as the
original iBook) and 2.5-hour battery life.
Sony’s obviously consumer-targeted QR10 has
borrowed elements of Apple’s first iBook. The case looks
quite smart, and maybe less like a toy than 1999’s iBook –
although I think it looks like a giant metal pencil case.
Oddly, the keyboard is toy-like, and nothing like as smart as
either the original or new iBook.
Also, Sony equips its Vaios with 4-pin FireWire
connectors – so if you want to add external storage (like
LaCie’s PocketDrive), you have to add an extra power supply.
Macs boast the 6-pin connector that supplies power as well
as data. Portability isn’t just the weight of the machine, it’s
all the other stuff you have to carry round with you.

Consumer portable

iBook
(CD-ROM)
Manufacturer: Apple
(0800 039 1010)
www.apple.com/uk
Pros: Small; lightweight;
inexpensive; all the
connections you need; free
software, including Mac OS X;
smart looks.
Cons: Slowest iBook;
limited RAM and cache.
Price: (inc. VAT) £1,099
Star Rating: ★★★★/8.6

iBook
(DVD-ROM)
Pros: Small; lightweight;
inexpensive; all the
connections you need; free
software, including Mac OS X;
DVD video capability; smart
looks.
Cons: No speed merchant;
small cache.
Price: (inc. VAT) £1,299
Star Rating: ★★★★/8.7

iBook
(CD-RW)
Pros: Small; lightweight;
inexpensive; CD-RW
capability; all the connections
you need; free software,
including Mac OS X; smart
looks.
Cons: No speed merchant;
small cache; available from
online Apple Store only.
Price: (inc. VAT) £1,399
Star Rating: ★★★★/8.7

iBook
(DVD/CD-RW)
Pros: Small; lightweight;
inexpensive; CD-RW and
DVD video capability; all the
connections you need; free
software, including Mac OS X;
smart looks.
Cons: No speed merchant;
small cache.
Price: (inc. VAT) £1,599
Star Rating: ★★★★/8.7

page 79

Macworld JULY 2001

77

56KbpsM
odem

10/100
ethernet

FireWire

USB

VGA

Audio/Composite-Video Out (AV)

And don’t forget Apple’s AirPort (IEEE 802.11)
technology that gets you fast wireless networking and Web
browsing up to 150ft away from your phone line or
ethernet hub or router.
No compromise vs flexibility Like the PowerBook, the
iBook comes fully loaded: ethernet; CD, DVD, CD-RW or CDRW/DVD combo; USB; FireWire; modem; Video Out; AV, etc.
Adding all this stuff takes the Windows equivalents way
over the 2.2kg barrier. And the iBook costs a whole lot less.
Of course, there’s something to be said for the PC
laptops’ flexibility. If you don’t need an optical drive, Vaio
Z600 users can leave it at home or in the office, and lug a lot
less dead weight around. Apple doesn’t want to go down
this route, as it believes that none of its machines should be
“compromised”. In any case, for the money, Apple’s new
iBook is as light as any of today’s fully specified laptops –
and it’s not even Apple’s pro system.

iBook vs PowerBook
In fact, many Mac professionals will prefer the iBook to the
PowerBook. The PowerBook is super-fast and features super
video, but is it worth the weight?
Performance Creative pros should plump for the lump.
The PowerBook’s extra half a pound is certainly worthwhile
for the additional performance boost guaranteed by the G4
processor. Macworld Lab tests point to the 400MHz
PowerBook G4 being at least 22 per cent faster than the
new iBook, and the 500MHz PBG4 as 37 per cent faster. See
the above table “Mac portable performance” for more.
The latest PowerBook’s AltiVec-optimized G4 processor
counts for much of this extra oomph, but one of the new
iBook models really fell to the floor during our speed tests.

The iBook (with 64MB of RAM) took almost twice as long as
the 128MB iBooks to complete the Internet Explorer part of
the Speedmark test. This isn’t down to the rather limited
memory, as the older 64MB/466MHz iBook SE came in at
just under the score of the new 128MB/500MHz iBook.
Our tests revealed that one reason for the slower speeds
on the new CD-ROM drive is that it has a 128K buffer size
compared to the 512K buffer of the older drives. That all the
new iBooks (and those that preceded it) score around the
page 80

Consumer rival
Sony’s think-different QR10 Vaio
Windows notebook took lessons
from Apple’s first iBook, but also
weighs as much at 3kg.
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Actual size:
28.5cm wide

Actual size:
3.4cm thick
23cm deep

CD-ROM, DVD or CD-RW
Your choice of optical-media drive
comes down to what you want
to use your iBook for… and price.
There are two DVD-ROM and
DVD-Video options (one with
CD-RW as well), a CD-RW
model, and the entry-level
system that has CD-ROM only.
Because there are recordable
options, the drive is tray-mounted
– which isn’t as attractive and
safe as the PowerBook’s slotloading drive, but is pretty
robust all the same.
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same as 1999’s 350MHz iMac despite much faster G3 chips
is down to the simple matter of less cache. The older iMac
had 512K level-2 cache (for speedy storage of frequently
used data, to save the system constantly trawling for that
data between hard disk, RAM and processor); the iBooks
have half that amount, at 256K.
Clearly, the new iBook is no speed merchant, although
its performance should be ample for nearly all consumer
and education-oriented operations. But it is definitely not
for graphics or video pros. iMovie performance is fine; Final
Cut Pro’s isn’t.
Screen size While the iBook’s smaller screen size won’t
bother those who use Word and a Web browser as their
mainstays, graphics and video professionals will greatly
appreciate the PowerBook’s 15.2-inch widescreen display.
The iBook’s 1,024-x-768-pixel resolution is actually quite
spacious, but the PowerBook’s 1,152-x-768 supplies muchneeded space for those palette-crazy
applications.
If the native 1,024-x-768-pixel
resolution of the screen makes icons and
text too small for you, note that all
lower resolutions have to be created
via pixel interpolation – small pixels
emulating larger pixels – and the
results can be blocky and fuzzy.
Video The AV port lets you show
your movies and presentations to
best effect on a big-screen TV. If
you have one of the DVD iBooks,
you can watch your DVD movies
via the iBook as well. However,
if you want to watch a lot of
DVDs at home – on a long-haul flight is
another matter entirely – we’d recommend a
separate DVD player and home-cinema system.
The PowerBook’s S-Video output port is also superior to
the iBook’s AV port. S-Video separates information into two
signals: Chrominance (which separates colour
information); and Luminance (brightness). This prevents
colour bleeding and dot crawl, and increases clarity and
sharpness. For most of us, though, the iBook’s AV port will
easily be sufficient.
Memory Heavy-duty applications require a stack of
memory, as well as a G4 processor. The PowerBook comes
with at least 128MB of RAM, expandable to 1GB. The entrylevel iBook comes with 64MB of RAM, which really requires
an immediate upgrade to at least 128MB – especially if
you’re considering upgrading to Mac OS X in the near
future. (See “Extra value and extra costs” below).
Size With its smaller screen, the iBook can be a lot
littler than its pro sibling. In fact, the iBook is only slightly
larger than its (12.1-inch diagonal) screen. It’s 28.5cm wide
(compared to the PowerBook’s 34.1cm), and 23cm deep
(PB: 24.1cm). This makes the iBook even better than the
PB G4 for air travel work and play.

The PowerBook is skinnier, however: 2.6cm (1 inch) thin
compared to the iBook’s 3.4cm (1.35 inches). Due to the CDRW drive requiring a tray-loading drive, the iBook cannot
take advantage of the PowerBook’s thinner slot-loading
mechanism. (This is also the reason that Power Macs still
have the tray-loaded CD drive; so roll on slot-loading
rewriteable CD drives.)
Input/output
The iBook boasts the same full-size
keyboard and trackpad as the PowerBook, so there’s no loss
of comfort due to the tiny footprint. Two magnets at the
leading edge of the keyboard (closest to the screen) ensure
the keyboard is nice and firm, so there’s none of that
spongy nonsense you often get from laptop keyboards.
Above the keyboard, on either side, are built-in stereo
speakers. The sound is pretty good, and you can always add
Harman Kardon’s £139 SoundSticks (with iSub) for the full
iTunes audio experience at home.
Like the PowerBook’s, the new iBook’s trackpad is a lot
more robust and responsive than the original iBook’s. The
addition of a built-in microphone is also a bonus, although
a separate USB-based mic is still the superior option.
Sound
The iBook’s stereo speakers are a big
improvement on the original’s, and are even noticeably
clearer than even the PowerBook G4’s.

Optical media
The new iBook comes as just one G3 speed: 500MHz. The
options are all to do with memory (see above) and types of
optical-media drives. Your drive choice will also affect speed
(see above), but not by enough to worry you greatly.
The low-end model (£1,099 inc. VAT) has a CD-ROM
drive built-in. This should suit most users, but those who
want to watch movies on long-haul flights or even longerhaul short British train journeys should splash out the extra
£200 on the DVD-ROM model. As you’re likely to be on the
move a lot, you may find yourself in need of removable
recordable media for those situations when email and FTP
just won’t stretch. Here, Apple provides you with two
options. There’s a CD-RW model for £1,399, and a £1,599
CD-RW/DVD-ROM combo model that lets you watch (not
burn) DVD movies and record CD-RW and CD-R discs.
If there’s any chance that you’ll require a DVD system,
then go for either of the DVD solutions now – as Apple’s
software doesn’t support movies on external DVD drives.
You can buy the CD-ROM version and add an external CDRW (rather slow USB versions from around £200; better
FireWire versions from £269) easily enough. But internal is
always best for true portability, so stump up for the built-in
8-speed CD-RW if you possibly can.

Extra value and extra costs
Free software Every iBook will ship with both Mac OS 9.1
and OS X (previously on sale separately for £99) installed.
9.1 will be the default operating system, but you can boot
in X whenever you want to.
Consumers who just use iMovie, iTunes and AppleWorks
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(all of which have been optimized for OS X) could go with
the next-generation operating system fulltime if their
printer, scanner and other peripherals are also supported –
check with the manufacturers before going all-out X.
Of course, the iBooks also ship with Apple’s easy-to-use
iMovie 2 digital video editor, which works alongside a
camcorder’s FireWire (also known as i.Link and IEEE 1394)
connection. iTunes 1.1.1 is also free and bundled with the
iBooks. This digital-music jukebox software lets you make
MP3 playlists, rip music from CDs, and (with a CD-RW drive)
burn your own music CDs, as well as graphically visualize
the music as it plays. AppleWorks 6 is a suite of business
applications (word processor, spreadsheet, presentations,
database, graphics) that is also bundled, alongside Web
browsers and email clients from Microsoft and Netscape.
Cro-Mag Rally, Bugdom, Nanosaur are the free fun
games included alongside the more serious stuff.
Cables Unlike the PowerBook G4, the iBook doesn’t
come with a FireWire cable. Buying one of these costs about
£25. And the iBook requires a special £15 AV cable to
connect to your TV or VCR.
RAM If you buy the CD-ROM model, plan on buying at
least an extra 64MB of RAM (to take it to 128MB). This will
cost you £80 (inc. VAT) at the online Apple Store, but just
£28.50 from Crucial Technology (www.crucial.com/uk);
alternatively, call around the mail-order dealers at the back
of Macworld, making sure that you state that it’s for the
500MHz iBook.
The base RAM (either 64MB or 128MB) is soldered to the
logic board, leaving one free DIMM slot for adding extra.
This single free DIMM slot means you’re better off buying as
large a RAM DIMM as possible now rather than a 64MB one
now and having to replace that later with a larger one.
Crucial is offering a 256MB DIMM (to add to the 64MB or
128MB) for £122.

Design
Strength One of the strong points of the original iBook was
its robust casing, which had co-moulded rubber bumpers to
save its exposed edges from the usual knocks and bumps
consumers and students subject laptops to. Despite the lack
of rubber bumpers, Apple claims that this new iBook is
twice as durable as the old iBook.
The new case is made from “impact-resistant”
polycarbonate plastic. Inside, it’s further strengthened with
a magnesium frame, which adds sturdiness and reduces
weight. To give the iBook even greater “bump tolerance”,
Apple rubber-mounts the hard drive. As with the original
iBook, there are no protruding latches or levers to snap off.
Sadly, the handle has gone – but it’s fairly easy to tuck under
your arm when walking about, and now looks less like a
plastic handbag.
A primary hinge (see above) connects the top and
bottom of the case. The firm, thick hinge swings the screen
back and down, behind the computer’s back edge, which
lowers its overall height when open.

Apple’s new iBooks – they’ve got the lot
Model

Price
inc. VAT

PowerPC
processor

Base
RAM

Max
RAM

iBook 500 CD-ROM

£1,099

500MHz G3

64MB

iBook 500 DVD-ROM

£1,299

500MHz G3

iBook 500 CD-RW

£1,399

500MHz G3

iBook 500 CD-RW/DVD £1,599

500MHz G3

Hard
disk

USB
ports

Fire Ethernet
Wire

56Kbps Screen type
modem and size

576MB 10GB * 2

1

10/100

Yes

128MB 640MB 10GB * 2

1

10/100

Yes

12.1” TFT

128MB 640MB 10GB * 2

1

10/100

Yes

12.1” TFT

128MB 640MB 10GB * 2

1

10/100

Yes

12.1” TFT

12.1” TFT

* 20GB option available on online Apple Store, for an extra £169 (inc. VAT).

Looks Apple has whitewashed its fancy colour policy
with this new system. Its milky-white case is interrupted
only by a metallic-grey band that’s sandwiched between
the near-featureless top and bottom casing. There are a few
features to the otherwise minimal round-edged case.
There’s a glowing crystal Apple logo that sits the right-way
up when facing away from you, and a pulsing light sleep
light embedded in the central grey strap.
The colour (or rather lack of it) is reminiscent of the
now-discontinued Snow iMac. As a portable, it’s bound to
get scratched, but these don’t stand out as much as they
would have on a coloured plastic case.
The iBook also shares the same magnetic catch, and the
rounded metal release button.

Battery bonus
As with the original iBook, the
battery is mounted in the bottom
of the unit. But, thankfully, the
new battery is smaller and a lot
easier to remove via a single coin
screw instead of two. A series of
LEDs tells you at a glance how
much charge the iBook has left.

Macworld’s buying advice
The new iBook has real consumer
pulling power due to its lightweight,
cute case. And, unlike the old iBook, it
can also pass as a pro laptop. With
its fully ticked list of technical
specifications, the iBook is perfect
for people who want to start
making digital home movies,
playlist their own CDs and get
connected to the Internet – as
well as move their computer
around with them whenever
they want.
And the RGB video
output lets you mirror your
work to a larger external
display or projector,
when you based in your
home, school, or office.
Forget the hype
about cheaper, lighter
Windows equivalents –
none can match Apple’s
iBook on features per pound (both in cost and
weight). Graphics pros (and serious lightweight metal
heads) should still pay the extra for the speedier, largerscreened titanium PowerBook, but the rest of us should
praise the fact that, after years of waiting, we all now have
the option to go portable.
MW
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test centre: flat-panel monitors

Hi-res flats
Flat-panel LCD monitors assessed and rated.
By David Fanning

W

that feature, prices again started climbing,
and soon, flat-panels were prohibitively
costly. Well, it’s déjà vu all over again – as
Big Ron would say – because LCD displays
are better and more affordable than ever.
This is great news for everyone bar hardpage 84

PHOTOGRAPHY: MIKE LAYE

hen we ran the LCD flat-panel
round-up a couple of years ago,
prices were in freefall – so much
so that it seemed possible most future
displays made would be LCDs – and that
traditional CRT (Cathode Ray Tube) displays
were on the way out. However, soon after

All prices in this feature exclude VAT at 17.5 per cent
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15 inch

Apple 15-inch Studio Display Iiyama TXA3834MT

Maxdata Belinea 10 15 15

NEC MultiSync LCD 1530V

Samsung SyncMaster 150MB Sharp LL 1510A

ViewSonic ViewPanel VP150m ELO TouchSystems

If you’re suffering from
Cinema Display-envy, this
Studio Display is the more
affordable option – it’s now
only £449. Cube owners have
plenty of reasons to complete
the desktop décor with a
Studio Display. However, if
you want an LCD display
without the frills and leadingedge design, then you can
get something cheaper – but
not nearly as pretty.

While the 15-inch Iiyama just
misses out to others on being
the cheapest available screen,
it has many extras that the
NEC cheapie lacks. These
include a four-port USB hub
and speakers, as well as the
ability to pivot to portrait
mode. The only problem
is that the Apple Studio
Display is now £65 cheaper
– something that makes the
choice for you.

Plain, simple and to the point,
this 15-inch Belinea is much
the same as its larger
counterpart. It won’t win any
beauty competitions, but will
blend into most surroundings
with no trouble. Its frontmounted controls are simple to
navigate, but – like the Nokia
530L – its auto set-up function
failed to produce a perfect
picture. This was achieved only
with manual adjustments.

There’s no major difference
between this bargain £399
model and many of the others
at almost twice the price.
The Apple models and the
LG screen may have extra
features, but their image
quality and resolution is just
the same. It’s design may be
plain, but it’s the first time I’ve
seen an LCD that can compete
with a CRT on price. But Apple
is closing in on value.

The SyncMaster seems
overpriced for a 15-inch LCD
display – but the reason for
the extra outlay is its built-in
TV tuner. This means that,
during your lunch hour, you
can watch Neighbours while
you eat your lunch. For the
money the 150MB costs, you
could buy both a television
and a monitor, but you would
need a larger desk to hold
them.

The price of this quality
15-inch screen’s is
comparable with that of the
Apple 17-inch Studio Display’s
– but it doesn’t even come
close on specs or styling. If
you’ve a Studio Displaycompatible Mac, the choice
is a no-brainer. The Sharp isn’t
even a clear-cut choice for
owners of older Macs, as
there are cheaper screens
that offer the same specs.

This cost of this plain, 15-inch
screen that incorporates
speakers wouldn’t have seemed
high a few months ago – but
now it’s £200 more than the
NEC 15-inch model, and even
more expensive than the Studio
Display. However, one thing to
consider is that, with an LCD
price war widely expected (see
“IBM strikes while ion is hot”)
the ViewSonic may well come
down in cost.

Iiyama
TXA3834MT
15 inches
1,024-x-768 pixels
VGA
Four-port USB hub;
speakers
£515
Iiyama
www.iiyama.co.uk
01438 745 482

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Maxdata
Belinea 10 15 15
15 inches
1,024-x-768 pixels
VGA
None
£399
Maxdata
www.maxdata.co.uk
01344 788 900

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

NEC
Multisync 1530V
15 inches
1,024-x-768 pixels
VGA
None
£399
NEC
www.nec-monitors.com
0870 120 1160

Company
Model
Screen
Resolution
Connection
Extra features

Samsung
SM150MB
15 inches
1,024-x-768 pixels
VGA, S-video, RCA video;
speakers; remote control;
video inputs
£880
www.samsungelectronics.
co.uk, 0800 521 652

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Sharp
LL1510A
15 inches
1,024-x-768 pixels
VGA x2
Two-port USB hub
£699
Sharp
www.sharp.co.uk
0800 138 8879

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

ViewSonic
VP150m
15 inches
1,024-x-768 pixels
DVI, VGA
Speakers; pivoted screen
£599
ViewSonic
www.viewsoniceurope.
com 0800 833 648

Company
Model
Screen
Resolution
Connection
Extra features

❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 7

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 6
❚❚❚❚❚❚❚❚❚❚ 9

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 8
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 9

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 8
❚❚❚❚❚❚❚❚❚❚ 9
❚❚❚❚❚❚❚❚❚❚ 7

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 8
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 6

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 5

Image quality
Design/control
Value

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Apple
Studio Display
15 inches
1,024-x-768 pixels
ADC
None
£449
Apple
www.apple.com/uk
0800 039 1010

Company
Model
Screen
Resolution
Connection
Extra features

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 10
❚❚❚❚❚❚❚❚❚❚ 9
❚❚❚❚❚❚❚❚❚❚ 9

Image quality
Design/control
Value

Star Rating ★★★★★/9.1

Price
Contact

Star Rating ★★★★/7.3

Product scores
Bar-chart quality scores run from
0-10, and reflect specific aspects of
performance. Star Rating is an overall score,
encapsulating these individual scores, plus
any other factors relevant to your choice
of purchase.

Star Rating ★★★★/7.7

core designers, who are likely to stick with
CRTs come what may because of their
superior colour fidelity. LCDs can fall down
on colour-critical work because the viewing
angle affects the colours displayed. However,
with good hard-copy proofing, there’s no
reason at all why a decent-quality LCD can’t
figure in professional workflow situations.
Figuring what constitutes quality in
an LCD monitor is a tough task for the
uninitiated, because LCD displays are still
relatively uncommon compared to CRTs.
For this Test Centre, we secured 26 models
from 15 manufacturers. We tested them
head-to-head to determine which ones
most successfully produce the best blend
of price and performance.

Digital or analogue?
Unlike CRT monitors, LCD screens are digital
rather than analogue. Until recently, most
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Star Rating ★★★★/8.3

computers had only analogue output
to control CRT monitors. Now, desktop
Macs have acquired a digital output, but
in a format incompatible with most digital
screens – except, of course, Apple’s own.
This isn’t an insurmountable problem, as
there are adaptors available, but it adds
another level of complication.
While LCD screens are inherently
digital, they usually sport an analogue
connection so that they’re compatible
with the majority of computers. This year,
more screens than ever offer both a digital
and analogue connection.

Flicker of hope
Sorting out the wheat from the chaff is a
little different for LCDs than for CRTs. For
example, refresh rate – a good measure of
the capabilities of a CRT monitor – is entirely
irrelevant with LCD screens. Flat-panels
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Price
Contact

Star Rating ★★★★/8.3

Star Rating ★★★/6.4

don’t suffer from flicker, because the
image doesn’t scan down the screen as
it does with traditional monitors. Instead,
it appears instantly. Once a pixel is
illuminated on an LCD, it remains – as
opposed to fading after the cathode ray
has passed by. The result is a screen that
remains flicker-free, even at miserly refresh
rates of 60Hz.

Resolution
Resolution is also handled differently in flat
panels. There are a set number of pixels,
and, although you may be able to display
different resolutions, they must all be
translated into the native resolution. This
might work well enough with pictures, but
text will always look bad if displayed at a
resolution that isn’t the native one. If you

Star Rating ★★★/6.5

This model differs from all
others on test because it’s a
touch-screen display, making
it ideal for interactive-booth
installation. The software
needed an update – available
from ELO’s Web site – before
we got it working. Screen
quality is OK, but the touchscreen feature makes the
screen more reflective than is
desirable, making it
unsuitable for everyday use.

Price
Contact

ELO
Touchscreen
15.1 inches
1,024-x-768 pixels
VGA
Touch-screen;
speakers
£809
ELO
www.elotouch.co.uk
01793 573 344
❚❚❚❚❚❚❚❚❚❚ 6
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 7

Star Rating ★★★/6.9

IBM strikes while ion is hot...
BM has uncovered a cost-cutting
manufacturing process for LCDs
(liquid crystal displays). Traditional
LCD-manufacture uses velvet to align
liquid crystals on the substrate. The
polymer on the substrate is rubbed
with a velvet cloth, and when the
crystals are formed, they align
themselves with the direction the
velvet was rubbed. This method,
though, means that there is a high
failure-rate of screens.
The new technique involves aligning
crystal molecules inside flat-panel LCDs,
a principle called atomic beam

I

alignment (ABA). This involves a noncontact atomic-beam being used to
align the crystals. Instead of a polymer
substrate, the method relies on a thin
layer of carbon, which is bombarded
with ions, pushing aside many of the
surface carbon atoms.
ABA means IBM will begin making
higher-quality, higher-resolution LCD
displays next year. Because the failure
rate will be lower, prices should be
lower too.
IBM holds the patent for ABA, but
is likely to license the technology to
other manufacturers.
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17.4 inch

▲

17.3 inch

▲

▲

15.1 inch

LG Flatron FL885

Nokia 530L

Sony SDM-N50

Silicon Graphics 1600SW

Iiyama AS4431D

Taxan CrystalVision 780

ViewSonic ViewPanel VG175 LaCie Photon18blue

For the second time this year,
LG has surprised us with a
beautifully designed screen.
It’s elegant and has plentiful
additional features. The best
of these is the built-in TV
tuner. The Macworld Test
Centre is in a basement and
there’s no TV signal – but we
tested it on a video and it
worked well. One downside
is that the FL885’s auto set-up
feature was slightly off-mark.

The Nokia is nicely compact
and neatly designed. Its menu
system is easy to navigate,
although the auto-adjustment
feature did fail to produce a
perfect picture. This was only
achieved by fiddling with the
width and sharpness controls.
Although it has some
attractive extras – such as
built-in speakers – its price is
now out of step with the NEC
and Apple prices.

Although the SDM-N50 is a
year old, it still looks as fresh
and as high-tech as ever. The
screen-image on its ultra-thin
screen looks good from
any angle, and it is a viable
alternative to the Apple Studio
Display. The price has fallen
£300 from last year, but the
15-inch Studio Display has
dropped even further – making
it a no-contest until Sony drops
its prices even further.

Although this model is long
in the tooth, it holds up well
against the competition. Its
wide-screen format is great
for displaying video or
graphics apps that involve
a multitude of palettes. It
is compatible only with the
included Formac Proformance
III card. This is something of a
drawback, as the Proformance
is slower than the latest 3D
video-cards.

The Iiyama is dumpy
compared to some of the
supermodel screens on test.
However, for the price, you
get a full 17.4-inch screen
with 1,280-x-1,024
resolution, a four-port hub,
speakers, and video input.
It’s dull, but for the money,
offers much. But you could
save around £200 by buying
the slightly smaller 17-inch
Studio Display.

The 780’s 17.4-inch screen
offers the same amount of
pixels as its larger sibling –
the 880 – but in a smaller
space. Its price is lower too,
and, considering its identical
resolution, it’s a bargain
compared to the 880. The only
drawback is that, using its
high resolution, means
desktop icons become smaller.
The £200 saving on the bigger
model is worth every penny.

The ViewPanel offers simple,
well-designed controls on a
screen that sits in a cleanlooking light-grey case. It has
dual inputs that are easily
switchable – something that
should prove popular with Web
designers who own more than
one machine. This is a 17.4inch model, and compares very
favourably on price with the
cost of models in the 18.1-inch
category.

LaCie previously considered
the available LCD technology
insufficient for colour work –
but its LCD debut, the Photon,
is an excellent screen, and
even sports the removable
reflection-hood that its CRT
models sport. There will also
soon be a version of the
BlueEye calibrator available
for the Photon, giving
maximum colour-control
– a first for LCD screens.

Company
Model
Screen
Resolution
Connection

LG Electronics
Flatron FL885
15.1 inches
1,024-x-768 pixels
DVI, VGA SCART and
Video
TV tuner; remote control
£899
LG Electronics
www.lge.co.uk
0870 607 5544

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Nokia
530L
15.1 inches
1,024-x-768 pixels
VGA digital
Speakers
£649
Viewsonic
www.viewsoniceurope.com
0800 833 648

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Sony
SDM-N50
15.1 inches
1,024-x-768 pixels
VGA x2
Speakers
£799
Sony
www.sony-cp.com
08705 424 424

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

SGI
SGI 1600SW
17.3 inches
1,600-x-1,024 pixels
Digital
Proformance III card
£1,545
Formac
www.formac.co.uk
020 8533 4040

Company
Model
Screen
Resolution
Connection
Extra features

Iiyama
AS4431D
17.4 inches
1,280-x-1,024 pixels
VGA, DVI, video
Four-port USB hub;
speakers; video inputs
£895
Iiyama
www.iiyama.co.uk
01438 745 482

Company
Model
Screen
Resolution
Connection
Extra features

Taxan
CrystalVision
780TCO99
17.4 inches
1,280-x-1,024 pixels
VGA x2
Four-port USB hub
£949
Taxan
www.taxan.co.uk
01344 484 646

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

ViewSonic
VG175
17.4 inches
1,280-x-1,024 pixels
VGA x2
Pivot
£899
Viewsonic
www.viewsoniceurope
.com
0800 833 648

Company
Model
Screen
Resolution
Connection
Extra features

❚❚❚❚❚❚❚❚❚❚ 8
❚❚❚❚❚❚❚❚❚❚ 10
❚❚❚❚❚❚❚❚❚❚ 7
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Star Rating

★★★★/7.6

Star Rating

★★★★/7.9

Star Rating ★★★★/7.8

score

Extra features
Price
Contact

Image quality
Design/control
Value

Star Rating ★★★★/8.6

Star Rating ★★★★/7.2

Star Rating ★★★★/8.4

Star Rating ★★★★/7.5

are used to seeing icons at a particular size
on a CRT, you may be in for a shock with
an LCD. Because traditional monitors have
variable resolutions, you can change this to
suit your preference. If, however, you’re an
early adopter of Mac OS X, then this is not
a problem, as OS X allows icons to be
resized to your requirements. The simplest
thing to do is pay for the biggest screenresolution you can afford. If your eyes aren’t
up to looking at tiny icons, then go for a
larger screen – or perhaps try out OS X.

Size does matter

Spike lean
LG’s Flatron can either rest on the spike at the back, or with the spike in a stand. Either way, it looks fantastic.
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Screen size is one thing that is easier to
understand with flat panels than CRT
displays. With traditional displays, the size
of the tube is what the model will be sold
on – with the actual viewable-area size
appearing only in small print. LCD displays
give you only the diagonal screen-

Search Macworld’s Reviews database online (www.macworld.co.uk), updated throughout the month.

Price
Contact

Star Rating ★★★★/8.3

Price
Contact

measurement, so only the viewable area is
measured. When comparing LCD with CRT
sizes, be sure to compare the viewable areas.

A question of control
When a digital display has an analogue
input, there will be some tweaking involved
to line-up the image with the correct pixels.
Without this tweaking, greys and fine
vertical-lines can become noisy and distort
text. Many screens have an auto-adjust
feature to take care of this, although
sometimes you can do a better job by doing
it manually. Consequently, good adjustment
controls – particularly for this feature – are
important.

Colour critical
Apple claims its screens are fine for high-end
colour work, but only recently have there
been tools to accurately calibrate LCD

Price
Contact

LaCie
Photon18blue
18 inches
1,280-x-1,024 pixels
VGA, DVI-to-ADC
Hood; BlueEye colour
calibrator to follow.
£1,499
LaCie
www.lacie.com
020 7872 8000
❚❚❚❚❚❚❚❚❚❚ 9
❚❚❚❚❚❚❚❚❚❚ 7
❚❚❚❚❚❚❚❚❚❚ 7

monitors. So, how do LCD screens compare
to CRTs for colour accuracy?
The theory that LCDs are better than
CRTs for colour pivots on the fact that they’re
much brighter. An uncalibrated LCD such as
the Cinema Display has luminance of 180
candelas, compared with a CRT – such as the
LaCie electron 22 – which outputs a white
luminance of 158 candelas. The Barco range
of CRTs are set to a conservative 75 candelas,
though Barco claims to be able
to hold this calibrated state for three years.
Calibration by necessity lowers the raw
output of a screen, be it LCD or CRT, and the
Cinema Display was dramatically reduced
in brightness to 108 candelas. The LaCie
electron went down to 103 candelas, but,
because the blacks on a CRT screen are
darker than with an LCD, the contrast range
is comparable.
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specs

buying advice

design

22 inch

▲

19.6 inch

▲

▲

18.1 inch

Eizo FlexScan L675

Maxdata Belinea 10 18 10

NEC MultiSync LCD 1850DX

Nokia 800 Pro+

Sharp LL-T1810SA

Taxan CrystalVision 880

Eizo FlexScan L771

LG Electronics Flatron 22

This 18.1-inch screen offers
a much thinner border than
most of the other screens on
test, making for a noticeably
smaller case. The swivelaction screen can be twisted
for portrait viewing, and it
has dual digital-connections
that can double as analogue
connections. Add to this the
fact that the auto-settings
button works perfectly, and
you’ve got a top flat panel.

Another light-grey cased
screen that is simplicity itself.
However, this 18.1-inch screen
offers the same resolution as
the 17.4-inch models, so you
don’t get any extra screen realestate. In light of this, the cost
of that extra inch is quite high,
but not as high as most of the
other 18.1-inch models. If you
need the extra inch, this is a
fair choice from the 18.1-inch
category of flat-panels.

Functionally, this model is
similar to the Eizo 18.1-inch
model. It has dual inputs,
either of which can be used
in digital or analogue mode.
It also shares the same narrow
border, which makes for a
smaller, neater screen, and has
the ability to swivel. The only
real difference is that its
software support is a bit flaky.
Otherwise, it is an excellent
and well-presented screen.

At 18.1 inches, this screen is
the big brother of the 503L. It
looks the same as the 503L –
boasting a wheel-controlled
menu for settings – and
also incorporates a USB
hub and front-mounted
speakers. Although its price
is reasonable compared to
most 18.1-inch screens with
dual digital-inputs, a 17.4-inch
screen still offers similar
specs at a much lower price.

The T1810 is a luxuriously big
screen, yet looks “light on its
footprint”. The styling is clean,
if not head-turning, and it
offers a built-in two-port hub.
This adds to the clean lines,
by discreetly connecting your
mouse. One thing that most
18.1-inch screens include that
this model lacks is a digital
interface. This would be a
useful addition. The price is
high, considering the features.

The CrystalVision’s cabling is
hidden neatly at its rear,
adding to its sleekness –
although packing them in to
the tight allotted space was
not plain sailing. The controls
worked well and the dual-input
will win it many Web-designer
friends who use two machines
on the same desk. The price
is good for a screen this size.
The USB hub makes it
convenient, as well as neat.

This is a big screen, offering
a whopping 19.5-inches of
screen-space, and a 1,600-x1,200-pixel desktop. This is the
equivalent of a 22-inch CRT
monitor. However, unlike a CRT
of this size, there’s no blurring
in the corners or convergence
problems. As one of the few
screens that out-performs many
CRTs on large, high-resolution
images, it’s a worthwhile – if
expensive – purchase.

The new 22-inch Flatron is the
first flat-panel monitor to rival
the Apple Cinema Display in
size. It also sports matching
speakers that stand either side
of the deliciously designed
screen. If both the Cinema
Display and the Flatron were
the same price then they
would be neck and neck.
But there’s a £1,000 price
difference – and no amount of
fancy design can justify that.

Company
Model
Screen
Resolution
Connection
Extra features

Eizo
L675
18.1 inches
1,280-x-1,024 pixels
DVI/VGA x2
Four-port USB hub;
speakers; screen pivot.
£1,439
Eizo
www.eizo.co.uk
01483 719 500

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Maxdata
Belinea 10 18 10
18.1 inches
1,280-x-1,024 pixels
VGA, video
Speakers
£1,099
Maxdata
www.maxdata.co.uk
01344 788 900

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

NEC
Multisync 1850DX
18.1 inches
1,280-x-1,024 pixels
DVI/VGA x2
None
£1,649
NEC
www.nec-monitors.com
0870 120 1160

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Nokia
800 Pro+
18.1 inches
1,280-x-1,024 pixels
VGA digital
USB hub; speakers
£1,749
Viewsonic
www.viewsoniceurope.com
0800 833 648

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Sharp
LL-T810SA
18.1 inches
1,280-x-1,024 pixels
VGA x2
Two-port USB hub
£1,899
Sharp
www.sharp.co.uk
0800 138 8879

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Taxan
Crystalvision 880
18.1 inches
1,280-x-1,024 pixels
VGA x2
Four-port USB hub
£1,149
Taxan
www.taxan.co.uk
01344 484 646

Company
Model
Screen
Resolution
Connection
Extra features

Eizo
L771
19.6 inches
1,600-x-1,200 pixels
DVI/VGA x2
Four-port USB hub;
speakers
£2,229
Eizo
www.eizo.co.uk
01484 719 500

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

LG Electronics
Flatron 22
8 inches
1,600-x-1,024 pixels
DVI, VGA and video
Speakers
£2,799
LG Electronics
www.lge.co.uk
0870 607 5544
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Star Rating
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score

Price
Contact

Image quality
Design/control
Value

Star Rating ★★★★/8.2

Star Rating ★★★★/7.8

Star Rating ★★★★/7.6

Contrast is pretty much the same,
though blacks are a little dusty on LCD
screens. Colour accuracy tests show the
CRTs ahead on this score. Faithful colourreproduction is still something that CRTs
hold sway on.
Colour is also less uniform on LCD
screens than on CRTs, blighted by light
and dark patches. This is because LCDs must
be lit with a light source, while CRTs create
the light and colour with the same light
source. Quality on cheaper LCDs also suffers
when viewing the screen from an angle,
whereupon the colours change. It’s less of
a problem with modern LCD displays, but
can still make a difference with colourcritical work.
Before you throw your hands up and
your flat panel out, there’s another matter
to consider. Are you one of the elite that
regularly calibrates your monitor? If so, then
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Star Rating ★★★★/7.5

you’re in a small minority that takes colour
seriously. If, like most people, you performed
an initial calibration with the Monitors
Control Panel – and do so once a year – then
the minor inaccuracies of an LCD screen will
be no hardship for you. Lots of people seem
to want colour calibration, but relatively few
use it. So, unless you actually use calibration
properly, don’t worry that LCD isn’t good
enough for you.

The price is right?
The price of LCD panels is as volatile as RAM
prices. Presently, prices are as low as they
have been – and analysts are widely
predicting a further flat-panel price war.
As with all volatile markets, you need luck
when making a purchase: if you buy now,
prices may continue to fall through the floor;
if you hesitate, they may go through the
roof.

Search Macworld’s Reviews database online (www.macworld.co.uk), updated throughout the month.

Star Rating ★★★★/7.5

Additional features
There are important features with LCD
screens that are not easily compared. For
instance, the LG and the Samsung 15-inch
screens have built-in TV tuners. This is
fantastic if you want them, but useless if
you work in a basement with no TV signal.
Other more common bonus features include
speakers and USB hubs. Speakers are always
handy, although sound quality is unlikely
to match a pair of good external speakers,
such as harmon kardon’s SoundSticks. But
compared to the Mac’s weedy internal
speaker, it’s likely to be an improvement.
A USB hub is a helpful feature. A two-port
hub is just enough to connect a keyboard
and mouse. If the screen houses a four-port
hub, you’ll be able to connect extra gadgets,
such as a Palm cradle or printer. Although a
four-port hub costs only about £30, it does
mean having more gadgets on your desktop.

Price
Contact

Having a hub built into your monitor keeps
cable clutter to a minimum.

Can your office justify the expense?
Although still pricier than CRTs, there are
two good reasons why flat-panel displays
are a good idea for offices. Heat output
is one. A large CRT monitor can get pretty
warm, and an office full of them will end
up feeling like a sauna, unless the airconditioning is cranked up. Flat-panel
displays use up to 60 per cent less energy,
making for a cooler office and considerably
lower electricity bills.
Space is another issue. A 22-inch CRT
will swamp most desks, but even a big LCD
screen leaves plenty of elbow room. An
office full of LCDs can mean being able to fit
more people into the same space – thus
keeping the accountants happy.
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editors’ choice

▲

▲

22 inch

Port-tastic
Apple’s dual-USB ports
means peripherals can plug
straight into the display.

Apple Cinema Display
The daddy of all flat-panel
displays. It does have some
quirks – not least that it works
only with Macs equipped with
an Apple Display Connector
(ADC). Although this is good
for excluding PC users from
our lovely Apple designs, it
also excludes those with a Mac
older than about a year. Its
price may have fallen, but it’s
still pricey. But nice things cost
money.

Company
Model
Screen
Resolution
Connection
Extra features
Price
Contact

Image quality
Design/control
Value

Apple 17-inch Studio Display

Apple
Cinema Display
22 inches
1,600-x-1,024 pixels
ADC
Two-port self-powered
USB hub
£1,799
Apple
www.apple.com/uk
0800 039 1010

Company
Model
Screen
Resolution
Connection
Extra features

❚❚❚❚❚❚❚❚❚❚ 10
❚❚❚❚❚❚❚❚❚❚ 9
❚❚❚❚❚❚❚❚❚❚ 7

Image quality
Design/control
Value

❚❚❚❚❚❚❚❚❚❚ 10
❚❚❚❚❚❚❚❚❚❚ 9
❚❚❚❚❚❚❚❚❚❚ 10

Star Rating

★★★★★/9.3

Star Rating ★★★★★/9.0

Price
Contact

Apple
17-inch Studio Display
17 inches
1,280-x-1,024 pixels
ADC
Two-port self-powered
USB hub
£699
Apple
www.apple.com/uk
0800 039 1010

With its recent price cuts and a new 17-inch
Studio Display, Apple has captured stealthily
the LCD market for Macs. The 15-inch Studio
Display is great – and, although now cheap
enough for most people to afford, is too
small for graphics pros. They are more likely
to go for the 22-inch Cinema Display – but
at £1,799, hardly anyone else will. The new
17-inch Studio Display is a perfect halfway
house, slotting neatly into a large market. It
not only competes with most other 17-inch
LCDs on price, but beats them hands down,
being £200 cheaper than the nearest model.
Even though it’s almost half an inch smaller
than the 17.4-inch class, the difference is
minimal – and certainly worth the £200 saving.
On top of this, it’s cool looking – with all the
class of the Cinema Display, but in a slightly
smaller package.
It has enough screen real estate to
accommodate most desktop furniture. In fact,
the chances are that it offers more room than
your current CRT display. Even if you have a
22-inch CRT, a resolution of 1,280-x-1,024
pixels isn’t always very crisp. On the 17-inch
Studio Display, though, the same resolution is
always crystal clear.

Macworld’s buying advice
With so many excellent monitors, it’s hard
to choose clear winners, though Apple has
done well. We tested no bad screens as
such, although a few are overpriced.
Due to the latest round of price cuts
Apple is now the leader of the LCD pack.
The Studio Display has always been a thing
of beauty, but now that its price has fallen
to the point where it’s in the same price
band as its 15-inch competitors – meaning
they don’t stand a chance. It may still be
a bit more expensive, but if you can afford
this, you’d be a fool to miss out. The only
drawback with the Apple screens is their
ADC (Apple Display Connector) connection.
ADC carries both digital and analogue video
signals, USB and control signals, and power
for the 17-inch Apple Studio Display, the
15-inch flat-panel Apple Studio Display, or
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the 22-inch Apple Cinema Display. But this
isn’t a problem if you have a new Mac.
At the other end of the scale, the
Cinema Display is still the best-looking
screen on the planet. The price has come
down for this model too – now it’s a mere
£1,799. A runner-up was the 19.6-inch
Eizo, which has an even-higher resolution.
However, even though it’s a great screen, it
just can’t compete on looks, and the price is
already out of step with the rest of the big
screens.
Mention should also be made of the two
TV/LCD models – the LG and the Samsung.
These are of an excellent quality and are
extremely well designed. Their TV capability
will appeal to many. The bottom line,
though, is that there are no bad flat-panel
displays – only bad prices. Comparative
shopping will unearth a bargain. MW

Inside the OS X extras
pple has provided not only a
completely new operating system but
also a collection of new applications
and utilities to show it off. Like the MacPaint
and MacWrite programs on the earliest Macs,
the new Mac OS X applications exist as much
to demonstrate the promise (and polish) of
OS X as to do their primary jobs.
Take the Clock application. Despite its
location in the Utilities folder, its actual utility
is debatable. After all, if you want to know
what time it is, you need only glance at the
right side of the menu bar. But when you adjust
the transparency of Clock’s analogue display
so that it floats faintly over a document
window without obscuring your work, the
elegance of OS X’s Aqua interface is undeniably
apparent. A similar claim can be made about
the updated Stickies application. No, the world
hasn’t been clamouring for a better, prettier
Stickies app, but this one sure looks cool.
Given the resources Apple surely invested
just to get the first version of OS X out
the door, it’s a little surprising that apps
as non-utilitarian as Clock or as inessential
as the Chess program were included at all.
But most of Apple’s OS X applications serve
more practical needs. Console, Process Viewer,
Terminal, and NetInfo Manager, for instance,
help Unix and network geeks get their work
done. Internet Connect, Grab, QuickTime
Player, Image Capture, Calculator, and TextEdit
take care of basic functions – often far more
elegantly than their predecessors. Showing its
commitment to open-source standards, Apple
includes Applet Launcher (for Java applets), too.
Here’s a look at the most-important
applications that come with OS X. And to help
you get some OS X dirt under your nails while
you wait for Carbon apps to appear later this
year, we’ve also included some tips on using
them.

A

Address Book
For Apple to call Address Book an application
is somewhat misleading. This is not what used
to be called, in pre-handheld days, a “personal
information manager,” or PIM. Address Book
is not what you’ll use to address your holiday
newsletter or to keep track of birthdays. Rather,
Address Book is like a part of Apple’s Mail
application (see Mail review, page 98) that has
been split off into its own app – like Joanie
Loves Chachi was spun off from Happy Days.
Every email program has some kind
of address book where you can keep
a list of email addresses that you
frequently use. Address Book provides
that functionality in stand-alone
form. Its primary purpose at present is
to provide address-book functionality
to Mail, but there’s no reason it couldn’t
work with other email programs or interact
directly with your handheld in the future.
Address Book supports the vCard specification
for personal information – a standard endorsed
by everyone from Microsoft to Palm.
Address Book lets you save individual
addresses as vCards, essentially electronic
business cards. They can be sent (by email
or IR beam) as files and then imported into
applications such as Address Book by dragging
and dropping.
Putting it in contacts When you open
Address Book, a window lists all of your
contacts. This view lets you see only each
contact’s name, phone number, and email
address. To view more information, you must
open a contact’s record.
There are two easy ways to add contacts.
One is to import them from a tab-delimited
list. If you keep email addresses in a PIM such
as Palm Desktop, it’s easy to save your contacts
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Get the scoop on five useful
applications that come with
Apple’s new operating system.
By James Bradbury,
Brett Larson and John Rizzo
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Desktop business cards
Want to put a vCard on your desktop? Simply grab the
head icon next to the contact’s name (top), and drag it
to the desired spot (bottom).

in a text file and then use Address Book’s File:
Import command. If you want to import
addresses from a different email program’s
address book, things might get trickier. Check
out the eMailman Web site (http://emailman
.com/conversion/#addrmac) for tips on importing
address books from various programs.
The other approach is to use Address Book’s
Add Sender Command (⌘-Y) to quickly add a
bunch of email addresses. Say you have a folder
of saved messages from your friends. Select
them, and redirect them to yourself from
within your email program. (Don’t forward
them or they’ll be sent to you from yourself.)
Send these messages; then quit your email
program before it has a chance to check your
mailbox. Log on to OS X’s Mail program to
receive the messages that you just redirected
to yourself. Select them, and press ⌘-Y.
Address Book has a few other cool tricks,
as well. To put a vCard from Address Book onto
your desktop, click on the address’s head icon
and drag the vCard to where you want it (see
“Desktop business cards”, left).
If you receive a vCard that you’d like to
add to Address Book, double-click on the vCard,
and it will open in the Address Book application
– with a button that allows you to add it.
Every vCard has a field for a picture. It’s
simple to add a photo to this field: you just
drag-&-drop a JPEG, GIF, TIFF, PNG, or PDF
file. Apple says you’ll get the best results using
a file that’s 64-x-64 pixels, but you can get
acceptable results with photos nowhere
near that size or proportion, as the following
example illustrates.

1 First, create a new contact record in Address Book.
2 In the Name fields, enter Andy Ihnatko (Macworld
columnist and beloved industry figure).

3 Enter Andy’s email address: andyi@world.std.com.
This step is essential, because without an email address,
a record cannot contain a picture.

4 Using Microsoft Internet Explorer, visit www.andyi.com.
5 Scroll down to the “unnaturally flattering” photo of Andy;
click and hold the mouse on it to download it. Save it to
the desktop for easy access.

6 Quit Internet Explorer.
7 Drag the photo from the desktop to the Picture field on
the address record you just created. Once Andy’s face
appears in the field, you can click on Save. Andy Ihnatko’s
name, email address, and photo should now appear in
your Address Book.

Adding a photo to a record has one
immediate benefit: every time you get a
message in OS X’s Mail application from that
email address, the person’s photo will appear in
the upper right corner of the Address Book
window.
Of course, to test our example you’d have to
get an email from Andy Ihnatko; fortunately,
he’s a prolific correspondent.
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Terminal
Before 1984, most
computers used what was
essentially a “terminal”
interface. You may remember
it well: the blinking orange
cursor waiting for you to type
something such as C:// on a black screen.
The Mac changed all that, as the first personal
computer to have a GUI (graphical user
interface). So it may seem odd that Mac OS X
includes Terminal, an application that lets you
access the Unix command line underneath the
interface.
Why would Apple catapult us back to the
early eighties? Well, even though you’ll be just
fine if you never venture beyond OS X’s Aquified
programs, you can do much more with OS X by
taking control of the command line. You can
use OS X’s built-in suite of Unix commands to
perform a wide range of tasks, from finding
hidden files to deleting files you’re unable to
put in the Trash.
But you don’t have to limit yourself to the
commands under OS X’s hood. The Internet
abounds with Unix applications that you can
compile and run from the command line. For
instance, you can use pine (a popular textbased email client) and mmap (an application
that scans IP addresses for open ports, helping
you find security holes in your network). You
can also use the command line to create shell
scripts (similar to AppleScripts) that enable
your Mac to perform tasks such as copying
a set of files to a removable disk and then
compressing them. Using a script with
the Unix cron command – which lets you
schedule system functions such as copying
or synchronizing files – you can even have
your Mac run scripts in your absence.
Hey, good looking Before you dive into
using the command line, you may want
to try customizing Terminal’s appearance.
For example, you can change the size of the
Terminal window if you want to see more
or longer lines of text than are visible in the
default setting, 80 by 24 characters.
Simply go to Terminal’s Preferences dialog
box and click on General to get to the windowsize options. Keep in mind, however, that if
you access a computer remotely, Terminal will
use the standard 80-by-24-characters setting
on the remote display. The result could look
rather odd.
You can also go for a whole new look by
customizing the font and background colours
of the Terminal window. You do this from
within the Colors and General panels in
the Preferences dialog box (see “Terminally
beautiful”).
Perhaps a more useful trick is making
the Terminal window semi-transparent, so you
can see other applications while you’re using
Terminal. To adjust transparency, type defaults
write com.apple .Terminal TerminalOpaqueness
0.4 in the command line: 0.4 is the level of
transparency; the higher the number, the more
opaque Terminal’s window. One limitation is
that all you’ll be able to see through it are your
Carbon and Cocoa applications.
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Grab
Grab is a simple program that
performs an essential task:
capturing screen images as
TIFF files. Apple no doubt had to
create Grab so that the developers
working on OS X applications could
illustrate on-screen help and instructions.
The program is useful for the rest of us, too,
since it offers an easy way to quickly grab lowresolution images off the screen. And Grab has
a couple of nifty features that far outstrip the
old keystroke combinations of early Mac OS
iterations: for instance, you can choose the
cursor you’d like to appear in your screenshot,
take timed shots, or choose a portion rather
than the entire screen.
Grab is also one of the applications that
appears as a service in other applications.
To see how this works, open the TextEdit
application from the Applications folder.
Type in some text, and then choose Services:
Grab: Selection from the TextEdit menu. After
you select a portion of the screen as directed,
Grab inserts it into your text window.

NetInfo Manager
NetInfo Manager is a powerful administration
tool, but it’s not for the average user. If you’re
a system administrator, or if you’ve had
experience managing Unix computers that
used the NetInfo Database or Mac OS X Server,
you’re a prime candidate for putting
this application to work.
You use NetInfo Manager
primarily to perform Unix
administration tasks. You
can use NetInfo Manager
to mount NFS directories, for
instance (Network File System
is a Unix file-sharing standard
for localnetworks). Since OS X stores
user and password information in the NetInfo
database, you can also use NetInfo Manager
(instead of System Preferences) to make
changes to user accounts. If the database is
shared on a network, you can administer user
accounts on multiple Macs and Unix machines.
Are you ready for your Mystery App?
There’s nothing Mac-like about the NetInfo
database, and the NetInfo Manager utility
is only remotely Mac-like. Making changes
in this application – such as selecting
an item and pressing the delete key –
can cause damage and even make OS X
unusable on your Mac. Be sure you know
how to use this program before opening it.
It’s not easy to obtain help in using
NetInfo Manager. Don’t even bother looking
to the Help menu, which will tell you only,
“Help isn’t available for NetInfo Manager.”
Fortunately, you can access information
from the Unix command line. Open Terminal
(Applications: Utilities), and type the command
man netinfo in the Terminal window. This
will bring up a Unix manual (circa 1990) that
defines the various aspects and parameters of
the NetInfo database. In order to scroll through
the manual, just press the return key. When the
percentage displayed at the bottom of the

Terminally beautiful
Get in touch with your inner geek – change Terminal’s look by using green Monaco text on a black background
(think Apple II).

Terminal window reaches 100, you have
reached the end of the document.
Getting into NetInfo Manager Except
for its Aqua interface, this NetInfo Manager
is the same as the Mac OS X Server version.
The top half of its main window consists of a
Directory Browser that looks like the Finder’s
column view. However, NetInfo directories
are not folders in the file system but subgroups
of the database. When you click on a NetInfo
directory, the bottom portion of the NetInfo
Manager window will display Property
fields and a corresponding value.
You can edit the field names and values
or create new directories. To edit them, click
on Users and then on a user name. This will let
you see and edit the user’s name, short name,
password, password hint, and other attributes.
Power troubleshooting If you need
maximum control over a system so you can
do low-level Unix troubleshooting, log in to
NetInfo Manager as the root user. This will
give you access to every folder in OS X – even
the invisible ones. (Unless you’re sure of what
you’re doing, though, skip this trick; it gives
you so much control that you can endanger
your entire system.)
To log in as the root user, click on the
padlock icon in the lower left portion of the
NetInfo Manager window, and type in your
administrator password (the password you
chose when you installed OS X). Now go to
the Domain menu, select Security, and choose
Enable Root User from the submenu. Create
a password for the root domain, and you’ll
be able to log in as the user Root.

The key to change
You can use NetInfo Manager to make changes to Mac
OS X user names, passwords, and hints; all are stored
in the NetInfo database.

More X in basket
The extra applications that come on the Mac
OS X installation disc are certainly not the
be-all and end-all of what we can do with this
new operating system. Instead, they simply
whet our appetites for the feast that will be
available in the Mac’s near future.
OS X’s Mail reviewed, page 98
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Bundled OS X email program

Mail
Publisher: Apple (0870 600 6010)
www.apple.com
Pros: Nicely integrated with iTools;
flexible mail-composition; many
formatting options.
Cons: Buggy; limited by Address Book;
weak mail filtering; inadequate help
files.
Price: Free with Mac OS X
Min specs: Mac OS X
Star Rating: ★★/4.5

ac OS X’s commitment to
the Internet is one of its
most appealing features,
from the Apache Web server under
the hood to the inclusion of iDisks in
the Finder. Most people use the
Internet primarily to send email, so
Apple’s Mail 1.0, included with OS X,
is welcome, especially as one of the
few native Mac OS X (or Cocoa)
applications available in these early
days. Unfortunately, the first version
of Mail has many drawbacks and
outright bugs, making it unsuitable
for heavy use.
The program includes
most of the features
you would expect
in a modern mail
application. It supports
multiple email accounts,
of which any can be POP,
IMAP, or Unix. You’ll also find
a Rules feature, for filtering mail
based on criteria you select; support
for multiple signatures; and the ability
to create and view messages with
images and Rich Text formatting.
Converting from other mail programs
is easy; Apple has made a set of
unsupported AppleScripts, available
on its Web site, that let you import
messages from Microsoft Entourage
and Outlook Express, Qualcomm
Eudora, Netscape Communicator,
and Claris Emailer.
As part of the initial registration
of Mac OS X, you’re asked to enter
or create an iTools account, which
includes a mac.com email address.
(You can also choose to add other
mail accounts during setup). The
installer conveniently sets up your
mac.com account in Mail as part of
this process, so you’re ready to send
and receive email as soon as you’re
up and running with Mac OS X.
If you skipped entering your iTools
information during installation,
Mail can still set up your mac.com
account for you. Just open System
Preferences, click on the iTools tab,
and enter your iTools user name and
password; then click on the Email tab

M
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Pretty on the outside
Mail, which is free with OS X, looks great – thanks to the Aqua interface. However, it needs more depth and better stability.

and select the Use iTools
Email Account option.

Making and
reading mail
Mail lets you compose
email messages in one of
two formats: plain text and
Rich Text. The first is text with no
fancy formatting. Rich Text adds
formatting tags to text, allowing you
to add fonts, font styles, and inline
images. Rich Text is similar to HTML;
however, Mail cannot create email in
HTML format. Rich Text conforms to
the Internet mail-format for enriched
text and can be read (with varying
degrees of accuracy) by programs
such as Eudora and Outlook Express.
Some older email programs can’t
handle Rich Text; those programs will
show the formatting tags in the
message body and turn embedded
images into attachments. Mail’s Rich
Text is not the same as Rich Text
Format (RTF), a document interchange
format created by Microsoft (and also
the native format of OS X’s TextEdit).
Using Mail to compose messages
is easy and enjoyable. Mail uses
Apple’s Address Book application for
addressing; addresses automatically
complete as you type them, or you
can drag and drop addresses from
Address Book into your new message
form. One annoying drawback is that
if a contact has more than one email
address listed in Address Book, Mail
can access only the first address. You

can work around this by making
another address record for each email
address, but there’s no way to define
an email address as the primary one
for a person. Spelling mistakes are
underlined as you type, and you can
fix errors simply by clicking on a
contextual menu item. And of course,
as a Cocoa program, Mail takes full
advantage of OS X’s gorgeous text
styling and rendering, with the full
palette of antialiased fonts, styles,
and text colours available.
Mail displays incoming email that
was created in plain text, Rich Text,
or HTML formats. Unfortunately,
the HTML mail display is buggy;
sometimes inline images fail to
display when you first view the email
message. If you switch to another
message, then back to the first one,
the images load properly.

Deficient in the details
Good filtering is an essential feature
for email programs (especially to help
keep the flood of spam out of your
in-box), but here Mail falls short.
The range of filtering criteria is too
small, and you can filter only by
one criterion per rule. Mail also
lacks some useful features you
can get in other programs, such as
Outlook Express’s Junk Mail Filter,
or Eudora’s text-formatting plug-ins.
You’ll quickly run into some of
Mail’s limitations. For example, you
can search only one mailbox at a time,
and you can’t redirect incoming mail.

Overall performance wasn’t especially
snappy on a 400MHz Power Mac G4
with 256MB of RAM; like much of
OS X, Mail just feels slow, especially
when opening mailboxes with many
messages or resizing windows.
If you need assistance, you
probably won’t find it in Mail’s
abysmal help files. Far from
comprising a good tutorial or
reference, they supply only the
smallest amount of information,
and they fail to explain many of
Mail’s features altogether.
Given the importance of
email, you would expect Mail to
be practically bulletproof, or at
least immune to simple crashes.
Unfortunately, this is not the case.
The program unexpectedly quit
many times during my testing, and I
discovered a reliable way to crash it:
simply double-clicking on a particular
spot in the mailbox list.

Macworld buying advice
That it’s free is one argument in
favour of using Mail, but when
you consider Mail’s problems, this
argument may not prove strong
enough. You can readily get free
versions of other, better mail
programs, and no one likes a program
that crashes. Until Apple fixes Mail’s
bugs and addresses at least some
of its shortcomings, you’re better
off sticking with Qualcomm Eudora
or Microsoft Outlook Express.
Tom Negrino
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How to:

web

Flash 5
expert
guide
Use Flash 5 to add oomph to
Web sites. By Philip Karmen
here’s no doubt that Macromedia
Flash has helped create some of the
most memorable sites on the Web.
No other program delivers such
attractive animation, engaging interactivity, and
synchronized sound. So, it’s a shame that using
Flash can be so frustrating. Flash’s unintuitive
interface, click-intensive dialogs, and limited
scripting support have inspired a love-hate
relationship between the program and
developers. Sure, you can do amazing
things in Flash – but it isn’t easy.
Macromedia provoked a little more love,
and a little less hate with the release of Flash 5
– a total overhaul of the program. Almost every
corner of the program sports changes – many
of them significant – including a streamlined
interface, new drawing tools, expanded sitemanagement features, and newly unleashed
programming power. Here’s a look at how
Flash 5’s tools and refined features will
have you working smarter.
Although you can use Flash to create
beautiful and engaging Web interfaces, the
program can be a nightmare to navigate. If
you’ve ever looked for your library under the
Libraries menu (it’s not there) or tried tinting
several movie clips at once (you can’t), you
know why Flash designers complain bitterly
about the program’s interface. Flash’s face-lift
adds dozens of subtle enhancements to
simplify and speed up even the most mundane
tasks.
A familiar face One of the most striking
changes in Flash 5 is its look. Macromedia
retooled the program’s interface to make
it more consistent with almost all Macromedia
products. This makes it easy for new users
to apply knowledge across programs.

ILLUSTRATION: LEE HASLER

T

In addition to being easier to learn, the
new interface is also more efficient – thanks
in large part to the near elimination of Flash 4’s
clunky modal dialog-boxes. The most-common
controls and settings are now housed in panels
– tabbed palettes that remain on screen.
While modal dialog-boxes had to be opened
each time you needed to change an object’s
setting (a very click-intensive process) and
closed before anything else could be done,
panels let you inspect and modify several
objects at once. This will save you valuable
time on almost every task – from changing
the font in several blocks of text, to modifying
the alpha level of everything on the stage.
Macromedia has also tweaked Flash 5’s
timeline, which users are likely to find more
intuitive than the old one. For example, you
can now extend a layer simply by click-&dragging its end. In the past you had to click
once, wait for the cursor to change to a box,
and then click-&-drag. Realizing that the new
timeline may frustrate Flash users accustomed
to the old way of working, Macromedia
provides a preference setting that lets
you view the timeline as in past versions.
Controlling fine lines Designers who
cringed at Flash’s unusual drawing method
appreciate Flash 5’s new pen tool – a standard
feature in most vector-illustration programs. In
previous versions of Flash, designers employed
a drawing method called vector clay – bending
and extending shapes to mould illustrations.
This organic-drawing process made many
professional designers who were familiar with
Adobe Illustrator and Macromedia FreeHand
feel out of control – if not downright queasy.
The new pen tool lets designers draw and
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Set your style First
construct the text on which
you’d like to base your style.
In the Text Options panel,
select Dynamic Text from
the first drop-down menu (A). Type a
name, such as Title, into the Variable
field (B). If the text may not always fit
on one line, be sure to set the line type
to Multiline (C), and select the Word Wrap
option to accommodate the extra length.

Perfect your style

1

You can use Flash 5’s Smart Clips to impose
consistency on often-used movie elements,
such as type styles. Once the clip is
created, team members can simply enter

Convert to symbol Select
the block of text with the arrow
tool. Open the Insert menu
and select Convert To Symbol
(or press F8). In the Symbol
Properties window enter a name for your
clip (A). Make sure the Behavior is set to
Movie Clip. Click on OK.

2

A

the text into the appropriate parameters
window without worrying about the font

Define parameters Next you
need to specify which variables
the authors will supply for the
clip. Open the Library window
from the Windows menu, and
select the new clip. Then choose Define Clip
Parameters from the Library’s Options menu
(A). In the Define Clip Parameters window,
click on the plus-sign (+) button (B).
Under the Name column (C), select
varName (by double clicking on it), and
replace it with the variable name you
created in step 1 (Title). In the Value column
(D), you can add instructions – such as
Enter Your Headline Here. Click on OK.

3

A

Put your clip to work You
can now drag instances of your
Smart Clip anywhere in your
movie. To populate the text,
open the Clip Parameters
panel – located in the Windows menu
under Panels. Enter the text of your
headline in the Value column (A).

4

A

B

or size.
C

D

A

Note: You won’t actually see your new
headline on the stage. To view the new text,
open the Control Window and select Test
Movie.

C
B

shape objects in a very controlled manner,
using bézier handles. Macromedia not only
added a pen tool, but also integrated it, making
it completely compatible with the vector-clay
drawing style of Flash. Shapes drawn with the
pen tool can be modified with precise bézier
handles, or by simply bending shapes and
extending points. Likewise, you can modify
anything you draw with the paintbrush or
pencil tool, using the pen tool’s Subselect
option.

Basic drawing
While many designers will welcome the
addition of the pen tool, Flash 5 still has a
long way to go before it matches the powerful
drawing features of professional illustration
programs. Earlier versions of Flash attempted
to bridge this gap by allowing users to import
native Adobe Illustrator 6 files – a limiting
option, considering that Illustrator is currently
at version 9. In Flash 5, Macromedia has
focused its efforts on improving integration
with its own illustration program, FreeHand.
You can now import native FreeHand – version
7 or later – documents into Flash 5. This means
that an artist on your team can create complex
graphics in FreeHand, and simply send you
the finished files for direct import into Flash.
(If you use Illustrator, you’ll need to export
your document as a .swf file – a feature
built into Illustrator 9, and available to earlier
versions with the help of the free Flash Writer
plug-in from Macromedia.)

Web conversion
The FreeHand Import controls make it easier to
repurpose print content for the Web – leaving
you with fewer files to maintain. For example,
you can lay out a multipage brochure using
FreeHand, and then open the file in Flash.
Flash doesn’t have “pages”, so after importing
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a FreeHand file, you can selectively map pages
into separate keyframes (for images to appear
sequentially) or into separate scenes (to use the
graphics in distinct sections of your movie). You
can also choose to distribute FreeHand’s layers
to individual Flash layers or to keyframes (see
“A helping hand”). These options allow you to
retain more attributes of the original FreeHand
file. This is a giant step toward seamless
integration of Flash and FreeHand.
Despite its significant interface changes,
Flash 5 isn’t all about looks. Aiming to please
one of its most demanding groups of
customers – programmers – Macromedia also
took a hammer and monkey wrench to the
inner workings of Flash, adding a level of
flexibility and power previously missing from
the program. Sure, you could create amazing
Web sites in Flash 4 – but that’s like saying
you could build a house out of toothpicks. It’s
possible, but not easy. Pushing Flash 4’s limited
scripting capabilities beyond the simplest of
tasks required a resourceful nature, and a host
of complicated workarounds. Flash 5 addresses
this problem – its scripting tools and improved
text controls provide enough power and
flexibility to make even the most controlhungry users smile with glee.
Getting up to code The most profound
technical change in Flash 5 came in the
form of an entirely overhauled programming
language. Introduced in Flash 4, the original
ActionScript was something experienced
programmers called a “language” only
while snickering. Key components of any
programming language are functions – and
Flash 4 had only a handful. Worse, there was
no way to create your own. Instead of writing
lines of code, you simply selected preset
Actions (such as Go to) and filled in parameters
(such as Go to frame 1) from a pop-up menu.
Though Flash 4’s ActionScript was very

approachable for novices, experienced
programmers felt hampered. Even
programming simple tasks, such as exchangerate calculation, required complex and funky
workarounds.

Program possibilities
Flash 5 puts power back in the hands of
programmers, letting them turn off structured
guidance by selecting Expert mode in the
Actions panel, and then typing code directly
into a window. (The guided method of writing
scripts is still available in Normal mode.)
The ActionScript has been extended to a
true object-oriented programming language.
What’s better, the retooled ActionScript is
now based on the same standard as JavaScript.
Although ActionScript contains a few unique
attributes specific to Flash – for example,
what Flash calls (on (roll over) JavaScript calls
onMouseOver – the syntax and structure of
the code are the same.
Now that they have a true programming
language at their disposal, Flash users can
control their code. Functions, such as the
currency-exchange calculator, that used to
require three or four lines of complex code,
can now be accomplished in one. And, because
no one writes perfect code, Flash 5 even
includes the Debugger feature, which displays
code while your movie is playing to help you
identify and weed out programming errors.
Broadening horizons The improvements
to ActionScript in Flash 5 give experienced
programmers the power to create sophisticated
programming tasks that were previously
impossible. In the past, you could apply scripts
only to frames and buttons (making your movie
loop or jump to a new URL, say). But in Flash 5,
you can place scripts on Movie Clip instances –
so you can write scripts that respond to
events (called Clip Events) that formerly went

unnoticed. For example, you can make a
running movie clip appear to float across the
screen by using the enterFrame event to push
a movie clip one pixel to the right each time a
new frame loads.
Looking smart If you aren’t quite ready to
become a programmer, Flash 5 also offers ways
to insulate yourself from code, while still taking
advantage of powerful interactivity features.
The best example of this is Flash 5’s Smart Clips
– prefabricated, sophisticated code snippets
that can be shared and recycled. One sample
Smart Clip that ships with Flash lets you
automatically create pop-up menus. All you
have to do is select the Menu Smart Clip, and
enter the menu items in the Clip Parameters
window. You never need to get your hands
dirty in the code.
Only a few Smart Clips ship with Flash 5.
What makes the Smart Clips feature truly
powerful is that you can create your own,
greatly simplifying the construction of Flash
files. Programmers can create custom Smart
Clips for reuse by others. Say you have a Movie
Clip of a bouncing-ball animation, you can turn
it into a Smart Clip that lets the author specify
how many times it plays – or bounces. A Flash
designer can then drag this custom Smart Clip
onto the stage, and set it to bounce five times.
Later, he could drag out another instance,
and make it bounce only twice. The same
code is used in each instance, but with different
parameters. And since the code is centralized,
Smart Clips are easy to maintain. If you find
a problem, you have to fix it in only one place.
This flexibility makes customized Smart Clips
great for creating repetitive and graphically
consistent elements for your Web site –
such as type styles (see “Perfect your style”).
Dynamic text Not all of Flash 5’s geekpleasing enhancements involve
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Flash in a haystack
Movie Explorer maps out every asset in a Flash movie,
helping you decipher even the largest Flash sites.
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Sharing the load

Sharing the wealth
Maintaining consistency throughout large and complex Flash projects is easy,
if you have a shared library. This public repository lets you share common movie
assets, and ensures that everyone is working with the latest version of elements.
Set image-library linkage
Start with a document that
contains the library you want
to share. Select a library item,
and choose Linkage from the
library’s Options menu (A). This will force
Flash to export the item.

1

Name your assets Give each
item a unique identifier name
in the Identifier field (B). If you
want to replace the shared
item later, you’ll need to make
sure your replacement uses the same
identifier. Repeat this process for every item
you want to include in your shared library.

A

2

3

Export the file Save the Flash file under the name Shared. Then open the
Control menu, and select Test Movie to export the file. This will create a file
called Shared.swf. Anyone can now select Open As Shared Library from the
File menu in his or her Flash file, to link to and use the shared Library.

A helping hand
FreeHand’s import options let you control how your layers
and pages are distributed to Flash.
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programming. Macromedia has also added a
surge of power to the program’s text-handling
features. Flash 5 now offers basic HTML (1.0)
text formatting, in addition to traditional
antialiased display type. This makes it easy to
reuse text from an existing Web page, without
reformatting it. But, the true power of HTML
text comes into play with dynamically updated
Flash sites. Regular Flash display type becomes
locked once the movie is exported. But with
HTML-formatted files, it’s easy to make Flash
content automatically update, or change
formatting, while a user visits your site.
And, now you can put a link right inside
your dynamic text, instead of carefully
positioning an invisible button over the word.
Missing the Flash It’s worth noting that
Flash 5 is not entirely backward-compatible.
While you can use Flash 5 to create a movie
that works in the Flash 4 player (which has a
huge install base), you won’t be able to use
many of the newest and best scripting features,
such as Smart Clips. To help you remember
which scripts are off limits, Flash 5 highlights
the scripts in the Actions panel when they’re
unavailable in the format to which you’re
publishing. This is an improvement over Flash 4,
in which you could deliver to Flash 3, but you
had to know which features were off limits.

More and more, designers and programmers
are collaborating to build large Flash projects.
This team effort can produce a unique set of
problems. Working in teams requires that
everyone be able to work simultaneously, and,
if need be, take over other parts of the project
at a moment’s notice. However, working
simultaneously is impossible if there’s just one
master file. And making sense out of team
members’ Flash files can be more difficult than
finding where they keep the silverware in their
kitchens. Luckily, Flash 5 now addresses many
of these productivity issues.
Getting noticed Large and complex Flash
files tend to get unwieldy. If you’ve ever had to
update a large file you programmed a long time
ago, you probably found it easier to just start
over. And forget about trying to edit someone
else’s work! You’d have an easier time hacking
into the MI5’s computer system.
Flash 5’s new Movie Explorer can help
navigate complex projects by creating a
visual map of the whole file – including fonts,
graphics, and scripts (see “Flash in a haystack”).
Its hierarchical view lets you sort, print, and
even jump to any part of your movie; it’s a
great tool for making small tweaks to large
movies. You can use the Movie Explorer to
quickly find and change every instance of
a particular font – a huge time-saver.
Learning to share Working with multiple
designers often means working with multiple
design styles. But, without strong graphicconsistency, a Web site can wind up looking
sloppy and unprofessional. Imposing a standard
style requires keen attention to detail; making
sure every member of a group has the correct
and updated versions of fonts, images, and
other movie assets is a challenge.
To keep all team members on the same
page, Flash 5 allows groups to access a shared
repository of elements. This shared library can
include images, movie clips, fonts, and even
Smart Clips. And just as regular Flash libraries
store the media once, no matter how many
times you recycle an item, team members need
to download the contents of a shared library
only once, which keeps files compact. If a
shared library item is edited, the change is
automatically reflected in every file linked to
that library. For example, if you add rounded
corners to a button in the shared library, you’ll
see that change everywhere the button is used.
This ensures consistency even as the design
changes. (To learn how to create a shared
library, see “Sharing the wealth”.)
Flash 5 is built for productivity and power.
Its new features and enhancements make
it more efficient, more flexible, and easier
to maintain. Flash 5 won’t start making Web
sites for you, but it will definitely make the
job much easier. Although Flash veterans
may at first have been put off by some of the
changes, once they get over the initial shock
and adapt to these ways of working, they’re
sure to find plenty to keep them satisfied.
And, every minute invested in learning a new
approach will be paid back in hours of saved
MW
time.

How to:

Charting
success
Bring dull data to life.
By Cathy Abes

1

graphics

Chart the data Rod began by plotting the
numerical data in SPSS’s graphing program
DeltaGraph Professional (£199; 01483 719 201;
www.spss.com). Rather than using pie or bar graphs,
he opted for single-line (A) and double-line (B) charts:
these are best for visually comparing trends over
time.

A

250

200

150

hen you think of a chart, artistic expression doesn’t
usually jump to mind: you may picture simple jagged
lines on horizontal and vertical axes, or coloured pie
slices. But, Rod Little’s informational graphics, which
liven up the pages of US News & World Report, present statistical
data in a new light. Rod looks for unusual ways to weave images
around static numbers, transforming them into visually arresting
tableaux.
To illustrate two related line graphs, comparing the US economy
with Japan’s, Rod conjured up stylized sumo-wrestlers to symbolize
Japan. One wrestler supports a huge cargo box that shows the
value of the Japanese yen against the US dollar over 20 years. In
the second graph – which charts Japan’s trade surplus – another
Japanese wrestler swims confidently above the waterline while
Uncle Sam struggles below the surface, attempting to rise above
the US trade deficit. Double fever lines define the strokes of both
swimmers.
Although Rod’s illustrations are clever and imaginative, they
never overpower or obscure the facts. This helps them communicate
complicated data in a clear, powerful style that’s appealing to the
mind and the eye.

W

100

50
0
1977

'87
150 bil.
100 bil.

B
50 bil.
0 bil.
-50 bil.
-100 bil.
-150 bil.

1980

'82

'84

'86

'88

'90

'92

Sketch the design To add illustration elements,
Rod pasted the finished graphs into Macromedia
FreeHand, printed them out, and covered them
with tissue paper. He then began sketching the
figures and other elements around them (C).
Once he had a design he liked, Rod scanned the sketch and
used it as a foundation for building his infographic – he outlined
the shapes with the pen tool on one layer, and filled each
shape with colours, gradients, or blends on successive layers.

'94

'96

-200 bil.

C

2

continues page 138
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Add blends To emphasize
the wrestler’s girth, Rod added
a shadow to his belly (D). He
began by framing the blend
with two lines (E), using the
beige tone for the inner line and a medium
brown for the outer. He then created a 150step blend between the two (F). The result
was a fin-like shape that blended from a
dark, hard edge to a light, diffused one (G).

3

E

F

G

D

Create transparency To
make Uncle Sam appear to
be underwater (H), Rod used
transparency. First he added
subtle tints of blue and black
to several areas of the ocean’s blue-green
colour (I). He then selected both the
ocean and the Uncle Sam figure. After
choosing the Transparency command
(Modify: Combine), Rod reduced the
opacity to 83 per cent; the figure’s
submerged portion took on a translucent
variation of the ocean’s colour (J).

4
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manual

Word 2001: Table talk
Getting to grips with Office 2001. Part One. By Nan Barber & David Reynolds
ow do you use Word to create a résumé,
agenda, program booklet, list, multiplechoice test, Web page, or other
document where numbers, words, and phrases
must be aligned across the page? In the bad
old days, people did it by pressing the Tab key
to line up columns. This method is a recipe for
disaster. (Unfortunately, thousands of people
still use this method—or, worse, they still try to
line up columns by pressing the Space bar lots.)
Using Word’s table feature is light-years
easier and more flexible. Each row of a table
expands infinitely to contain whatever you
put into it; everything else on its row remains
aligned. Tables also have a few simple
spreadsheet features.

H

Creating tables
There are two ways to insert a table: you can
let Word build the table to your specifications,
or you can draw it more or less freehand.
Inserting a table The quickest way to
insert a table is to use the Insert Table pop-up
button on the Standard toolbar (see “Insert
certainties”).
If the toolbar isn’t visible, choose
Table➔Insert➔Table. The Insert Table
dialog box opens, also shown overleaf.
After you choose the number of rows and
columns you wish to start with (you can always
add more later), click an AutoFit radio button to
tell Word how to size the columns across your
table. If you know how wide in inches you’d like
each column to be, click “Initial column width”
and set a measurement in the size box. “AutoFit
to contents” creates skinny columns that
expand as you type into them, and “AutoFit
to window” spaces the selected number of
columns evenly across the page. The table
appears in your document at the insertion
point when you click OK. “Size well be” shows
a small 3-x-3 table.
Drawing a table Word’s Draw Table tool
gives you free rein to form the table of your
dreams – the trick is learning to control it.
To summon this toolbar, click the Tables and
Borders button on the Standard toolbar, choose
View➔Toolbar➔Tables and Borders, or choose
Table➔DrawTable. The Tables and Borders

toolbar opens and the cursor turns into a
pencil.
When you drag the pencil horizontally
or vertically, it draws lines; when you drag
diagonally, it draws boxes. Using these
techniques, you can design even the most
eccentric, asymmetrical table on earth.
The tidiest way to begin drawing a table is
to drag diagonally to create the outer boundary,
as shown at the left in “Table draw”, then drag
horizontal and vertical lines to create the rows
and columns. Drawing your own table is the
best option when you want a variety of widths
in your rows and columns, rather than evenly
spaced ones.
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Tables are top
Top: If you use tabs to set up a table, things may look
good at first – as long as every line fits within its space
and you never plan to insert any additional text.
Middle: Here’s what’s wrong with the tab approach.
When you insert the word Understudy into one of the
columns, it pushes too far to the right, causing an ugly
ripple effect that will take you a long time to straighten
out.
Bottom: If you use a table, you never have this kind
of problem. You can type as much text as you like into
a “cell”; that row of the table simply expands to contain
it. (The light grey gridlines don’t print unless you want
them to.)

continues page 142
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Table Move handle

End-of-cell mark

Row

Resize box
Column

Cell

Size will be
The light grey markings shown here appear when you
click the Show ¶ button on the Standard toolbar or
Formatting Palette. To select an entire column, click
near the top of it – the cursor turns into a tiny arrow.
To resize a row or column, drag the horizontal or
vertical lines when the cursor turns into a double
arrow. The resize box at lower right keeps all rows
and columns in proportion as it expands or shrinks
the entire table.

Insert certainties
Left: The Insert Table button on the Standard Toolbar is
a quick way to make a small table. As you drag through
the grid, you’re specifying the table size you want.
(You can drag beyond the boundaries shown here,
by the way, to specify – for example – a 9-x-9 table;
the pop-up grid grows as necessary.)
Right: If you often use the same kind of table, you
can turn on “Set as default for new tables” to make
your favourite settings the new defaults. They will
appear in this dialog box each time you choose
Table➔Insert➔Table.

There’s more on Word tables, and a whopping seven
whole chapters on Word 2001 from ‘Basic Word Processing’
to ‘Word Meets Web’ in Nan Barber & David Reynolds’
Office 2001 for Macintosh: The Missing Manual (Pogue
Press/O’Reilly; ISBN: 0-596-00081-2). This article is the
first of a series of Macworld extracts from the book, which
costs £17.50 from all good booksellers.Next month: Excel.
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To remove a cell or line you’ve just drawn,
hold down the Shift key (or click the eraser tool
on the Tables and Borders toolbar) and drag
it across a line. The line promptly disappears.
When you’re done designing your table’s
framework, dismiss the Tables and Borders
toolbar. The insertion point is now blinking
in your new table, ready to begin typing.
Typing into tables To type into a table cell,
click in that cell. You can use the up or down
arrow keys to change rows; press Tab and ShiftTab to jump forward or backward through the
cells. (There’s not much call for tabs within cells
– after all, you’ve already lined up text the way
you like it. But if you need a Tab character, press
Option-Tab.)
Pressing Return or Enter doesn’t take you to
the next cell; it puts a line break in the current
cell. Get in the habit of pressing Tab to move on
to the next cell. You can also navigate like this:
To move to:
First cell in the row
Last cell in the row
Top cell in the column
Bottom cell in the column
Highlight whole table

Press these keys:
Control-Home
Control-End
Control-Page Up
Control-Page Down
Option-Clear

As you type, text wraps within the cell,
forcing the row to grow taller as necessary.
To make the cell get wider as you type, choose
Table➔AutoFit➔AutoFit to Contents. (Even
then, the cell will get wider only until the table
reaches the edge of the page – then the text
will start to wrap down.)
Of course, this automatic wrapping
is the principal charm of tables. But if you
find yourself wishing Word would not wrap
text in this way, select the cells in which you
want wrapping turned off, and then choose
Table➔Table Properties➔Cell tab. Click Options
and uncheck the Wrap Text box. You can still
enter as much text in a cell as you like, but the
cell won’t expand downwards to show it – it
will just disappear beyond the cell boundary.
Selecting cells To cut, copy, or drag material

Table draw
Top: Drag diagonally to create the outer border of
your table. Bottom: The Draw Table tool lets you
create rows and columns of any size and shape
just by drawing them.

from cells in a table, you must first select it,
as with any other Word text. Because it’s a
table, however, you have a variety of options:
■ Drag with the mouse, down, across, or
diagonally over the cells you want.
■ Click at the top of a column – the cursor
changes into a downward-pointing arrow – to
select an entire column. Likewise, click at the
left of a row – the cursor changes into a rightslanting arrow – to select an entire row, or the
thin, invisible selection bar at the left edge
of a cell to highlight that cell. (Double-click
this selection bar to highlight a whole row.)
■ Click, press Shift, and click with the
mouse to extend the selection one cell,
row, or column at a time.
■ Option-click anywhere in a column
to select the entire column.
■ Triple-click the cursor at the beginning
of any row to select the entire table.
■ Use the Shift key with any of the
navigation keystrokes described previously.
Sizing rows and columns You can make
a row taller or shorter, or a column wider or
narrower, much the way you adjust Word’s text
boxes or margins; point to any line or boundary
of a table without clicking; when the cursor
turns into a double-sided arrow, drag.
You can also rely on Word’s own automatic
table features to help you design the table:
■ Balanced columns. If you want a
symmetrical, balanced look, select the rows
and columns that you want to balance, then
choose Table➔AutoFit➔Distribute Rows Evenly
or Distribute Columns Evenly.
■ Automatic sizing. Often, you want the
columns to stretch and shrink depending on
what you type into them. Or maybe you don’t
know what size you want or need the columns
to be. In such cases, choose Table➔AutoFit➔
AutoFit to Contents. As you work, the columns
will stretch to just the width necessary to show
the contents. For maximum room, Table➔
AutoFit➔AutoFit to Window stretches your
columns, however many of them there are,
to fill the page from margin to margin.
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At any time, you can resize the table using
the mouse; you’ll override and cancel the
previous AutoFit setting. When you have the
column widths right where you want them,
choose AutoFit➔Fixed Column Width.
■ Numeric precision. To set row and column
sizes using exact measurements, select the
rows or columns in question and then choose
Table➔Table Properties.
The resulting dialog box (see “Property
properly”) contains size boxes where you
can enter exact measurements.
For columns, you can also specify a
percentage of the table width instead of a
measurement in inches. For rows, you have
the option of setting an exact measurement,
or an “At least” measurement. When “At least”
is chosen, the cells in that row will stretch
downwards to wrap text as you type – even
if you’ve turned off “Wrap Text” on the Cell tab.
■ The whole table. To resize the table as a
whole, drag the lower-right corner. The rows
and columns remain evenly spaced or in the
proportions you’ve chosen.
Adding rows and columns If you run out
of room and need more rows at the bottom
of your table, it’s easy to add more: click the
lower-right cell and press Tab. A new row
appears.
To add a new row or column anywhere
in your table, click in the table and then use
the Table➔Insert submenu. Choose one of the
options from the menu that appears: “Insert
Columns to the Left,” for example. (These
commands are also available in the Insert
Table pop-up button on the Tables and Borders
toolbar.)
Adding multiple rows or columns at either
end of your table, or anywhere within it, is
a two-step process: First, highlight the same
number of rows or columns as the ones you
want to insert; to add two rows, select two
existing rows.
Next, choose Table➔Insert, and one of
the submenu options (Insert➔Rows Below, for
example). Word instantly creates the requested
number of new, empty rows or columns.
Inserting individual cells works much the
same way. You can insert one cell at a time by
choosing Table➔Insert➔Cells, or by using the
Insert Table menu on the Tables and Borders
toolbar. To insert multiple cells, select the
equivalent number of existing cells at the
desired location in your table before choosing
from the menu.
Of course, you may find it more fun simply
to click the Draw Table tool on the Tables and
Borders toolbar and draw the extra columns
and rows onto your table.
Deleting table parts It’s easy to dismantle
a table in various ways:
■ Deleting cells. You can get rid of one or more
cells by selecting them and choosing Table➔
Delete➔Cells. Word asks if you want to move
the remaining cells up or leftward to fill the
void; choose one and click OK (or press Return).
■ Deleting rows and columns. Select them (as
shown in “Size well be”) and choose Table➔
Delete➔Rows (or Columns). You may find it
faster to click anywhere in the row or column

and choose Table➔Delete➔Cells, then choose
a radio button to delete the entire row or
column. Click OK to confirm the deletion.
■ Deleting the whole table. Click in the table
and choose Table➔Delete➔Table.

Formatting tables
When you click inside a table, the everresponsive Formatting Palette sprouts a new
set of formatting tools – a section called Table
Cells. In conjunction with the existing Borders
and Shading section, you have all the
formatting controls you need. To use them,
begin by highlighting the cells, rows, or
columns that you want to work on. Then you’re
all set to format any of these table elements:
■ Table border or gridlines. The Borders tools
let you choose a line style (solid, dashed, and
so on), colour, and weight (thickness in points).
Clicking the Type button gives you a menu
where you can choose which sides of the table
you want borders to appear on. For instance,
you may want only vertical lines inside the
table and no outside border. Or you may want a
heavier top border on the top row of cells only.
■ Background shading in cells. Shading in a
table is similar to a fill, except that you don’t
use the Fill palette; you use the Shading palette
in the Formatting Palette (or Tables and Border
toolbar).
AutoFormatting tables With creative
combinations of borders, lines, and shading,
you can make a table look right for anything
from a bank’s annual report to Teletubbies; but
when you’re in a hurry, you can choose a Table
AutoFormat for instant good looks.
Click anywhere in your table and choose
Table➔Table AutoFormat. There’s a long list
of potential formats in the list box at the left
of the Table AutoFormat dialog box.
Click on each to see a preview. If you want
to use some of the features in the format but
not others (font, colour, and so on), then just
turn on the boxes for the ones you wish to use.
Many of the formats have a different
typeface or shading applied to the top
(heading) row, first column, last column,
and so on.
The checkboxes in the “Apply special
formats to” section control whether you
take those features along with the rest of
the format. For instance, if you’re not using
the last row of your table for totals, don’t turn
on the “Last row” box.
Text formatting within cells Like text
anywhere in Word, you can change the
direction and alignment of selected text
in a table using the Format Text Direction
command – a great effect for row or column
labels. In the resulting dialog box, choose
the text orientation – horizontal, vertical,
or bottom-to-top – and click OK.
You can also make the text in selected cells
hug the left or right side of its cell, or centre
it right in the middle. To do that, choose
Table➔Table Properties➔Cell tab, and choose
the icon for right, centre, or left.
To use the same alignment for the entire
table, choose the alignment using the buttons
MW
on the Table tab instead.

Property properly
When using the Table Properties dialog box, you can
select a group of rows and columns and size them all
at once, or you can use the Previous and Next buttons
to work on each row or column one at a time.

You can also eliminate certain table lines
entirely. Just click the eraser tool on the
top row of the Tables and Borders toolbar and drag
along each line you want to disappear from the
table.

TIP

Cell margins and spacing
To make your text look good in a table, you can adjust
gap between the characters and the borderlines. You
can also put a little space around the outside of each
cell – an especially attractive effect on Web pages.
Just select one or more cells and choose Table➔
Table Properties➔Cell tab. Click Options, and set
measurements in the size boxes for the distance
between the text and the top, bottom, left, and right
edges of the cell. The “Same as the whole table”
box changes the margins of the selected cell to
match the default cell margins for the table. To set
the default margins for all cells in the table at once,
choose Table➔Table Properties➔Table tab; click
Options and enter measurements in the “Default
cell margins” boxes.
To put more spacing around the outside of cells,
click anywhere in the table and choose Table➔Table
Properties➔Table tab. Click Options and turn on
“Allow spacing between cells”; enter a setting in the
size box. When you click OK, that amount of white
space will surround each cell, simulating the effect
of thicker cell walls.
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Your tip of the month wins an hp deskjet 990c m

Q&A/tips

We reward the tip of the month with an hp deskjet 990c m, worth £279.
This graphite colour-printer offers amazing image quality and speed, and
is bursting with gadgetry and cool extras.

• Wired wireless • Keyboard coaster • iTunes burning

Q&A/tips
Handy Mac tips and readers’ questions answered. By Christopher Breen
Picture pasting
Can I paste pictures into a table cell in
Microsoft Word 98? (It’s just a matter of
following the normal cut-&-paste commands
with Word 2001.)

Q
A

Chong Chee Nian
The simple, though costly, answer to this
problem is to upgrade to Word 2001, which
pastes graphics into a cell as you’d expect.
Performing this trick in Word 98 takes a bit more
effort: With a picture ready to paste, click inside a
cell and choose Paste Special from Word 98’s Edit
menu. In the dialog box that appears, select Picture
and deselect the Float Over Text option. Click on OK,
and the picture appears within the cell.

Wired wireless network

TIP

Recently I asked for information on
using an AirPort-less Mac to access
the Internet over an AirPort network
– but my problem wasn’t so much getting on to the
Web (Macs on an ethernet network can access the
Web via an AirPort Base Station). Rather, I wanted
to know how to easily terminate my connection
from that AirPort-less Mac.
For those of you who’ve read the previous
paragraph six times, and still have no idea what
I’m talking about, here’s a little insight. To connect
an ethernet-networked Mac through an AirPort Base
Station to the Web, you wire your network this way:
Using a standard Cat 5 ethernet cable, connect an
AirPort Base Station and the non-AirPort-equipped
Mac to an ethernet hub. Run a phone line from the
Base Station’s modem port to a phone jack. In the
Network window of the AirPort Admin Utility
application, configure AirPort to share a single IP
address using DHCP (Dynamic Host Configuration
Protocol), and select both of these bridging options:
Enable DHCP Server On Ethernet, and Enable AirPort
To Ethernet Bridging (see “AirPort connection”).
With this setup, any time you check your email or
fire up a browser on your Mac, you’ll initiate a dialup connection through the Base Station. That’s all
well and good, but there’s a catch: you can’t easily
break the dial-up connection from the Mac. That’s
because you can’t run the AirPort software, which
supplies a disconnect button, if your Mac doesn’t

have an AirPort card. I know someone’s
going to suggest it, but no, I don’t
care to wait for a period of inactivity
to terminate the connection.
Happily, the solution is easier
to explain than the problem.
Damien Barrett recommended
Larry Rosenstein’s free AirPort Modem
Utility, which allows you to initiate or
terminate a dial-up connection simply
by clicking on the utility’s Connect or
Disconnect button. And its small
window displays the Base Station’s
IP address and connection status.

Segmenting sources

Q
A

How do I segment a very large
file across several Zip disks
on the cheap?

Mac Maniac
Although Aladdin Systems’ StuffIt
Deluxe (£65; Softline, 01883 745 111;
www.aladdinsys.com) – and its
accompanying drag-&-drop application,
DropSegment – is my segmenting software of
choice, as a die-hard penny-pincher, I respect this
maniac’s desire to use something less expensive.
That something is also available from Aladdin
Systems – StuffIt Lite. This $30 application (from
www.aladdinsys.com), allows you to chunk your
files into any size you like by choosing Segmenting
from the Translate menu. You can try it yourself
after downloading the demo version from Aladdin’s
Web site.
But, if you’re a real cheapskate, you’ll
opt for Apple’s free Disk Copy Scripts
(http://asu.info.apple.com/). This collection of addon AppleScripts contains the Segment Image script
that lets you divide image files into bite-size bits.
To use it, simply place the Segment Image script
into the Scripts folder inside the folder on your
Mac containing Disk Copy (by default, Disk Copy
is in the Utilities folder). Now drag the file you
want to segment into a new folder. Launch Disk
Copy, and then create an image file for the new
folder that contains your original file, by selecting
Create Image From Folder in the Image menu.
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Picture perfect
See Picture pasting for tips on importing pictures into
Word 98 tables.

AirPort connection
You can share an AirPort connection over an ethernet
network by selecting the Enable AirPort To Ethernet
Bridging option in the AirPort Admin Utility application.
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Keyboard coaster
What do you do after pouring sugary
Nescafé into your keyboard? I turned my
iMac’s keyboard upside down, and let it
drain. Later that morning my friendly local geek
suggested that I use my hairdryer on the
problem, which has left me with a crunchy
keypad. Now what?

Q

Ellen Gilbert

Unfortunately, you’ll probably have to buy
a new keyboard. There are plenty of USB
mice available for Macs, but fewer
keyboards because of the ⌘ key. Apple’s new
Pro Keyboard costs £45 (inc. VAT), and there are
also some enhanced keyboards from Macally,
such as its iKey Extended Keyboard (Mac
Accessory Centre, 0191 296 1500).

A

Next, choose Segment Image from the Scripts
menu and indicate whether you’d like to segment by
size or number of parts. In the resulting Open dialog
box, select the image file you just created, click on
OK, and choose a location for the segmented files in
the Save dialog box that appears. Now stand back
while Disk Copy verifies and segments your file.

For exact instructions, go to the btinternet
home page (www.btinternet.com), click “0800
number withdrawal” and look at the various
options. Every one has a “Mac setup” button, so
click one and follow the instructions. No problem.
Of course, the Windows crew couldn’t manage
that – they have to have a script to do it for them,
hence the DOS file.

Eudora order

Graham Willis

TIP

Sorted SoundJam

To change the order in which
Eudora sorts – from A-Z to Z-A
or most-recent to least-recent,
for example – Option-click on a column heading
in a mailbox’s window.

Alert PowerBook

TIP

The titanium PowerBook G4, like
some of Apple’s other portables,
sometimes fails to make sound
after it’s been woken from sleep. To make your Mac
more audibly expressive, try this:
Flip open the Control Strip, click on the Sound
Strip control strip module – the one that features
a microphone and CD icon – and select Built In
Mic (yes, even if that option is already selected).
Now click on the Speaker Volume control strip
module, and move the slider. When you do so,
your Mac should once again produce sound.

Conserving colours

TIP

It’s awfully wasteful to replace an
entire colour inkjet cartridge simply
because one has consumed a single
hue. However, you can contact a company, such
as Prink (www.prink.co.uk), to inquire about its
refillable ink cartridges. Designed to work with
today’s most popular ink-jet printers, these
cartridges cost a fraction of the price of those sold
by printer manufacturers. They can be refilled with
ink, and despite implied threats to the contrary,
using them shouldn’t void your printer’s warranty.

BT blunder

TIP

James Churchill’s letter in
Macworld, May 2001 complaining
about BT Anytime having “no
auto-dial Mac version” is wrong.
Stop BT-bashing. The only thing you have to
do manually is open the control panel for “remote
access”, click “setup” and tap in the new telephone
number and a couple of other settings.

TIP

If you want to batch edit ID3 tags
in Casady & Greene’s SoundJam,
just drag a folder full of MP3s to
a playlist, highlight the playlist, and press ⌘-I. A
dialog box – in which you can edit attributes such
as artist, album, and year for the entire collection
of MP3s – then appears. You can perform the same
trick in Apple’s iTunes by selecting a group of MP3s
(sorry, the folder trick won’t work) in a playlist and
pressing ⌘-I.

Richard Hayes0
Missing Web

TIP

If, while running OS X, your Mac
tells you that it’s unable to connect
to the Internet with Software
Update, Sherlock, or Mac Help, try going to
www.apple.com, and then running one of the
affected applications. Apple says that this problem
crops up when DNS servers provide Software
Update with an unexpected response. Connecting
to Apple’s site first works around this problem.

TIP

Outlook Express rules

TIP

If you’ve imported a fair chunk
of email into Outlook Express
from another program, and would
like to separate the wheat from the chaff (meaning
you’d like to see how much of that imported mail
is useless junk), try this trick:
Once the mail is imported and in a separate
folder, Control-click on that folder and select
Apply Junk Mail Filter from the contextual menu.
When you do, Outlook Express will rifle through
that mail and mark any messages it deems spam.
To collect all marked mail, just select Rules
from the Tools menu, click the New button to
create a new rule, give it a descriptive name like
“Suspected Junk”, select Is Junk Mail from the
If pop-up menu, and select Move Message from
the Then pop-up menu. In the Folder pop-up menu
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Multi all
When you have multiple documents open in Microsoft
Word, you can save or close them all in one fell swoop.
To do this, hold down the Shift key and select Save All
or Close All from the File menu.
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Tip of the month: Speedy iTunes burns
Dragging a playlist from iTunes – any version – to the Toast 4.x
or later window produces an audio CD in a quarter of the time Disk Burner
can. Simply create your playlist in iTunes, select it (A), and drag it accross
to Toast. Then, in Toast, hit record (B).

TIP

“quote” (without the quotes), followed by a space,
and then the stock symbol – quote aapl, for
example. Doing so produces the price of the stock,
along with such information as yesterday’s closing
price and the stock’s 52-week high and low.

Dock’s dropped icons

TIP

Chris Webb

If OS X’s Dock displays generic
folder-icons when it should be
showing application icons, try this:
Drag the LSApplications, LSClaimedTypes, and
LSSchemes files to the trash. These files can be
found inside the Preferences folder inside the Library
folder inside the affected user’s folder (if Johnny is
signed on, for example, and the icons are generic,
these files will be inside Johnny’s user folder) inside
the Users folder at the root level of the OS X disk.
Now, log out of OS X and log back in as the
affected user.

A

Double updates

TIP

If you are running Mac OS X,
remember to use Software Update
in both OS X and in OS 9.1, as
different downloads will be selected for each
operating system.

Burned burner

TIP

B

that appears to the right of the Move Message
menu, select New Folder. In the resulting dialog
box, give the folder a descriptive name (how
about “Suspected Junk” again?) and click OK.
Now open the folder of imported mail, click
once in the message pane, and press ⌘-A to select
all of the messages. Finally – I swear, we’re almost
done – Control-click in this pane and select the
Suspected Junk rule from the Apply Rules submenu.
Outlook Express will now move all those tagged
messages to a different folder where you can
peruse them at your leisure.

TIP

Opt+double-clicking the title bar of
a window will collapse all the open
windows being used by that application.

Macworld’s chief sub-editor Woody Phillips
and contributing editor Christopher Breen
answer readers’ questions and select readersubmitted tips for this column. Send your
question or tip (include your address and
phone number) to Q&A, Macworld, 99
Gray’s Inn Road, London, WC1X 8UT. You
can also send an email, marked Q&A in
the subject line, to qanda@macworld.co.uk.
We pay £25 for each tip published here.
We cannot make personal replies,
so please do not include a stamped
addressed envelope.
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PowerBook connections

TIP

If you want to make a direct
ethernet connection between two
Macs, you normally have to either
connect the Macs via an ethernet hub, or use
a special ethernet crossover cable. This is not
the case with the Titanium PowerBook. These
PowerBooks allow you to make direct computerto-computer connections with a standard ethernet
cable.

Stock answer

TIP

To get a quick quote on a favourite
– or, perhaps, disappointing –
stock, do the following:
Launch Netscape, and in the address field, type

If you have a Power Mac G4 or
iMac with a CD-RW drive, and
you’ve used your Software Restore
disc to restore your software in place, you might lose
the ability to burn a CD from the Finder. In order for
the Burn Disc command to appear in the Finder’s
Special menu, you need Finder version 9.1.1 – a
version that may not be on your Software Restore
disc.
If you find yourself in such a pickle, simply
reinstall Disc Burner. Doing so installs this newer
version of the Finder and returns the Burn Disc
command to the Finder.

SoundJam conflict

TIP

If Casady & Greene’s SoundJam
can’t seem to remember title
information you’ve obtained via
CDDB lookups, turn off QuickTime 4’s AutoPlay
option. To do so, select QuickTime Settings from
the Control Panels submenu, and in the resulting
window select AutoPlay from the pop-up menu.
Finally, disable the Enable Audio CD AutoPlay
option and close the control panel.

Sticky-business cards

TIP

Some companies are producing
a CD business card – which is
business-card size, but incorporates
a CD so that you can view company details on your
PC. Although this idea works fine on a CD tray with
a centre spindle, if you insert it into a new Mac with
a slot loading CD/DVD drive, it will jam and the
CD/DVD will need to be taken apart to remove
the disk. This is not only expensive, but renders
the CD/DVD useless until its removed.

David Carling
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Andy Ihnatko

The Palm is great, but Apple needs
to get back in the handheld-game

Palming off Apple
new pocket computing device is coming from
Apple. If the company isn’t planning to release
one soon, then it already has some prototypes
built and working as proof-of-concepts. Or it’s
aggressively white-boarding basic ideas on what sort
of handheld it hopes to make someday. If you don’t
believe that, maybe this one will work for you: a year
or two ago when Steve Jobs modified the tic-tac-toe
diagram he uses to represent Apple’s hardware
strategy, he left a square tantalizingly blank, so
there’s every reason to – Oh, who the hell am I
fooling?
For all we know, Jobs could have intentionally
left that space blank for tax purposes. At the
moment, the most realistic analysis is that
Apple’s next handheld will be a flop, because the
hyperintelligent supermonkeys who will probably
rule the planet by then will lack the opposable
thumbs.
Yet, folks are still hot for Apple to reinterpret
the personal digital assistant for this millennium –
perhaps against all logic. But, Palm owns the category.
It’s got a great product that’s only getting greater.
Palm seems to grasp that the development
of computer hardware and software is a creative
endeavour – no less than a great movie, or album is –
and that the price of market analysis is mediocrity.
Maybe the folks at Apple took that principle to
the extreme with the Newton. If they had done a
little more analysis before building ’em, perhaps they
would have discovered that the only way users can fit
Newton into convenient pockets is if they first borrow
old tracksuits from their dads. But the Newton OS
remains the gold standard in handheld operating
systems. The Palm OS is at first forgivably clunky,
and then endearingly so. But when you put a Palm
next to the manifestly elegant and powerful aura
of a Newton, you’re left wondering why no one’s
making anything that can approach it… even today.
You think I’m kidding? Years after the Newton
was discontinued – and after I finally determined
that I was expending more calories keeping my
Newton working with incompatible hardware and
software than its developers had spent designing it –
it still takes no fewer than three items to replace it.
My Palm is the best thing for managing contacts

A
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“Folks are still
hot for Apple
to reinterpret
the personal
digital
assistant
for this
millennium
– perhaps
against all
logic.”
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and appointments, has the best library of mobile
apps and games, and has the most elegant operating
system. My Compaq iPaq runs PocketPC, which is the
first version of Windows CE that inspires me to write
about it – calmly instead of causing me to jump up
and down and shriek incoherently. And for the most
important function of my Newton, I’m back to using
a pocket sketchbook. No other pen-based handheld
computer is worth a shaved elk hoof if you need to
jot down notes longer than a sentence or two.
The Newton was ahead of its time. We’re just
now at the leading edge of the major cultural shift
it anticipated: year after year, we’re getting closer to
the day when the majority of the adult population is
made up of people who grew up with computers. The
handheld computer is merely a thriving market space
today, but before long those things are gonna be as
common as underpants.
For now, Apple’s sole presence in that enormous
market space is, well, Palm’s support for Mac OS. It’s
just wrong. If Palm is fulfilling every Macintosh user’s
expectations of a Mac handheld, why do cities burn
every time there’s a new rumour of an Apple
Handheld? We all want Apple to get back into the
handheld world, and not just because we’re Apple
freaks. We want it because it’s an opportunity
for Apple to do what it’s great at: presenting
truly fresh damn-the-torpedoes ideas.
Imagine Apple creating connectivity software that
allowed the Mac to work more intimately with a Palm
device than any Windows machine could, for starters.
After five or six pints, it may occur to you that
the iPaq uses the StrongARM processor – the same
one powering the next-generation Palms – and
that both handhelds will have flashable ROMs,
so their original operating systems can be wiped
and replaced with something better, written by a
company that’s good at spotting and eliminating
the most cumbersome aspects of the status quo.
If you keep drinking until your friends, ignoring
your incoherent mumblings, trick you out of your
car keys and put you to bed on the nearest sofa, you
might drift off to sleep remembering that, hey, you
know, Apple still owns the Newton OS. And wasn’t
it written for the StrongARM processor? What if. . .
MW
grrzzzzzzzzz.
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